


Multi-Function Technologye®
Your swiss army knife for HVAC.
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Features and benefits only
Belmo's MFT can provide.

Multi-Function Technology, only from
Belimo, allows you to create custom
solutions for individual applications, using
the same programmable actuator.
Whether you need a particular control or
feedback signal, or need to change
running speeds, MFT is the answer. It
comes standard as a 2 to 10 VDC
proportional control but can be
reprogrammed on-site. You can modify
voltage control, time proportional control,
floating point, on/off and feedback
signals too. In addition, MFT makes it
easy to set parameters for running time,
mechanical working range, address,
status and diagnostics. Think of it as your
all-in-one, swiss army knife for HVAC.

-

WARRANTY

Feature

Configurable control and
feedback signal type

Variable runtime
Flexible angle of rotation setting

Scalable operating range

Min, Mid, Max override function

Stored alarm information

Data logging capability

Benefit

Reduced number of actuators
required in stock

Flexibility to tune to each application

Customized to fit application - to drive
actuator less than 100% open/closed

Optimized control resolution
for every operating range

Additional system control beyond
modulation

Ease troubleshooting

Gather system data for optimization
or diagnostics
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BELIMO

MULTI-FUNCTION TECHNOLOGY

Belimo damper actuators and control valves with Multi-Function
Technology (MFT) are an excellent way to standardize your product
line while reducing the number of different actuators needed. Multi-
Function Technology offers a wide variety
of programmable control inputs and
MULTI-FUNCTION TECHNOLOGY®  faacinack signals. Parameters can be set

for voltage control (VDC), time proportional control (PWM), floating

point, on-off, feedback signal, or torque output. Parameters can be
changed on-site to optimize/enable application. You can also set, modify
or read position, running time, mechanical working range, address,

status, and diagnostics.

MEFT offers tailor made solutions allowing you to adapt the actuator
of valve to your system for replacement and to improve system
functionality.

BELIMO PC-TOOL

Laptop access anywhere.
Universal Access to all MFT actuators.

The PC-Tool is a universal software application for setting,
commissioning, monitoring and evaluating communications with
Belimo actuators. Actuators are normally delivered with the basic
settings. They can be individually programmed using the PC-Tool

and precisely adjusted to the requirements of the system. Service related
diagnostics for the actuators are extremely easy with the PC-Tool.
Setpoints can be specified and actual values monitored The trend
recording function can output the information in a graphical format for

system documentation.
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Multi-Function Technology® BELI “16

Nomeclature

50 X -MFT
Valve o=
B2 = 2-Way Control S\lijv)i(;clﬁry
B3 = 3-Way Power Supply -MFT = Multi-
B6 = 2-Way Flanged Valve Size ) Version 24 = 24 \IAC/DC Function
ﬂ Torque Rating  x- - customized 120 = 1200 230 Technology
Non-Spring Return Cable VAC

GM =360 in-Ib 10 ft (3m)
AM =180 in-Ib 16 ft (5m)

NM =90 in-lb i
LU =27 in-Ib

AH =220 Ibf
LH =100 Ibf
New Generation
Spring Return
AF =180 in-Ib
NF =90 in-Ib
Original Spring
Return

AF =133 in-Ib
NF =60 in-Ib

LF = 35 !n_lb * Only available on New Generation Spring Return and Non-Spring
TF=18in-Ib “* Not Available on NF, LF and TF

Ordering Example

/e For MFT orders only - select programming code

o Choose the valve actuator combination. Py
B250+ARX24-MFT +NO +Tagging (if needed)

(4]

e Specify preference or configuration.

Does order
require
Set-Up tagging?
Y Y \ 4
Non-Spring Models | P-10001 (A01) | Tagging:
NO = Normally Open - Valves may be
NC = Normally Closed P-100xx (Axx)  Control voltage applications tagged per customer
P-200xx (Wxx) Pulse width modulation specification.
Spring Return Models applications
NO/FO = Normally Open/Fail Open P-300xx (Fxx)  Floating Point applications Example:
NO/FC = Normally Open/Fail Closed P-400xx (Jxx)  On/Off applications ?';321
NC/FO = Normally Closed/Fail Open KXXXXX ggf#iteuc;;?nmcgjg
NC/FC = Normally Closed/Fail Closed g
X-XXXXX Create custom MFT
Refers to valve ports A to AB. configuration in the field
with MFT-actuator PC software

e Complete Ordering Example: B250+ARX24-MFT+NO+A01

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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BELIMO

Control

Parameter Variables

Multi-Function Technology®
Overview

Description

VDC

o Start: 0.5 to 30 VDC

e Stop: 2.5 t0 32 VDC

(Minimum 2 VDC between start and stop
required)

P-100...(A...) configuration types are used for VDC control applications.
Pre-set configurations are listed which offer solutions for standard control
applications. Additional pre-set configurations are list which offer solutions
for non-standard control application for:

 Sequencing Actuators

* Adjustable Start and Stop Points

» Combination for Master Slave

Pulse Width Modulation
(PWM)

PWM Range

*0.02 to 50 sec. range minimum interval
* 20 [ms] between pulses

e Minimum cycle duration 520 [ms]

P-200... (W...) configuration types are used for pulse width modulation
control outputs with four standard ranges. There must be at least one
second between the min pulses allowed (0.02 sec.) and the max pulse
allowed (50 sec.). (eg: 0.02 to 1.02 sec.)

Floating Point

P-300... (F...) configuration types are used for floating point control outputs.
In this application MFT actuators offer constant running time and standard
feedback options. A 1N4004 diode is required for original spring return
actuators. The actuator is designed to recognize the rectified voltage as an
opposite control signal request.

On/0ff

P-400... (J...) configuration types are used for on/off control outputs.

The configuration allows for service replacement of on/off actuators when a
true on/off actuator is not available. In addition the MFT actuator offers
additional functionality in the on/off mode, such as configuration P-40003
(J03) with minimum position and 2 to 10 VDC feedback.

Position Feedback

Feedback

Position Feedback Range
o Start: 0.5 to 8 VDC Selectable
* Stop: 2 to 10 VDC Selectable

The default-operating mode of the U5 output is 2 to 10 VDC for position
feedback.

Control Sensitivity

Normal (Default)

MFT actuators are designed with a unique non-symmetrical dead band. The
actuator follows an increasing control signal with a 80 mV resolution. If the
signal changes in the opposite direction, the actuator will no respond until the
control signal changes by 200 mV. This allows the actuator to track even the
slightest deviation very accuratly, yet allowing the actuator to "wait" for a
much larger change in control signal. For quick actuators the values are half.

Reduced

Upon detecting an un-stable control loop, the "reduced" setting can be
manually selected via the PC software. This will reduce the sensitivity of the
actuator by 50%.

Meaning, control accuracy will now be 160 mV for signal changes in the
same direction. And a 400 mV signal change in the opposite direction is
needed for the actuator to change direction. Once driving in the opposite
direction the actuator will respond in 160 mV increments.

Upon improving the control loop stability you can return the actuator to the
"Normal" mode.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Spring Return Actuator Product Range ;
Multi-Function Technology BELIMO

(of:11][] . Power Power
L G Supply | Consumption

Control Input Auxillary
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= S5 = = o = o o o 2Io0|E|leS|ZS|olog|la|lalal 2
S © = < - sSl|=e < = - Sl |n|xn =]
o = (=% < < o ! =} c |l 2| So C 2 2 =
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AFX24-MFTt [} 70...220 (150)| <20¢ [ J 10(75(30)| ® [} [} [ B NN J [

New Generation AFX Series
180 in-Ib [20 Nm] AFX24-MFT-St [ ) 70...220 (150)| <20¢ | @ | 10|75(3.0)| ® o/ el o o o0 o ° [}
Approx. 45 sq. ft.*

AFX24-MFT95t 70...220 (150)| <20¢ | @ | 10|7.5(3.0)| ® [ ] e O [ J

AF24-MFT USt 75...300 (150)| <20 ® |10(60(25| @ o © o0 o

Original AF Series
133 in-Ib [15 Nm] AF24-MFT-S USt 75...300 (150)| <20 ® |10(6.0(25)| ® ool o o o0 o [}
Approx. 33 sq. ft.*

AF24-MFT95 US 75..300 (150) <20 | ® |10(60(25)| ® o ol o
a 14

New Goneration NFX Series. NPX24MFT o |[40.20(150] <20¢| ® |9 |6530)] @ oo/ o |o|e| 0 o

90 in-1b 10 Nm]

Approx. 22 sq. Tt NFX24-MFT-5 o 40,2050 <20¢| ® | 9(65(30)]| @ oje| o [o|0| e ol | o

Original NF Series
60 in-Ib [7 Nm] NF24-MFT US 75...300 (150)| <60¢ | ® 6 (30(18)| ® ool 6 o 0| o
Approx. 15 sq. ft.*

LF24-MFT US 75..300 (150)| <25¢ | @ | 5 (25(1.0)| @ oo/ o 0|0 @
. LF24-MFT-S US 75..300 (150)| <25¢ | @ | 5 |25(1.0)| ® oo/ o 0|0/ 0|0
LF Series
35 in-1b [4 Nm]
Approx. 8 5q. ft. LF24-MFT-20 US 150 | <5¢| @ | 63505 ° oo o (0|0 @
LF24-MFT-5-20 US 150 [<25¢| @ | 635015 ° oo/ o 0|0/ 0|0
TF Series
18 in-lb [2 Nm] TF24-MFT US 75..300 (150)| <25¢ | ® | 4 |20(1.0)| ® oo/ o 0|0 @

Approx. 4.5 sq. ft.*

4 <60 seconds @ -22°F [-30°C].
t Dual mounting on a single shaft-MFT wired master slave. Please refer to page XX or call Belimo customer service for details.
* Parallel blade without edge seals and 1000 FPM face velocity.

NOTE: Some spring and non-spring damper actuators are also used for water applications. A linkage connects the actuators to the valve. Some of the valves, such as the PICCV use
a running time of 100 seconds. Some actuators end with an X1 such as AMX24-MFTX1.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

4

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.



M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

BELIMO

Non-Spring Return Actuator Product Range

Multi-Function Technology

Control Input

Custom Running Power Power
Options Time Supply | Consumption M FT
@ o =
2 . s |8 =
= T S =| G wo| 8 +
5 28 |3 2|8 Sl &| | 5
~ jT + %) ] I} o
=l 3| £ |3 2l2 8813 |S i
S g | > =4 | solo| =l o S
2| ¥ £2 |S|e 2 |E2|8 Sd|la|El &S z
Zles| £% |8|= € 3|5 =l 8|23 52 S
S| EA o= (== Elacs|c|la|l o a
=128 £2 |3|g8le| 25 |a2ls| |2]99| 2o 8: v
SIE2| 2k |2|S|5| 82 |S8|2||2| 58|88 5 | 3
=1E=l €% (23| E2|22|2|C|8|s52(2|2|gg| = 3
2lez| = |32 = |as|2|S5|2|a8|z|a|E8] =2 b+
GMX24-MFT+ ° 75-300 (150) | ® 7 |40(15)| e o|lo| o (0|0 @ °
GMX Series 360 in-Ib [40 Nm]
Approx. 90 sq. ft.**
GMX24-MFT95t ° 100-300 (150)| ® 7 |4.0(15) ° o| o °
AMX24-MFT ° 90-300 (150) | ® 6 [35(1.3)| ® o|lo| o (0|0 @ ° °
AMX Series 180 in-1b [20 Nm] AMCX24-MFT ° 35-120 (35) | ® 6 (3513)| e e|le| o |o]e| @ °
Approx. 45 sq. ft.**
AMX24-MFT95 ° 90-150 (150) | ® 6 |35(1.3) ° o| o °
AMQ Series 140 in-Ib [16Nm] AMQX24-MFT ° 7-15(7) | @ 18 [12(15)| @ o|lo| o (0|0 @ °
NMX24-MFT ° 45-150 (150) | ® 6 (35(1.3)| @ o|lo| o (0|0 o ° °
NMX Series 70 in-Ib [8 N
Series 70 in-1b {8 Nm] NMX24-MFT95 ° 45150 (150)| ® 6 [35(13) ° ol o | o
Approx. 22 sq. ft.**
NMCX24-MFT ° 20-75(20) | ® 5 (30(06)| ® o| o °
NMQ Series 70 in-Ib [8Nm] NMQX24-MFT ° 4-20(4) | @ 18 [12(15)| ® e|lo| o o| o °
LMX24-MFT ° 35-200 (150) | ® 5(25(12)| e o|lo| o (0|0 o °
LMX Series 35 in-Ib [4 Nm]
Approx. 11 sq. ft.**
LMX24-MFT95 ° 35-150 (150) | ® 5 25(1.2) ° o| o °
LMQ Series 35 in-Ib [4Nm] LMQX24-MFT ° 2510 (25) | ® 18 [12(15) | @ o|lo| o o| o °
AHX Series 101 [bf [450 N Force] AHX24-MFT* ° 1500 | e 6 [35(13)| e e|o| o |o|e]| o
4” or 8” stroke
AHQ Series 44 Ibf [200 N Force] AHQX24-MFT-100 ° 7-30(7)* | ® 18 [12(15)| ® o|lo| o (0|0 o
LHX Series 34 Ibf [150 N F
HX Series 34 Ibf | orce] LHX24-MFT* ° 75150 (150)*| ® 5 [25(12)| e o|o| o |o|e]| o
4” or 8” stroke
LHQ Series 22 Ibf [100 N Force] LHQX24-MFT-100 ° 35-15(35)" | ® 18 [12(15)| ® o|lo| o o| o
LUX Series 27 in-Ib [3 Nm] LUX24-MFT ° 75-150 (150) | ® 5 (25(12)| e o|lo| o (0|0 @

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

* The LH and AH linear series actuators come in three different stroke lengths [4, 8 or 12 in]. The part number is followed by -100, -200, -300 respectively. The default
running time is 150 seconds per 4 inches [100 mm]. Running time is adjustable depending on model:
LH Series: 70-270, 140-540, 200-810, on the -100, -200, -300 models respectively.
AH Series: 150-600, 300-1200, 450-1800, on the -100, -200, -300 models respectively.

LHQ and AHQ available in 4 inch version only.
+ Dual mounting on a single shaft is possible for higher torque (-3 and -SR wired in parallel), (-MFT wired Master-Slave). Please call Belimo customer service for details.
** Parallel blade without edge seals and 1000 FPM face velocity.
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Pre-Set MFT Configurations

DC Voltage Control

Spring Return Actuators

BELIMO

Application

How the MFT actuator performs is determined by the configuration (P-10001,

AFX24-MFT(-S) 180 in-1b A01). The old generation actuators used a P-code (P-10001). The new
AF24-MFT(-S) US 133 in-lb generation actuators use a shorter 3 digit code. This shorter code is displayed
NFX24-MFT(-S) 90 in-b on the reorder number.
NF24-MFT US 60 in-Ib P-1000... configuration types are used for control voltage applications.
LF24-MFT(-S) US 35 in-Ib /:g(:ll(gl:rr:jalcgrrﬁ;zf;;gIr;zlz?tlij(;ﬁtlf%r::s are listed which offer solutions for non-
LF24-MFT(-5)-20US 35 in-lb « Adjustable Start and Stop points
TF24-MFT US 18 in-Ib * Sequencing actuators LSTED
. « Combination for master slave (see page 19.) c E REG, EQUIP. "@“s
Non-Spring Return Actuators
b GMX24-MFT 360 fn-lb Wiring Diagram
/". AMX24-MFT 180 in-Ib o
/ NMX24-MFET 90 in-Ib 24 VAC/DC Transformer E
LMX24-MFT 45 in-Ib Line \ (1) | Common
AMQX24-MFT 140 in-Ib Volts \ (2) | + Hot
NMQX24-MFT 70 in-Ib —] @3) | ¥ nput
LMQX24-MFT 35 in-Ib Control Signal 53 =
AHX24-MFT 101 Ibf —| (5) | U Output
AHQX24-MFT-100 44 1bf Position Feedback () | cow_ow
LHX24-MFT 34 Ibf ---MFT
LHQX24-MFT-100 22 Ibf
LUX24-MFT 27 in-lb VDC
Select Configuration
Configuration Code Input Range Position Feedback  Running Time Torque % Adaptation
P-10001* A01 2.0t0 10.0 VDC 2.0t0 10.0 VDC 150 100 MANUAL
P-10002 A02 0.5t010.0 VDC 0.5t010.0 VDC 150 100 MANUAL
P-10003 A03 2.0t010.0 VDC 0.5t0 5.0 VDG 150 100 MANUAL
P-10004 A04 4.0t07.0VDC 2.0t010.0 VDC 150 100 MANUAL
P-10005 A0S 6.01t09.0 VDC 2.0t010.0 VDC 150 100 MANUAL
P-10006 A06 10.5t013.5VDC 2.0t010.0 VDC 150 100 MANUAL
P-10007 A07 0.5t05.0VDC 2.0t010.0 VDC 150 100 MANUAL
P-10008 Ao8 0.5t0 5.0 VDC 0.5t0 10.0 VDC 150 100 MANUAL
P-10009 A09 5.0t0 10.0 VDC 2.0t010.0 VDC 150 100 MANUAL
dé’ P-10010 A10 5.0t010.0 VDC 0.5t010.0 VDC 150 100 MANUAL
E P-10013 A13 0.5t010.0 VDC 2.0t010.0 VDC 150 100 MANUAL
P-10015 A15 2.0t05.0VDC 2.0t010.0 VDC 150 100 MANUAL
P-10016 A16 2.0t0 6.0 VDC 2.0t010.0 VDC 150 100 MANUAL
P-10017 A17 6.0t0 10.0 VDC 2.0t0 10.0 VDC 150 100 MANUAL
P-10018 A18 14.0t017.0 VDC 2.0t010.0 VDC 150 100 MANUAL
P-10020 A20 9.0t0 12.0 VDC 2.0t010.0 VDC 150 100 MANUAL
P-10031 A31 0.5t04.0VDC 2.0t010.0 VDC 150 100 MANUAL
P-10063 AB3 0.5t04.5VDC 0.5t04.5VDC 150 100 MANUAL
P-10064 AG4 5.51010.0 VDC 5.51t010.0 VDC 150 100 MANUAL
P-10091 A9t 2.0t010.0 VDC 2.0t010.0 VDC 95 100** MANUAL

* P-10001 (A01) is the default configuration code.
** Reduced torque in Spring Return (see page 19)

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Pre-Set MFT Configurations
Pulse Width Modulation Control

BELIMO

Spring Return Actuators Application

How the MFT actuator performs is determined by the configuration (P-10001,

AFX24-MFT(-S) 180 in-Ib A01). The old generation actuators used a P-code (P-10001). The new
. generation actuators use a shorter 3 digit code. This shorter code is displayed
AF24-MFT(-S) US 133 in-Ib on the reorder number.
NFX24-MFT(-S) 90 in-Ib P-2000... configuration types are used for Pulse Width Modulation control
NF24-MFT US 60 in-Ib outputs. Most D.D.C. controllers have digital outputs which incorporate a default
- PWM range.
LF24-MFT(-S) US 35 in-1b This enables a D.0. to be used as a proportional output when needed. Simply
LF24-MFT(-S)-20 US ~ 35in-Ib select the appropriate configuration code according to your application.
TF24-MFT US 18 in-lb
LISTED
94 D5
c € RE. EQUp. °@”s
Non-Spring Return Actuators
/,"r“’. _ GMX24-MFT 360 in-Ib Wiring Diagram
Ao/ AMX24-MFT 180 in-Ib 24 VAC Transformer (AC only) %
NMX24-MFT 90 in-1b =
LMX24-MFT 45 in-Ib e | ! (1] Common
il Volts ——| @) | +Hot
AH24-MFT 101 Ibf :__]_
Position (=) — ! (3) | Y Input
LH2A-MFT 44 Ibf Feedback VDC (+) — | (5) | U Output
LUX24-MFT 27 in-1b
CCW CWwW
...MFT
PWM, Triac Source and Sink

Select Configuration

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

Configuration Code Input Range Position Feedback  Running Time Torque % Adaptation

P-20001 wo1 0.59t0 2.93 sec 2.0t0 10.0 VDC 150 100 MANUAL
.§ P-20002 w02 0.02 to 5.00 sec 2.0t0 10.0 VDC 150 100 MANUAL
§ P-20003 wos3 0.10 to 25.50 sec 2.0t0 10.0 VDC 150 100 MANUAL
=8l P-20004 Wo4 0.10 to 25.60 sec 2.0t0 10.0 VDC 150 100 MANUAL
§ P-20005 W05 0.10t0 5.20 sec 0.5t05.0VDC 150 100 MANUAL
% P-20012 W12 0.50 to 25.50 sec 0.5t0 10.0 VDC 150 100 MANUAL
§ P-20013 W13 0.50 t0 2.93 sec 0.5t05.0VDC 150 100 MANUAL

P-20014 W14 0.10 to 10.00 sec 2.0t0 10.0 VDC 150 100 MANUAL

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Pre-Set MFT Configurations

Floating Point Control

Spring Return Actuators

BELIMO

Application
How the MFT actuator performs is determined by the configuration (P-10001,

AFX24-MFT(-S) 180 in-Ib AO01). The old generation actuators used a P-code (P-10001). The new
AF24-MFT(-S) US 133 in-lb generation actuators use a shorter 3 digit code. This shorter code is displayed
: on the reorder number.
NFX24-MFT(-S) 90 in-Ib
_ . P-3000... configuration types are used for floating point control outputs. In this
NF24-MFT US 60 in-Ib application MFT actuators offer constant running time and standard feedback
LF24-MFT(-S) US 35 in-lb options. A IN4004 or IN4007 diode is required for original spring return
LF24-MFT(-S)-20 US 35 in-Ib actuators only.
TF24-MFT US 18 in-Ib Wiring Diagram
24 VAC Transformer (AC only) g
Non-Spring Return Actuators . the control panel. -+ =
\L,'n: Reduces field wiring
- ots ||| | }————-~ 1
Brbe GMX24-MFT 360 in-Ib !
A®  awoswr 180 in-Ib |
Hot com |
NMX24-MFT 90 in-Ib ‘\ ; I (1) | Common
LMX24-MFT 45 in-lb Triac Source ; : o |
- Wiring 0 (3) | Y Input
AHX24-MFT 101 Ibf YA : | ) | U output
LHX24-MFT 34 Ibf ° I cow cw
. ...MFT
LUX24-MFT 27 in-Ib A ;;4} o)
?‘ : Position
Controller ° | Feedback
LA
_______________ 1
Wiring Diagram A IN4004 or IN4007 diode. Direction of rotation switch
< (IN4007 supplied, Belimo
24 VAC Transformer (AC only) s part number 40155) ccw ccw
Diode may be placed at =
Line T el o ow ow
Volts | | | | |-——""-—-% f I — » »
: A Triac A and B can also be A B A A B A
: contact closures. — |~ — |~
Hot COoM | Why is a diod ired?
N e o
— recognize the rectified voitage
Triac Sink | I (2) | + Hot A as ar?opposite control signaﬁ request.
- ——1 3) | Y Input " . -
erlng A : A Position feedbgck cannot be used with a Trlac sink cont_roller.
| | (5) | U Output The actuators internal common reference is not compatible.
~ ! ccw cw A The Common connection from the actuator must be
A __4& ...MFT connected to the Hot Connection of the controller.
A A A The actuator Hot must be connected to the control board Common.

Controller g

|
: Position
|
|
|

A

connect to controller using wires 3 & 4.

Feedback

NOTE: Diode is internal on new generation spring return and non-spring return type actuators,

A MFT actuators are compatible with contact closure, triac source
and triac sink type contollers.

Floating Point

controller using wires 3 & 4.

NOTE: Diode is internal on new generation spring and non-spring return type actuators, connect to

Select Configuration

Configuration Code Input Range Position Feedback  Running Time Torque % Adaptation
P-30001 FO1 Floating Point 2.0t010.0 VDC 150 100 MANUAL
P-30002 F02 Floating Point 0.51010.0 VDC 150 100 MANUAL
g P-30003 FO3 Floating Point 2.0t010.0 VDC 100 100 MANUAL
§ P-30004 FO4 Floating Point 0.5105.0 VDC 100 100 MANUAL
=l P-30005 F05 Floating Point 0.51010.0 VDC 100 100 MANUAL
‘g P-30006 FO6 Floating Point 0.5105.0 VDC 150 100 MANUAL
'-E P-30007 FO7 Floating Point 2.0t010.0 VDC 300 100 MANUAL
u_c., P-30008 FO8 Floating Point 2.0t010.0 VDC 75 100* MANUAL
P-30009 F09 Floating Point 2.0t010.0 VDC 85 100* MANUAL
P-30010 F10 Floating Point 0.5t02.5VDC 150 100 MANUAL

* Reduced torque in Spring Return (see page 19)
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BELIMO

Spring Return Actuators

AFX24-MFT(-S) 180 in-lb
AF24-MFT(-S) US 133 in-Ib
NFX24-MFT(-S) 90 in-Ib
NF24-MFT US 60 in-Ib
LF24-MFT(-S) US 35 in-Ib
TF24-MFT US 18 in-Ib
Non-Spring Return Actuators
/‘,-;"__\ GMX24-MFT 360 ?n-lb
Al AMX24-MFT 180 in-Ib
NMX24-MFT 90 in-Ib
LMX24-MFT 45 in-lb
AMQX24-MFT 140 in-lb
NMQX24-MFT 70 in-Ib
LMQX24-MFT 35 in-Ib
AHX24-MFT 101 Ibf
AHQX24-MFT-100 44 |bf
LHX24-MFT 34 Ibf
LHQX24-MFT-100 22 Ibf
LUX24-MFT 27 in-Ib

Select Configuration

Pre-Set MFT Configurations
On/0ft Control, P-4000... (J...)

Application

How the MFT actuator performs is determined by the configuration (P-10001,
A01). The old generation actuators used a P-code (P-10001). The new
generation actuators use a shorter 3 digit code. This shorter code is displayed
on the reorder number.

P-4000... configuration types are used for on/off control outputs. The
configuration allows for service replacement of on/off actuators when a true on/
off actuator is not available.

In addition the MFT actuator offers additional functionality in the on/off mode,
such as configuration P-40003 with minimum position and 2 to 10 VDC
feedback.

Wiring Diagram

24 VAC/DC Transformer =
Line | (1) | Common
Volts o | @) | Hot

ion () — I_/ ;

Position ._l 3) | Y Input
Feedback VDC (+) ————— | (5) | U Output
CCwW Cw
...MFT
On/Off

S
=
=
=
S
(x}
=
(=}
—
=
(=]

Configuration Code Input Range Position Feedback  Running Time Torque % Adaptation
P-40001 Jo1 On/Off 2.0t010.0 VDC 75 100* MANUAL
P-40002 J02 On/Off 2.0t010.0 VDC 150 100 MANUAL
P-40003 Jo3 On/Off 2.0t010.0 VDC 75 100* MANUAL
P-40004 Jo4 On/Off 0.5t05.0VDC 100 100 MANUAL
P-40005 Jo5 On/Off 0.5t0 10.0 VDC 100 100 MANUAL

* Reduced torque in Spring Return (see page 19)
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Multi-Function Technology® BELIMO

Operation

All MFT actuators have built-in
brushless DC motors which provide better
accuracy and longer service life.

Control Accuracy and Stability

(GM/AM/NM /LM /AH/LH/LU/GR /AR /

Control Accuracy and Stability
(AF /NF /LF / TF)

The ...MFT US actuators are deSigned with a unique nOn'Symmetrical Belimo non-spring return actuators are designed with a unique non-
deadband. The actuator follows an increasing or decreasing control symmetrical deadband. The actuator follows an increasing or decreasing
signal with a 80 mV resolution. If the signal changes in the opposite control signal with a 75 mV resolution. If the signal changes in the
direction, the actuator will not respond until the control signal changes by opposite direction, the actuator will not respond until the control signal
200 mV. This allows these actuators to track even the slightest deviation changes by 175 mV. This allows these actuators to track even the
very accurately, yet allowing the actuator to “wait” for a much larger slightest deviation very accurately, yet allowing the actuator to “wait” for a
change in control signal due to control signal instability. much larger change in control signal due to control signal instability.

AF / NF / LF / TF Actuators responds to a 80 mV Actuator responds to a 75 mV signal when
signal when not changing direction from stop position. not changing direction from stop position.

Satisfied Satisfied
Control Position Control Position

Minimum Minimum
Control Resolution Control Resolution
AF / NF / LF / TF Actuators responds to a 200 mV Actuator responds to a 175 mV signal when
signal when reversing direction from stop position. reversing direction from stop position.

Minimum Reversed Minimum Reversed

Control Deadband Control Deadband \7
Prior to Normal Control\7 Prior to Normal Control 175 mV
\ Satisfied

Satisfied
Control Position

Control Position

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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, Multi-Function Technology®
BEL' MO Operation

All Belimo actuators have built-in
brushless DC motors which provide better
accuracy and longer service life.

Control Accuracy and Stability
(AMQ / NMQ / LMQ / AHQ / LHQ)

Belimo Quick Running non-spring return actuators are designed with a
unique non-symmetrical deadband. The actuator follows an increasing or
decreasing control signal with a 40 mV resolution. If the signal changes
in the opposite direction, the actuator will not respond until the control
signal changes by 100 mV. This allows these actuators to track even the
slightest deviation very accurately, yet allowing the actuator to “wait” for a
much larger change in control signal due to control signal instability.

Actuator responds to a 40 mV signal when
not changing direction from stop position.

Satisfied
Control Position

o
— \

Minimum
Control Resolution

Actuator responds to a 100 mV signal when
reversing direction from stop position.
Minimum Reversed

Control Deadband \7
Prior to Normal Control 100 mV

Satisfied
Control Position

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

11



Multi-Function Technology®

Operation

Running Time

Rotation

Motion Parameter Variables

BELIMO

Description

New Generation AF 70 to 220 seconds

New Generation NF 40 to 220 seconds
AF /NF /LF/TF 75 t0 300 seconds
GM 75 to0 300 seconds
AM* 90 to 350 seconds
NM* 45 to 150 seconds
AH* 7510 150 seconds
LM* 35 to 150 seconds
LH* 7510 150 seconds
LU 75 to 150 seconds

Running time is selectable allowing for customizing the actuator for the
application at hand. Adjustable running time allows for:

» Matching HVAC system sequence of operation.

* Improving control loop stability.

» Reducing actuating noise (slower running).

* Retrofit applications

The running time is constant and independent of load.

Direction of Rotation Default or Reversed

The direction of rotation can be "Direct" or "Reverse" acting of the control
signal. The direction of rotation is selected from a CW and CCW switch
located on the actuator.

An alternative method of changing the direction of rotation is to use the
PC-Tool software. This option allows you to make remote set-up corrections
without having the need to be at the actuator.

Selection of the direction of rotation is only possible via the PC-Tool
software or manually with the switch on the actuator. Selection via a preset
configuration is not an option.

Intermediate
Position

Control

(Override Control)

» Minimum Position (Default 0%)
e Intermediate Position (Default 50%)
» Maximum Position (Default 100%)

Intermediate Positions are achieved
through ‘forced override’ positions.

SEE FIGURE A — FORCED OVERRIDES.

All intermediate settings are adjustable from 0 to 100%. Programmed as
default, these control positions are possible by using the wiring diagram in
FIGURE A. The override functions can be used as a means to test the
actuator’s functionality during equipment servicing or troubleshooting.
Intermediate positions can also be integrated into the control circuit as a
part of the sequence of operation.

The Min, Mid, and Max positions can be used in any MFT control mode.

 VVDC: For stand-alone controllers where a minimum position is needed.
* PWM: Eliminate add-on accessories.
* Floating Point: New functionality to a common application.
 On/0ff: New functionality to a common application.
— Satisfy combustion air requirements or boiler sequencing with O/A damper.

— Eliminates secondary minimum position dampers.

* Quicker running actuators are available. Contact Belimo Customer Service for details.

FIGURE A - Forced Overrides

<J [%] 5
OPEN (100%) S
5
[
Max. 70% g
ax. o >
%\“f@“@& [ S
e
Min. 30% >
CLOSE (0%) “—t+—+++—+—+++++>

012345678910 [VDC]

Full control signal range is maintained between
min and max rotation positions.

i.e.: AM24-MFT on Belimo CCV, adjusting
actuator to damper flow characteristics.

Controller 0...10 VDC

Line
Volts

Digital Output, Relay Contacts,
Multiple Position Switch

Example Position Switch

Position
0% Close A
s 30% Minimum B
50% Mid C
70% Maximum D
100% Open E
2...10VDC | Normal F

Position Feedback
2...10 VDC (Default)

12 3 5 | IN4004 diode required.
Blk Red Wht Wht One each for switch position ‘C&E’
-+ Y Us where indicated

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Multi-Function Technology®

BEL"VIO Operation

Motion Parameter Variables Description

Adaptation OFF When the manual override button is depressed, and released, the actuator
will perform synchronization. The actuator will simply drive to the mechanical
zero position and return to its last control position.

ON - Manual The default setting for adaptation is “ON — Manual”.
When the ON-Manual setting is selected, adaptation is initiated by:

* Pressing the manual override button twice (GM / AM / NM / LM).
* Clicking the CW/CCW switch twice (AF, NF, LF and TF).

When adaptation is selected, (On-Manual or Automatic) the actuator will drive
one full cycle to its mechanical end stops OR the valves mechanical seats.
Upon completion of this cycle the actuators working range (input, feedback and
running time) will be adapted to the actual mechanical angle of rotation.

ON - Automatic When the ON-Automatic setting is selected at every power-up the actuator
will automatically adapt to the mechanical angle of rotation. Also upon
pressing the manual override button or CW/CCW switch, adaptation is
initiated (See above).

.E- Sound and All Actuators As the speed of the actuator increases, there is an increase in the sound

[l Running Time power level.

(=]

E

(-}

o

E Torque and Original Spring Return (AF / NF / LF) Though the running time remains constant, at approximately the 100-second
=8 Running Time range there is a loss in output torque. This is due to the association of

g runtime to torque. To gain a faster running time there is a loss in torque.

g SEE FIGURE B.

FIGURE B - Torque and Run Time

Torque and Run Time, AF24-MFT US Torque and Run Time, NF24-MFT US Torque and Run Time, LF24-MFT US

TORQUE [in-Ib] TORQUE [in-Ib] TORQUE [in-1b]

A 1

183 ‘
100 % torque curve
116
67
52
i Ly [ i o | } >
75 100 150 75 100 150 75 100 150
Running time [s] Running time [s] Running time [s]

NOTE: All new generation spring return and non-spring return actuators are torque independent of speed.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Multi-Function Technology®

Specifications/Descriptions

Specifications

Parameter Variables

BELIMO

Description

Alarms - Fault
A fixed voltage of 8.5 VDC is present when
Alarm ‘sounds’.

Hunting

A;(h)x100

& =Motion Percentage
Ot (h)

140x100 _ 550,
700

Alarm criteria: Actuator is hunting due to unstable control loop.

This fault occurs when the ratio of Active time to Operating time exceeds
20%.

Operating time: Total number of hours connected to power supply Active
time: Total number of hours the actuator is in mechanical motion.

Mechanical Overload

Alarm criteria: Actuator is in a position and not responding to the control
input. An alarm will ‘sound’ when an object or circumstance is preventing
the motion of the actuator, damper or valve. The actuator has initiated its
own overload protection after a period of 13 seconds.

Mechanical Travel

Alarm criteria: Actuator is adapted to the working angle of a damper or
to the stroke of a valve and is less than 95-degree actuator rotation (eg.
75° adapted angle). An alarm will ‘sound’ when the actuator detects a
mechanical travel difference of 10% above the adapted angle (eg. 82.6°).

Alarm - Maintenance
A fixed voltage of 5.5 VDC is present when
Alarm ‘sounds’.

Mechanical load limit
(Non-Spring Return Only)

Alarm criteria: The torque load of the application has exceeded the
actuator’s torque.

A typical scenario — the torque requirements has increased due to:

e Lack of lubrication

e Increased flow

e Improper installation

* Damage

e Dirt and debris build-up

The alarm ‘sounds’ when the specified torque rating of the actuator has

been exceeded for a period of 5 seconds.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Multi-Function Technology®

BEL' MO Specifications/Definitions

Service Parameter Variables Description

Identification Serial Number Displays the actuators internal serial number.

Actuator Type / Software Version Displays the actuator nomenclature (AFX24-MFT US) and MFT software version.

Assembly Location Displays the where the actuator was assembled.

Setpoint Displays the actual control input position as a percentage. As signal input
changes you will see the setpoint percentage change accordingly.

Actual Values Actual Position Displays the actual position as a percentage. As the setpoint changes the
actual position percentage will increase or decrease accordingly. If the
actuator is capable of rotating the damper or valve, this can be of benefit
when troubleshooting an application.

Function Control Type & Setting Displays the actual control type and operating range.

Feedback Type & Setting Displays the actual feedback signal type and operating range.
@ Torque % Setting Displays the actual torque setting, as a percentage of minimum torque.
g_ Running Time Displays the actual running time as programmed in seconds.
a Direction of Rotation Displays the status of the direction of rotation option (Normal or Reversed).
Min, Mid, Max Position Displays the actual position setting of the Intermediate position control.
Adaptation Displays the actual setting of the adaptation function (OFF, ON-Manual, ON-
Automatic).
Sensitivity / Hysteresis Displays the actual setting of the sensitivity (Normal or Reduced).
Synchronization Displays the actual setting of the synchronization function (Normal, Sync at
0%, Sync at 100%).
Data Log Total Time / Operating Time Total number of hours the actuator is connected to a power supply.
Active Time Total number of hours the actuator is in motion.
Stop / Go Ratio (Hunting %) Displays a percentage the total number of hours the actuator has spent in
mechanical motion, comparing the total time to the active time.

Sensitivity Normal, Reduced Displays the setting of the sensitivity function.

Messages Displays all messages present. Messages can be deleted as well.

Function Test This function enables you to check for complete opening and closing of the
actuator.

The test report contains:

* Information on the Project

* |dentification on the Actuator

* Alist of fault messages pending before the start of the test

* The test steps and results

* The current actuator settings

This is of benefit when troubleshooting an application, as the actuator
will drive the damper or valve. This gives an opportunity to observe the
installation to identify any possible problems.

Adaptation See Adaptation on page 13. Initiates the adaptation feature of the MFT actuator. The actuators working
range (input, feedback, and running time) will be adapted to the actual angle
of rotation.

This is of benefit when troubleshooting an application, as the actuator will
drive the damper or valve. This gives you an opportunity to observe the
installation to identify any possible problems.

Synchronization Normal At initial commissioning, when the manual override button is pressed, the
actuator runs to a default position defined by the position of the CW/CCW
direction of rotation switch.

Sync at 0% At each power-up (includes power failures), the actuator runs to a default
position defined by the position of the CW/CCW direction of rotation switch.

Sync at 100% At each power-up (includes power failures), the actuator runs to a default
position of the CW/CCW direction of rotation switch.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Multi-Function Technology®
Wiring

with electronic circuits. Disconnect power supply before attempting

any wiring connections or changes. Make all connections in
accordance with wiring diagrams and follow all applicable local and national
codes. Provide disconnect and overload protection as required. Use copper,
twisted pair, conductors only. If using electrical conduit, the attachment to the
actuator must be made with flexible conduit.

2 WARNING The wiring technician must be trained and experienced

Always read the controller manufacturer's installation literature carefully
before making any connections. Follow all instructions in this literature. If you
have any questions, contact the controller manufacturer and/or Belimo.

Transformer(s)

Non-spring return actuators require a 24 VAC class 2 transformer and draws a
maximum of 5 VA per actuator. The actuator enclosure cannot be opened in the
field, there are no parts or components to be replaced or repaired.

— EMC directive: 89/336/EEC
— Software class A: Mode of operation type 1
— Low voltage directive: 73/23/EEC

CAUTION: 1t is good practice to power electronic or digital controllers from a
separate power transformer than that used for actuators or other end devices.
The power supply design in our actuators and other end devices use half wave
rectification. Some controllers use full wave rectification. When these two
different types of power supplies are connected to the same power transformer
and the DC commons are connected together, a short circuit is created across
one of the diodes in the full wave power supply, damaging the controller. Only
use a single power transformer to power the controller and actuator if you know
the controller power supply uses half wave rectification.

Typical Transformer Sizing

Actuator Series Voltage Required VA Per Actuator
New Generation AF |24 10*
Original AF 24 10
New Generation NF |24 i
Original NF 24 6
LF 24 6
TF 24 4
GMB/GRB 24 7
AMB/ARB 24 6
NMB 24 6
LMB/LRB 24 5
AHB 24 6
LHB 24 5
LUB 24 5
AMQB 24 18
NMQB 24 18
LMQB 24 18
AHQB 24 18
LHQB 24 18

* @ 70 second run time
** @ 40 second run time

Multiple Actuators, One Transformer

Multiple actuators may be powered from one transformer provided the following

rules are followed:

1. The TOTAL current draw of the actuators (VA rating) is less than or equal to
the rating of the transformer.

2. Polarity on the secondary of the transformer is strictly followed. This means
that all No. 1 wires from all actuators are connected to the common leg on
the transformer and all No. 2 wires from all actuators are connected to the
hotleg. Switching wire No. 1 & 2 on one leg of the transformer will result in
erratic operation or failure of the actuator and/or controls.

BELIMO

Multiple Actuators, Multiple Transformers

Multiple actuators positioned by the same control signal may be powered from

multiple transformers provided the following rules are followed:

1. The transformers are properly sized.

2. All No. 1 wires from all actuators are tied together and tied to the negative leg
of the control signal. See wiring diagram on page 11.

Wire Lengths for Actuators

Keep power wire runs below the lengths listed in the Figure H. If more than one
actuator is powered from the same wire run, divide the allowable wire length by
the number of actuators to determine the maximum run to any single actuator.

Example: 3 actuators, 16 Ga wire
350 Ft + 3 Actuators = 117 Ft. Maximum wire run

LH-24.../LU-24... LM-24.../CM24

Wire Size Max. Feet. Wire Size Max. Feet
16 Ga 1175 Ft. 16 Ga 1125 Ft.
18 Ga 1075 Ft. 18 Ga 750 Ft.

20 Ga 575 Ft. 20 Ga 400 Ft.

22 Ga 300 Ft. 22 Ga 200 Ft.
NM-24.../AH-24.../LMX120... AM-24...

Wire Size Max. Feet. Wire Size Max. Feet
12 Ga 1250 Ft. 12 Ga 1150 Ft.
14 Ga 1130 Ft. 12 Ga 925 Ft.

16 Ga 900 Ft. 16 Ga 550 Ft.

18 Ga 575 Ft. 18 Ga 375 Ft.

20 Ga 300 Ft. 20 Ga 200 Ft.

22 Ga 150 Ft. 22 Ga 100 Ft.
GM.../NMX120.../AMX120...

Wire Size Max. Feet. Wire Size Max. Feet
12 Ga 1125 Ft. 18 Ga 325 Ft.

14 Ga 800 Ft. 20 Ga 175 Ft.

16 Ga 500 Ft. 22 Ga 90 Ft.

FIGURE H - Maximum Wire Lengths

Wire Type and Wire Installation Tips

For most installations, 18 or 16 Ga. cable works well with the non-spring return
actuators. Use code-approved wire nuts, terminal strips or solderless
connectors where wires are joined. It is good practice to run control wires
unspliced from the actuator to the controller. If splices are unavoidable, make
sure the splice can be reached for possible maintenance. Tape and/or wire-tie
the splice to reduce the possibility of the splice being inadvertently pulled apart.

The non-spring return proportional actuators have a digital circuit that is

designed to ignore most unwanted input signals (pickup). In some situations the

pickup may be severe enough to cause erratic running of the actuator. For

example, a large inductive load (high voltage AC wires, motors, etc.) running

near the power or control wiring may cause excessive pickup. To solve this

problem, make one or more of the following changes:

1. Run the wire in metallic conduit.

2. Re-route the wiring away from the source of pickup.

3. Use shielded wire (Belden 8760 or equal). Ground the shield to an earth
ground. Do not connect it to the actuator common.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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BELIMO

ATTENTION

Master-Slave is the correct method for wiring multiple Belimo MFT actuators to
a single load. For example, you can have up to three AFX24-MFT on a single
damper jackshaft or two GMX24-MFT on a large butterfly valve.

The current Belimo solution is to mount multiple actuators onto the damper or
valve. In the past this required the installer to wire the actuators in a “master-
slave” arrangement. This was typical for the AF24-SR US actuator.

By adding more actuators you can effectively increase the torque proportional to
the minimum specified torque times the number of actuators. This is normal as
seen on the following installations.

e Large dampers or valves
e Large multiple section dampers

Multiple actuators mounted to one control shaft

e Rack and Pinion style globe valves
o Ball or Butterfly valves

Model Max. Qty Per Shaft Torque Generated
AFX24-MFT(-S) 3 432 in-lb
NFX24-MFT(-S) 1 90 in-Ib
LF24-MFT(-S) US 1 35.in-Ib
GMX24-MFT 2 640 in-lb
AMX24-MFT 1 180 in-Ib
NMX24-MFT 1 90 in-lb
LIMX24-MFT 1 45 in-lb
GKX24-MFT 2 720 in-lb

The wiring method for multiple actuators mounted to shafts which are not
mechanically connecting other actuators is to wire the control signal in parallel
with each actuator.

Multiple XM24-MFT95...

EXCEPTION No mechanical dual mounting of AFX24-MFT US is possible.
Electrical parallel wiring of AFX24-MFT95 is possible only for
mechanically separate applications.

SOLUTION  For increased torque requirement use AFX24-MFT95 as a master
and the slave must be an AFX24-MFT. The masters feedback must
match the slaves input signal. (Both are default 2-10 VDC.)

INSTALLATION NOTES

Provide overload protection and disconnect as required.

CAUTION Equipment damage!
Actuators may be connected in parallel if not mechanically mounted to the
same shaft. Power consumption and input impedance must be observed.

Actuators may also be powered by 24 VDC.

Control signal may be pulsed from either the Hot (source)
or the Common (sink) 24 VAC line.

APPLICATION NOTES

s> P> X

The ZG-R01 500 Q resistor may be used.

A WARNING Live Electrical Components!

During installation, testing, servicing and troubleshooting of this product, it may
be necessary to work with live electrical components. Have a qualified licensed electrician
or other individual who has been properly trained in handling live electrical components
perform these tasks. Failure to follow all electrical safety precautions when exposed to live
electrical components could result in death or serious injury.

Multi-Function Technology®

Wiring
8\
24 VAC Transformer Master §
A E
Line * | (1) | Common
Volts I (2) | +Hot

A

Control Signal (-)

21010 VDCor (+) —® | (3) | Yinput,2t010v
4t020 mA 500
‘ 172 watt — (5) | Uouput2totov
CCw cw
w ...MFT
Slave
| (1) | Common
Maximum # actuators | (2) | +Hot
per shaft, see chart
on this page.
—I (3) | Yinput,2to10V
| (5 | U
Yyvy CCw cw

A w ...MFT

Wiring multiple ...MFT actuators to one shaft.
All MFT actuators are wired in master-slave configuration.

Wiring of multiple ...MFT actuators on valves must be master-slave (wires 3-5).

MFT actuator configurations should also co-ordinate with each other.
Meaning the master input = controllers output. Master output = slave input.
Slave output = controller input.

24 VAC Transformer Master z‘
A .11025.5 sec | (1) ¢ =
Line ommon
Volts A
| (2) | +Hot
Position E)— | b L I (3) | Yinput
Feedback VDC
oto5vDec  (+) — (5) | Uouput
2to 10 VDC
CcCw cw
w ...MFT
Slave
| (1) | Common
I (2) | +Hot
(3) | Yinput
—I 21010 VDC
| (5) | U Output
0to5VDC
Yy \J CCw cw
A w ...MFT
Controller Output  Master Feedback  Slave Input Slave Feedback
01t0255sec  |2t010VDC [2t010VDC  |0to5 VDG

p-7089 CANADA 203-791-8396 LATIN AMERICA
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Multi-Function Technology®

Wiring Diagrams

24 VAC Transformer
Line
Volts

Control Signal (-)=
41020 mA (+)—0—|

or
2to 10VDC

VDC /4 to 20mA

Original AF, NF, LF, TF

t 24 VAC Transformer

Spring Return Actuator with MFT

VNV VAV

Blk (1)] Common
Red (2)|+ Hot

Wht (3)] Y4 Input, 2 to 10V

5)| U Output, 2 to 10V

cow cw

VAV

Line I-: Blk (1) | Common —
Volts 1] Red (2| Hot+ AN
A
No—o—I1-H] wht (3) | Y1 Input
B\ f&
2to10VDC A 1.
Feedback Signal Y0 (5) | U Output 2 to 10V

New Generation AF, NF

2 24 VAC Transformer

a Blk (1) | Common -

AAA

2to10VDC

Line | I
Volts 1H] Red 2 Hot+ AN
A v I Wht (3) | Y1 Input
A B
—OAO—I-- Pnk (4)| Y2 Input

Org (5)| U Output 2 to 10V

Feedback Signal

Floating Point

ﬁ 24 VAC/DC Transformer A&A
Line I+ Blk (1)] Common
Volts I+ Red (2)| Hot

- - a
Position ) —| Wht (3)]Y Input
Feedback VDC (+) ——— | (5)| U Output
CCW Ccw

Two Position
24 VAC Transformer & A
Line -0_| Blk (1)[ Common
Volts Red (2)[+ Hot
Control Signal (-)=
2-10VDC or (+)—o—/ﬂ Wht (3)| Yy Input, 2 to 10V
41020 mA 500Q
1/4 watt
F i a b c
Min* 0% <J | |
Mid* 50% <J |-
Max* 100% <J A |
Normal**| Control mode acc.toY | —~-| ~-| A

* Default 0-100%. See C

i ion Data Shee!
** Customizable. See Configuration Data Sheet.

Override control to min, mid, max positions

f 24 VAC Transformer (AC only) A

Line Blk (1)[ Common
Volts Red ()|« Hot
Position @ — | Wht (3)]Y Input
F VDC (+) | (5)| U output
ccw cw
PWM

> PP PDE

BELIMO

Provide overload protection and disconnect as required.
Actuators may be connected in parallel if not
mechanically mounted to the same shaft. Power
consumption and input impedance must be observed.
Actuators may also be powered by 24 VDC.

Meets cULus requirements without the

need of an electrical ground connection.

Actuators with plenum rated cable do not have numbers
on wires; use color codes instead. Actuators with appliance
cables are numbered.

A 500Q resistor converts the 4 to 20 mA control signal

to 2to 10 VDC.

Control signal may be pulsed from either the Hot (Source)
or Common (Sink) 24 VAC line.

Contact closures A & B also can be triacs. A & B should
both be closed for triac source and open for triac sink.
For triac sink the Common connection from the actuator
must be connected to the Hot connection of the controller.
Position feedback cannot be used with a Triac sink
controller. The actuator internal common reference is

not compatible.

IN4004 or IN4007 diode. (IN4007 supplied, Belimo part
number 40155)

W425_08

24 VAC Transformer
Line
Volts

Control Signal (-)=

41020 mA (+)—o—|
210 10VDC
|
VDC /4 to 20mA

f 24 VAC Transformer

D

Non-Spring Return Actuator with MFT

VNV VAV

Blk (1)] Common
Red (2)|+ Hot

Wht (3)| Yy Input, 2 to 10V

Org (5)| U Output, 2 to 10V

[alA)

AAA

Floating Point

Line |=+=r Blk (1) | Common -
Volts |-1{ Red (2) | Hot +
4 | Wht (3) | Y1 Input
/ \O—I—— Pnk (4)| Y2 Input
Fe:;g;cokvs?;nal =g 0rg (5)] U output2to 10v

aTA)

%5

VAVANN

c 24 VAC/DC Transformer

Line |H Bk (1)] Common
Volts 14 Red (2)|Hot
Position (<) — : .a_| Wht (3)| Y Input
Feedback VDC (+) ——— | Org (5)|U Output
[aJA)

Two Position
24 VAC Transformer & A
Line Blk (1)] Common
Volts

Red (2)|+ Hot

Control Signal (-)=

2-10VDCor  (+)—e—e” Wht (3)] Y, tnput, 210 10V

4to20 mA 500Q
1/4 watt
i a b c
Mi 0% <J | |
M 50% <J — ||
Max* 100% <} ||
Normal**| Control mode acc.toY | ~-| ~-| A
* Default 0-100%. See Ct Data Sheef

** Customizable. See Configuration Data Sheet.

Override control to min, mid, max positions

: 24 VAC Transformer (AC only) A

Line Blk (1)[ Common
Volts Rt (2)] Hat
Position @ — 177 Wht (3)]Y Input
I VDC (+) |15 Org (5)] U Output
[aYA)
PWM

BB PR

Provide overload protection and disconnect as required.
Actuators may be connected in parallel if not
mechanically mounted to the same shaft. Power
consumption and input impedance must be observed.
Actuators may also be powered by 24 VDC.

Meets cULus requirements without the

need of an electrical ground connection.

Actuators with plenum rated cable do not have numbers
on wires; use color codes instead. Actuators with appliance
cables are numbered.

A 500Q resistor converts the 4 to 20 mA control signal

to 2to 10 VDC.

Control signal may be pulsed from either the Hot (Source)
or Common (Sink) 24 VAC line.

Contact closures A & B also can be triacs. A & B should
both be closed for triac source and open for triac sink.

For triac sink the Common connection from the actuator
must be connected to the Hot connection of the controller.
Position feedback cannot be used with a Triac sink

controller. The actuator internal common reference is
not compatible.

W426_08
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BELIMO

0 to 135 Q Control (MFT95)

Switch A Switch B Damper Position
e e | ——— Damper Open
——— _./._ Damper Closed

The direction of rotation switch is set so that the fail safe position and the
position of the damper is closed with no signal at wire R.

gl

24 VAC Transformer
Line 1 c Bik
Volts ———— |41 2 +Hot, Red A
A A\
I3 w
+1H4 R
1350 5!
|45 B
|4 6 ‘U5’ Output 2-10 VDC
24 VAC Transformer -MFT95 US
Line {1 c Bik
Volts |44 2 + Hot, Red A
A A
Weo—e |13 W
Line RI——I+H4 R
Volts B
B e—eI|1+f5 B
A Controller |4 6 ‘U5’ Output 2-10 VDC
...MFT95 US
Override
24 VAC Transformer
Line 1C , Blk
Volts 2 + Hot, Red A

A

Series 90 high limit control - 280Q

High Limit Control

installation information.

WEEIT]s w
Series 90 ® I 4R
c 7 | 5 B
Series 90 low limit control I 6 ‘U5’ Output 2-10VDC
135Q for 0 to 50% control
280 for 0 to 100% control --MFT95 US
Low Limit Control
ﬁ 24 VAC Transformer
Line | 1C 1, Blk
Volts —_— 2 +Hot, Red
A @F——Itsw
Series 90 ® I 4R
Controller ® @) | 5 B
| 6 ‘U5’ Output 2-10 VDC

...MFT95 US

A Provide overload protection and disconnect as required.
A Actuators and controller must have separate transformers.
Consult controller instruction data for more detailed

é 24 VAC Transformer

Line A1 c Bk A
Volts | 2 +Hot, Red
N A
@) s w
Resistor
e 7 e
Series 90 I-: M
Controller
...MFT95
Line A1 c Bk A\
Volts | 2 +Hot, Red A
I3 w
No. of I+f16 R
actuators | Resistance
2 1200 |+15 B
3 71.50 1] -
4 47.5Q ‘:_ ‘t'h " IV 6 'Us
5 37.5Q 0 other
s 280 ...MFT95

Resistor Kit No. ZG-R03

Wiring multiple actuators to
controller

a Series 90

S963A
24 VAC Minimum Position
f Transformer Potentiometer
Line | 1 C , Blk
Volts |4 2 +Hot, Red A
Series 90
Controller
®® W-e—It{is w
é T4 R
| 5B
| 6 ‘U5’ Output 2-10 VDC

...MFT95 US

%E
7

IR
H205 Change- Occupied
over Controller ~ Contact

Line
Volts

A

=

I
-

YYv

1C , Blk ﬁ

2 +Hot, Red f
3w

4 R

5B

6 ‘U5’ Output 2-10 VDC

To other

actuators

...MFT95 US

Wiring multiple actuators to a Series
90 controller using a minimum position

potentiometer

A Resistor value depends on the type of controller and
the number of actuators. No resistor is used for one
actuator. Honeywell resistor kits may also be used.

To reverse control rotation, use the reversing switch.

Multi-Function Technology®

Wiring Diagrams

Q209A
24 VAC Minimum Position
é Transformer Potentiometer
Line | 10 , Blk é
Volts | 2 +Hot, Red A
®®@—y—Imew
|
H205 | 4 R
Chs M
nengecrer |OIOH® Hs e
| 6 ‘U5’ Output 2-10 VDC
A ...MFT95 US
Shunting
Resistor
B | Occupied
| 41 Contact
yH 1O
Honeywell T675A
@m | 4 Morning Warmup
W973, W7100
Controller
Line 1 1 c 1, Blk
Volts | 2 +Hot, Red f
1
I 3w
No. of I 4 R
actuators Resistance
2 73000 1115 B
i gégg vvv| 6 ‘U5’ Output 2-10 VDC
To other
Resistor Kit No. ZG-R06 actuators ...MFT95 US

Used with the W973 and W7100 controllers.

Honeywell Q209A

Minimum Position

24 VAC N
f Transformer Potentiometer
Line 1] + common, Bk /\
Volts 7?| 2 +Hot, Red é
AlHR®® s w
O 1®#H® e "
4 1 5B
i () ba '
Resistor | 6 ‘U5’ Output 2-10 VDC
Honeywell
W973, W7100  T675A Mornii
775 Warmup ..MFT95 US
Line I 1 ¢ , Blk
Volts | 2 +Hot, Red f
I3 w
[ ol 4 R
>-| 5B
YYVI 6 ‘U5’ Output 2-10 VDC
To other
actuators ...MFT95 US

Typical wiring diagrams for multiple
actuators used with the W973, W7100 and

T775 controllers.

AF24-MFT95 US Wire Colors

1=Black 3=White 5=White
2=Red 4=White 6=White
AFX24-MFT95 and Non-Spring Return Wire Colors
1=Black 3=White 5=Gray
2=Red 4=Pink 6=0range

800-543-9038 U

203-791-8396 LATIN AMERICA




Multi-Function Technology® BELIMO
MFT VDC Proportional Control Program Codes

*Note: Not every code works with every acuator

Programmable Code Control Range Feedback Range |Obsolete Code MP Bus Logo

A01 150s 2..10V us2..10v P-10001 manual
A02 150s 0.5...10V U5 U50.5...10V P-10002 NO manual
A03 150s 2..10V us U50.5...5V P-10003 NO manual
A04 150s 4.7V U5 U5 2...10V P-10004 NO manual
A05 150s 6..9V us us2...10v P-10005 NO manual
A06 150s 10.5...13.5V us u52...10v P-10006 NO manual
A07 150s 0.5..5V us us2...10v P-10007 NO manual
A08 150s 0.5...5V us U50.5...10V P-10008 NO manual
A09 150s 5..10V us us2...10v P-10009 NO manual
A10 150s 5..10V us U50.5...10V P-10010 NO manual
A1 150s 0.5..5V U5 U50.5...5V P-10011 NO manual
A12 150s 0.5..5V us U50.5...2.5V P-10012 NO manual
A13 150s 0.5...10V us us2...10v P-10013 NO manual
A14 100s 0.5...10V U5 U50.5...2.5V P-10014 NO manual
A15 150s 2...5V U5 us2...10v P-10015 NO manual
A16 150s 2...6V us u52...10v P-10016 NO manual
A17 150s 6...10V us us2...10v P-10017 NO manual
A18 150s 14..17V U5 U5 2...10V P-10018 NO manual
A19 100s 2..10V us us2..10v P-10019 NO manual
A20 150s 9..12v us U5 2...10vV P-10020 NO manual
A21 150s 2..10V us U50.5...5V P-10021 NO manual
A22 150s 0.5...4.9V us 0.5...4.9v P-10022 NO manual
A23 150s 5.1...10V us 5.1...10V P-10023 NO manual
A24 150s 0.5...24V U5 U5 2...10v P-10024 NO manual
A25 76s 2..10V U5 us2..10v P-10025 NO manual
A26 150s 2.9V us U5 2...10vV P-10026 NO manual
A27 150s 5...9V us us2..10v P-10027 NO manual
A28 PICCV ONLY 100s 0.5..10V U5 U50.5...10V P-10028 NO manual
A29 150s 1.3V us us2..10v P-10029 NO manual
A30 150s 3.9V us U5 2...10v P-10030 NO manual
A31 150s 0.5...4V U5 us2..10v P-10031 NO manual
A32 150s 6...14V us U5 2...10v P-10032 NO manual
A33 150s 4..14V us us2..10v P-10033 NO manual
A34 120s 2..10V U5 U5 2...10v P-10034 NO manual
A35 78s 2..10V U5 us2..10v P-10035 NO manual
A37 120s 0.5...10V us U50.5...10V P-10037 NO manual
A38 150s 6..13V us us2..10v P-10038 NO manual
A39 150s 10...14V U5 U5 2...10v P-10039 NO manual
A40 150s 1..16V us us2..10v P-10040 NO manual
Ad1 150s 3..6V U5 U5 2...10vV P-10041 NO manual
A42 75s 0.5...10V us us2..10v P-10042 NO manual
A43 150s 0.5...2.5V us U5 2...10v P-10043 NO manual
Ad4 150s 7..10V us us2..10v P-10044 NO manual
A45 150s 13..17V us U5 2...10v P-10045 NO manual
A46 150s 2..10V U5 us2..10v P-10046 NO manual
A47 150s 0.5...20V us U5 2...10v P-10047 NO manual
A48 150s 1.5V us us1...5v P-10048 NO auto-adapt.
A49 150s 1...5V us U51...5V P-10049 NO auto-adapt.
A51 P-10051

A52 150s 2..10V us U50.5...5V P-10052 NO manual
A53 120s 0.5...10V us us2..10v P-10053 NO manual
A54 150s 0.5...2.5V us U50.5...2.5V P-10054 NO manual
A55 75s 2.5V us us2..10v P-10055 NO manual
A56 75s 6...9V us U5 2..10v P-10056 NO manual
A57 150s 2...55V U5 us2..10v P-10057 NO manual
A58 150s 6.5...10V us U5 2...10v P-10058 NO manual
A59 150s 0.5...6V us us2..10v P-10059 NO manual
A60 300s 2...10V us U5 2..10v P-10060 NO manual
A61 150s 10...20V us us2..10v P-10061 NO manual
A62 90s 2...10V us U5 2...10V P-10062 NO manual
A63 150s 0.5...4.5V us U50.5...4.5V P-10063 NO manual
A64 150s 5.5...10V us U55.5...10V P-10064 NO manual
AG65 150s 1.5V us us51...5v P-10065 NO manual

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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BELIMO

Programmable Code
A66
A67
A68
A69
A70
AT
AT72
A73
A74
A76
A77
A78
A79
A80
A81
A82
A83
A84
A85
A86
A88
A89
A90
A91
A92
A93
A94
A95
A96
A97
A98
A99
AAD
AA1
AA2
AA4
AA5
AAG
AA7
AA8
AA9
AAA
AAB
AAC
AAD
AAE
AAF
AAG
AAH
AAJ
AAK
AAL
AAM
AAN
AAP
AAR
AAS
AAT
AAU
AAV
AAW
AAX
ACO

Running Time
150s
150s
150s
150s
150s
150s
95s
150s
150s
150s
76s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
95s
150s
150s
85s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s

150s
150s
150s
100s
100s
150s
755

150s
100s
100s
150s
120s
100s
150s
150s
150s
20s

100s
150s

35s
45s

Control Range
2...10V
2...8V
2..13V
1.4V
3.5...10V
2...15V
2...10V
6...18V
2...10V
0.5...3V
0.5...10V
2...10V
0.5...10V
0.5...35
45..10
3...10v
5...15V
13...20V
2...10V
5...10.5
2...10V
12.5...22V
2.5V
2...10V
0.5...15V
2...10V
2...10V
0.5...5V
0.5...10V
5.25...7.25
2...10V
2...10v
0.5...12.85
3...15V
0.5...14V
0.5...22V
0.5...4V
6...10V
2.7V
4..10V

2..22V
0.5...20V
0.5....29V
0.5...4.5V
5.5...10V
0.5...28V
0.5...10V
0.5...10V
2...6V
6...10V
8...20V
0.5...10V
0.5...10V
2..10V
2..10V
2..10V
2..10V
6...9V
1.2...6V

2..10V
2..10V

Feedback

us
us
us
us
us
us
us
us
ub
us
us
us
us
us
us
us
us
us
ub

us
us
us
us
us
us
us
us
ub
us
us
us
ub
us
us
us
us
us
ub
us

us
ub
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
ub
us

us
ub

Feedback Range

U5s1...5v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
U50.5...10V
U50.5...10V
U50.5...10V
U50.5...5V
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
U52...5v
us2...10v
U50.5...10V
us2...10v
us2...10v
U50.5...5V
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
U50.5...5V
U50.5...5V
us2...10v
us2...10v

us2...10v
U50.5...10V
us2...10v
U50.5...4.5V
U55.5...10V
us2...10v
us2...10v
U54..5v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v
us2...10v

us2..10v
U5 2..10V

Multi-Function Technology®

MFT VDG Proportional Control Program Codes

Obsolete Code

P-10066
P-10067
P-10068
P-10069
P-10070
P-10071
P-10072
P-10073
P-10074
P-10076
P-10077
P-10078
P-10079
P-10080
P-10081
P-10082
P-10083
P-10084
P-10085
P-10086
P-10088
P-10089
P-10090
P-10091
P-10092
P-10093
P-10094
P-10095
P-10096
P-10097
P-10098
P-10099
P-10100
P-10101
P-10102
P-10104
P-10105
P-10106
P-10107
P-10108
P-10109
P-10110
P-10111
P-10112
P-10113
P-10114
P-10115
P-10116
P-10117
P-10118
P-10119
P-10120
P-10121
P-10122
P-10123
P-10124
P-10125

P-10130
P-10131

MP Bus Logo

NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

NO
NO

manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
auto-synch.
manual
manual
manual
manual
manual
manual
manual
manual
manual

manual
manual
manual
manual
manual
manual
auto-adapt
auto-adapt
auto-adapt
manual
manual
auto-synch.
manual
manual
auto-adapt
manual
manual
manual
manual

manual
manual
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Multi-Function Technology®
MFT VDC Proportional Control Program Codes

BELIMO

Programmable Code

AC1
AC2
000
AC4
AC5
AC6
AC7
AC8
AC9
ACA
ACX
ADO
AD1
AD2
AD3
AD4
AD5
ADG6
AD7
AD8
AD9
ADA
ADC
ADD
ADE
ADF
ADG
ADH
ADJ
ADK
ADL
ADM
ADN
ADP
ADR
ADS
ADT
ADU
ADV
ADW
ADX
AE0
AE1
AE2
AE3

PICCV ONLY

Running Time
90s
150s
150s
150s
75s
450s
150s
35s
45s
90s
150s
100s
100s
90s
35s
150s
100s

100s

100s

150s

70s
40s

Control Range
2..10v
0.5...10V
2..10V
0.5...10V
2..10V
2..10V

0.5...10V
0.5...10V
0.5...10V
2..10V
0.5..5V
5...10V
2...10V
2...10V
2...10V
2.5V

0.5..5V

0.5..10V

9...13V

2..10V
2..10V

Feedback

us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us

us

us

us

us
us

Feedback Range

us2..10v
u50.5...10v
U5 2..10vV
U50.5...10v
us2...10v
usa...1ov
U5 2...10v
U50.5..10vV
U5 0.5...10V
U5 0.5...10v
U50.5...10V
us2.10v
U5 2..10v
us2..10v
us2..10v
us2..10v
U5 2..10V

U5 2..10v

u50.5...10v

us2..10v

us 2..10v
US 2..10V

Obsolete Code

P-10132

MP Bus Logo

NO
NO
YES
YES
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

NO

NO

NO

NO
NO

Adaption
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
auto-adapt.
auto-adapt.
manual
manual

manual

manual

manual

manual
manual
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BELIMO Multi-Function Technology®
MFT VDG Proportional Control Program Codes

Programmable Code Running Time Control Range Feedback Feedback Range |Obsolete Code MP Bus Logo
AE4
AE5
AEG
AE7
AE8
AE9
AEA 120s 0.5...10v U5 U50.5...10V NO manual
AEC 755 0.5...10V us U50.5...10V NO manual
AED 300s 0.5...10V U5 U50.5...10V NO manual
AEE 450s 0.5...10v us U50.5...10V NO manual
AEF

AEG
AEH
AEJ

AEK
AEL

AEM
AEN
AEP
AER
AES
AET

AEU
AEV
AEW
AEX
AF0
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Multi-Function Technology® ,
MFT 95 (Honeywell Series 90, 0-135<2) Program Codes BEL' MO

Programmable Code Running Time Control Range Feedback Feedback Range |Obsolete Code MP Bus Logo Adaption

RO1 150s
R02 150s
RO3 150s

..135 0hm us Us2...10v P-16001 NO manual
..135 Ohm U5 U50.5...10V P-16002 NO manual
..135 0hm U5 U50.5...5V P-16003 NO manual
R04 758 ..135 Ohm us U52...10v P-16004 NO manual
R05 100s ..135 Ohm us U50.5...10v P-16028 NO manual
R06 P-16029
RO7 35s ..135 Ohm U5 Us2...10V NO manual
R08 45s ..135 Ohm us U52...10v NO manual
R09 90s ..135 Ohm us u52...10v NO manual
ROA 37s ..135 Ohm U5 U52...10v NO manual
ROC

ROD
ROE

ROF

ROG
ROH
ROJ

ROK
ROL

ROM
RON
ROP
ROR
ROS

ROT

ROU
ROV
ROW
ROX
R10

R11

Soooo

Sooo

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Multi-Function Technology®

BEL|MO MFT PWM (Pulse Width Modulation) Program Codes
Programmable Code Running Time Control Range Feedback Feedback Range |Obsolete Code MP Bus Logo

wo1i 150s 0.59...2.93s us u52...10v P-20001 NO manual
Wo2 150s 0.02...5s U5 u52...10v P-20002 NO manual
wo3 150s 0.1...25.5s us u52...10v P-20003 NO manual
wo4 150s 0.1...25.6s ) u52...10v P-20004 NO manual
Wo5s 150s 0.1...5.2s us U50.5...5V P-20005 NO manual
W06 150s 0.59...2.93s U5 U50.5...10V P-20006 NO manual
wo7 150s 0.02...5s us U50.5...5V P-20007 NO manual
wos 150s 0.1...10s U5 u52...10v P-20008 NO manual
wo9 150s 1. 11s us u52...10v P-20009 NO manual
w10 150s 0.02...5s U5 u52...10v P-20010 NO manual
W11 150s 0.02...5.6s us us2...10v P-20011 NO manual
W12 150s 0.5...25.55 U5 u52...10v P-20012 NO manual
w13 150s 0.5...2.93s us u52...10v P-20013 NO manual
w14 150s 0.1...10s U5 u52...10v P-20014 NO manual
W15 150s 1. 11s us u52...10v P-20015 NO manual
W16 150s 0.02...5s U5 u52...10V P-20016 NO auto-adapt.
w17 150s 0.02...5.6s us us2...10v P-20017 NO auto-adapt.
W18 150s 0.1...25.5s U5 u52...10v P-20018 NO auto-adapt.
w19 150s 0.02...2.5s us u52...10v P-20019 NO manual
w20 150s 2.7...58 U5 u52...10v P-20020 NO manual
w21 150s 0.1...5.2s us us2...10v P-20021 NO manual
w22 150s 0.1...12.85s U5 us2...10v P-20022 NO manual
w23 150s 5.1...10.1s us u52...10v P-20023 NO manual
w24 150s 0.59...1.76s ) u52...10v P-20024 NO manual
W25 150s 1.76...2.93s us u52...10v P-20025 NO manual
W26 150s 0.02...12s U5 u52...10v P-20026 NO manual
w27 150s 0.02...14s us us2...10v P-20027 NO manual
w28 150s 12.5...22s U5 u52...10v P-20028 NO manual
w29 150s 0.5...12.85s us u52...10v P-20029 NO manual
W30 150s 0.1...24s U5 u52...10v P-20030 NO manual
W31 100s 0.02...5s us U5 Q2...10V P-20031 NO off
W32 100s 0.1...25.5 U5 u52...10v P-20032 NO off
W33 150s 0.2...25.5 us u52...10v P-20033 NO manual
W34 100s 0.59...2.93s ) u52...10v P-20034 NO off
W35 150s 5.5...9.5s us us2...10v P-20035 NO manual
W36 150s 0.5...4.5s U5 u52...10v P-20036 NO manual
w37 150s 0.1...5.2s us U50.5...10V P-20037 NO manual
w38 150s 0.02...6s U5 u52...10v P-20038 NO manual
W39 150s 0.59...2.93s us u52...10v P-20039 NO auto-adapt.
W3A 150s 0.5...5.0s U5 u52...10v P-20040 NO auto-adapt.
W3c 150s 0.1..25.5s us U5 2..10V NO manual
w3D 150s 0.2..5.2s U5 U5 2...10V P-20041 NO manual
W3E

W3F

W3G

W3H

W3J

W3K

W3L

W3Mm

W3N

W3P

W3R

w3s

W3T

W3u

W3V

W3w

W3X

W40

W41
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Multi-Function Technology® ,
MFT Floating Point Program Codes BEL"VlO

Programmable Code Running Time Control Range Feedback Feedback Range |Obsolete Code MP Bus Logo Adaption
Fo1 150s us us2...10v P-30001 NO manual
F02 150s us U50.5...10V P-30002 NO manual
F03 100s us us2...10v P-30003 NO manual
F04 100s us U50.5...5V P-30004 NO manual
F05 100s us u50.5...10v P-30005 NO manual
F06 150s us U50.5...5V P-30006 NO manual
FO7 300s us us2...10v P-30007 NO manual
F08 75s us U52...10v P-30008 NO manual
F09 85s us u52...10v P-30009 NO manual
F10 150s us U50.5...6V P-30010 NO manual
F11 758 us U50.5...5v P-30011 NO manual
F13 120s us U50.5...10V P-30013 NO manual
F14 90s us us2...10v P-30014 NO manual
F15 150s us U50.5...4.5V P-30015 NO manual
F16 150s us us1...5v P-30016 NO manual
F17 90s us Us1...10v P-30017 NO manual
F18 60s us us2...10v NO manual
F19 45s U5 U52...10v NO manual
F1A 35s us us2...10v NO manual
F1C

F1D

F1E

F1F

F1G 120s us U52..10V NO manual
F1H 450s us u52...10v NO manual
F1J

F1K

FiL

FIM

FIN

F1P

F1R

F1S

FIT

F1U

F1V

F1w

F1X

F20

F21
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Multi-Function Technology®

BEL' MO MFT On/Off Program Codes

Programmable Code Running Time Control Range Feedback Feedback Range |Obsolete Code MP Bus Logo

Jo1 75s us U52...10v P-40001 NO manual
J02 150s U5 u52...10v P-40002 NO manual
Jo3 75s us u52...10v P-40003 NO manual
Jo4 100s U5 U50.5...5V P-40004 NO manual
J05 100s us U50.5...10V P-40005 NO manual
J06 120s U5 u52...10v P-40006 NO manual
Jo7 45s us U52...10v P-40007 NO manual
Jog 200s U5 u52...10v P-40008 NO manual
Jo9 120s us U50.5...10V P-40009 NO manual
J10 300s U5 u52...10v P-40010 NO manual

J11 150s us U50.5...10V P-40011 NO manual
J13 100s U5 U50.5...5V P-40012 NO manual (off)
J14
J15
J16
J17
J18
J19
J1A
J1C
J1D
J1E
J1F
J1G
J1H
J1J
J1K
JiL
JIM
JIN
J1P
J1R
J18
JIT
J1U
J1V
J1W
J1X
J20
J21
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Multi-Function Technology®

MFT Quick Actuators Proportional Control Program Codes

Programmable Code
TO1
T02
T03
T04
T05
T06
T07
T08
T09
TOA
TOC
T0D
TOE
TOF
TOG
TOH
T0J
TOK
TOL
TOM
TON
TOP
TOR
T0S
TOT
ToU
Tov
TOW
ToX
T10
T11

Running Time
2.5s
4s
7s
10s
15s
20s
2.5s
4s
7s
10s
15s
20s

Control Range
1oV
.10V
.10V
)Y
.10V
.10V
... 1ov
.10V
.10V
.10V
..oV
... 10v

Feedback

us
us
us
us
us
us
us
us
us
us
us
us

Feedback Range

us2..
us2...
us 2.
us2.
us 2.
us2...

Us50.5..
U50.5..
Us05..
U50.5...
Us50.5..
U505...

10V
10V
10V
10V
10V
10V
10V
10V
10V
10V
10V
10V

Obsolete Code

MP Bus Logo

NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

BELIMO

Adaption

manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
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i Multi-Function Technology®
BEL"VIO MFT Special Control (Non-Spring Return Only) Program Codes

Programmable Code Running Time Control Range Feedback Feedback Range |Obsolete Code MP Bus Logo

So1 150s Phasecut us U52...10v NO manual
S02 35s Phasecut U5 U52...10v NO manual
S03 45s Phasecut us U52...10v NO manual
S04 90s Phasecut U5 U52...10v NO manual
S05
S06 150s 4...20mA U5 u52...10v NO manual
S07
S08 45s 4...20mA us U52...10v NO manual
S09 90s 4...20mA us u52...10v NO manual
SOA
S0C 755 4...20mA us Us2...10v NO manual
S0D 758 Phasecut U5 u52...10v NO manual
SOE

SOF
S0G
SOH
S0J

SO0K
SOL
SOM
SON
SOP
SOR
S0S
SOT

Sou
Sov
SowW
S0X
$10

S
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Multi-Function Technology®
MFT NV/NVF Proportional Control Program Codes

Programmable Code
NO1
NO02
NO3
NO4
NO5
NO6
NO7
NO8
NO9
N10
N11
N12
N13
N14
N15
N16
N17
N18
N19
N1A
N1C
N1D
N1E
N1F
N1G
N1H
N1J
N1K
N1L
N1M
N1N
N1P
N1R
N1S
N1T
N1U
N1V
N1W
N1X
N20
N21
N22
N23
N24
N25
N26
N27
N28
N29
N30
N3A

Running Time
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
100s
150s
75s
150s
100s
150s
150s
150s
150s
150s
150s
150s
76s
758
758
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
150s
75s
758
150s
100s
100s

Control Range
2..10V
0.5...10V
2..10V
4.7V
6...9V
10.5...13.5V
0.5...5V
0.5...5V
5...10V
5...10V
0.5...5V
0.5...5V
0.5...10V
0.5...10V
2...5V
2...6V
6...10V
14..17V
2..10V
51...10V
2...10v
5...9V
0.5...10V
3...6V
0.5...2.5V
7..10V
0.5...20V
0.5...4.5V
5.5...10V
2...15V
0.5...10V
2...6V
6...10V
3.7V
0.59...2.93s
0.02...5s
0.1...25.55
0.1...25.6s
0.1...5.2s
0.59...2.93s
0.02...5s
0.1...5.2s
0.5...4.5s

Feedback

us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us
us

Feedback Range

us2..10v
U50.5...10V
U50.5...5V
U5 2..10v
us2..10v
U5 2..10v
us2..10v
U50.5...10V
us2..10v
U50.5...10V
U50.5...5v
U50.5...2.5V
us2..10v
U50.5...2.5V
us2..10v
U5 2..10v
us2..10v
U5 2...10vV
us2..10v
U5 5.1..10V
us2..10v
us2..10v
u50.5...10v
U5 2..10vV
us2..10v
U5 2..10v
us2..10v
U50.5...4.5V
U55.5...10V
U5 2..10v
u50.5...10v
us2..10v
us2..10v
U5 2...10v
us2..10v
U5 2..10v
us2..10v
U5 2...10v
U50.5...5V
U50.5...5V
us2..10v
us2..10v
us2..10v
U5 2..10vV
u50.5...10v
U50.5...5V
us2..10v
U5 2...10v
us2..10v
U50.5...5V
U50.5...10v

Obsolete Code

V-10001
V-10002
V-10003
V-10004
V-10005
V-10006
V-10007
V-10008
V-10009
V-10010
V-10011
V-10012
V-10013
V-10014
V-10015
V-10016
V-10017
V-10018
V-10019
V-10023
V-10025
V-10027
V-10028
V-10041
V-10043
V-10044
V-10047
V-10063
V-10064
V-10071
V-10077
V-10078
V-10079
V-10082
V-20001
V-20002
V-20003
V-20004
V-20005
V-20006
V-20007
V-20021
V-20040
V-30001
V-30002
V-30006
V-30008
V-40001
V-40002
V-40004
V-40005

MP Bus Logo

NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

BELIMO

Adaption

manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
manual
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BELIMO

Multi-Function Technology®

SY-MFT

Programmable Code Loss of Control Signal Input Signal Feedback Qutput Signal
ACE stop 2...10V us U52..10V
ACF stop 0.5...10V U5 U5 0.5...10V
ACG stop 4...20mA us U54...20mA
ACH stop 4...20mA us U5 2..10vV
ACJ open 2...10V U5 U5 2..10V
ACK open 0.5...10V U5 U5 0.5...10V
ACL open 4...20mA us U54...20mA
ACM open 4...20mA us U5 2..10V
ACN close 2...10V U5 U5 2..10V
ACP close 0.5...10v us U50.5...10V
ACR close 4...20mA us U54...20mA
ACS close 4...20mA U5 U5 2..10V
W3E** stop 0.02-5.00 seconds PWM U5 U5 2..10V

Note: Runtime is fixed based on actuator model.

**Available only on -24MFT models.
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Multi-Function Technology® BELIMO
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PG-Tool Accessories
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BELIMO
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MFT-P US
3.X

™

Compatible Operating System |For Windows 2000/XP/Vista

System requirem

ents

10 MB free hard disk space

Modules

MFT-PC

Language

English / German

CD contents

Set-up.exe (Installation tool)
Software documentation
(requires Adobe Acrobat Reader)
Adobe Acrobat Reader

License

Not required

MFT-P US
Belimo PC-Tool

Application
The Belimo PC-Tool software is a graphical user interface which allows the user
to set, modify and read actuator characteristics.

The Belimo PC-Tool is an MFT support tool which is a practical solution for
Controls distributors and Installation contractors.

The Controls Distributor can:
* Reduce inventory levels
» Optimize the flexible MFT product inventory
e Quickly program an MFT actuator
e Provide MFT custom retrofit solutions — same day
* Re-label the actuator with correct parameters
The Installation contractor or field technician can:
¢ Work with PCs having a dedicated hand held tool
¢ Connect and program actuators quickly on an as needed basis
¢ Get systems up and running faster for service replacement applications
¢ Optimize flexibility of MFT product inventory for replacement applications
e Program actuators to your company standard configuration

Required Accessory

ZIP-RS232 US  (required)

OR

ZIP-USB-MP  (required)

AND

ZK Cable depending upon application (required)
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ZIP-USB-MP US
For interfacing PC with...MFT US type actuators

ZIP-USB-MP US

Technical Data
Power Supply
Nominal voltage range

AC 24 V 50/60 Hz, DC 24V
AC19.2...28.8V,DC 21.6...28.8V

Driver For Windows 2000, XP or Vista
(download at www.belimo.com, call for link)
Connections USB|USB 2.0, 1 m cable

MP device | RJ11-socket
11l safety extra-low voltage

Electrical Safety

BELIMO

Application

The ZIP-USB-MP is used with the Belimo PC-Tool software (MFT-P US) to
interface all Multifunctional (...MFT US) type actuators via a USB port.
Monitoring and parameterization of one MFT actuator is enabled.

The ZIP-USB-MP can also be used to interface the MFT actuators functionality
via the UK24LON.

Connection and Operation

Power Supply
Power for the ZIP-USB-MP is supplied via the connected MFT actuator. The
Actuator needs to be powered up in order for the unit to work.

Connection and Indication
A PC is connected through its USB port and the associated ZK cable.

NOTE: A special driver found on the Belimo website is needed for the ZIP-USB-
MP US to operate. Contact factory for details.

Indication (See Accessories)
LED’s show the status of the interface and the flow of data between the
ZIP-USB MP and the MFT actuator/VAV controller.

LED Initialized
Data is transmitted from ZIP-USB-MP to actuator.

LED Data
e Data transmitted from actuator to ZIP-USB-MP.
* LED flashes synchronously when initlaized if an actuator does not respond.

LED Enable
Steady light when the interface is active.

Degree of protection IP 20
Ambient temperature 010 122 °F A .
Storage temperature -40t0 176 °F ccessories
Weight <1.0lb ZK1-GEN Cable 16 ft, RJ11-plug
ZK2-GEN Cable 16 ft, RJ11-plug, open wires
Wiring Diagram
o ZK3-GEN Cable 16 ft, diagnostic socket, plug
=
ZK6-GEN Use with SY actuator
Belimo .
PC-Tool ZKS-MP Use with UK24LON US gateway
®
ZK1-VAV Use with VAV actuators

4
. BELIMO
=
n S
g Som 2| zKCable
O Initialized E
_ 8 =
ZIP-USB MP (€
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BELIMO

ZIP-R5232

Technical data
Supply voltage

ZIP-RS232

ZIP-RS232 US
24 VAG; Class Il power supply

Power consumption

1 W /1.5 VA (without actuator)

Electrical protection

MFT-XFMR is internally protected and
automatically resets

Connections

Power supply | Stereo connector

Actuator | Manual push button terminals
MP-Bus | Orange male connector, ZKS-MP (Optional)
RS232 | PC cable, sub-D, 9 pin, female/female, included

Ambient temperature 0°to 122°F
Storage temperature -40°F to 176°F
Electrical safety Class Il

Weight

<1.0 Ib. (without actuator)

Wiring Diagram

Common 1
+Hot 2
Control signal “Y” 3

U5 Di ics 5

...MFT US

MFT-XFMR

Standard Jumper Setting

Null modem serial cables can be used by switching the internal jumpers.

ZIP-RS232WirDiagRev_08

ZIP-RS232

Actuator
ON

o

24VAC/IDC
50060 Hz
15VA W

Supply MP-Bus

Yk ENL  Tx Rx EN

Jumper Setting for Null-Modem Cable

ZIP-RS232 US
For Interfacing PC with...MFT US Type Actuators

Application

The ZIP-RS232 is used with the Belimo PC-Tool software (MFT-P US) to interface
all Multifunctional (...MFT US) type actuators via an RS232 port. Monitoring
and parameterization of one MFT actuator is enabled.

The ZIP-RS232 can also be used to interface the MFT actuators functionality via
the UK24LON.

Connection and Operation

Wiring Terminals
The ...MFT US actuator wires are connected to the terminals and correspond to
the conductor wire designations. Some actuators are color coded and do not
have numbered conductors. The following indications should be used:
1 =Black
2 =Red
5 = Orange (non-spring, TF)
Green (LF)
White (AF, NF)

Switch

The Actuator On/Off switch on the ZIP-RS232 applies 24 VAC power to the
connected actuator. The ZIP-RS232 is powered when the MFT-XFMR is plugged
into a power receptacle.

RS232 Connector
The ZIP-RS232 is connected via this RS232 connector to the PC with a standard
female-female 9-pin sub-D cable, provided.

Power Supply
The MFT-XFMR accessory transformer is connected to the unit, and supplies 24
VAC power to the ZIP-RS232 and up to one connected actuator.

Power LED
A Green LED is lit when 24 VAG is supplied.

MP-Bus Connector
This connection is used only with the UK24LON or another MP-Master device.

Terminal Designations
U/PP: Data communications lead EN: Enabling signal for UK24LON

MP-Bus LED’s
Tx: LED flashes when data flows from ZIP-RS232 to the ...MFT US actuator.
Rx: LED flashes when data flows from ...MFT US actuator to ZIP-RS232
EN: LED is lit constantly when RS232 device is connected.

(E.g. PC is connected to ZIP-RS232)

Accessories

MFT-XFMR Power transformer

ZKS-MP MP-bus cable for use with UK24LON
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MFT Cables
For Interfacing PC with...MFT US Type Actuators

ZK1-GEN

V [ 4
BELIMO

Cable for use with ZIP USB-MP or ZIP-RS232 to connect new generation non-
spring return actuators via diagnostic/programming socket

ZK2-GEN

ZK1-GEN

Belimo q
PC-Tool
[\

ZK1-GEN Wiring

Cable to connect ZIP-RS232 with spring and non-spring return actuators not
equipped with diagnostic/programming socket

ZK3-GEN

24V Com

Wht (1)] Common
Blu (2)| Hot

ZK2-GEN

Grn (5)| Output/PP|

Note: Actuator must be powered by
24V source to enable communication.

ZK2-GEN Wiring

Cable to connect ZIP-RS232 or UK24LON US to new generation non-spring
return actuator via diagnostic/programming socket

ZK6-GEN

White - Ground UK...Gateway
Blue - 24V
Green - MP GND 24V MP

ZK2-GEN

..MFT | | .MFT | | ..MFT | | ...MFT || ..MFT || ..MFT || ...MFT || ..MFT

ZK2-GEN Wiring to UK24LON US

Cable to connect to ZIP USB-MP
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38

=
Belimo | |I% 555
- 1]
AC 120 PC-Tool }
RS232 lead 9-pin female/female
1:1 thru connection
(included with ZIP-RS232)

ZIP-RS232
Supply - I~
l - Yo ZK3 -GEN

ZIP-RS232 to Actuator using ZK3-GEN

Actuator
ON

0

OFF

Yo

L
5

1
L
-
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PC-Tool User Manual

BELIMO

PC-Tool
User Manual
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1 Basics

1.1 Introduction

The user manual describes the functions of the Belimo PC-Tool. The Belimo PC-Tool is a PC-
based tool for parameterizing Belimo MFT via bus.

This document is designed to present basic information. This booklet is based on PC-Tool 3.4.
Later versions may contain more features.
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1.2 General structure of the user software

=10l |
File Project MP Channel Tools H A

D3| 2|1 | sle | e[ = |H B

-] P00l V30 Tpe NM24-MFT SN 00449-20025-062-069 | 1, |
e ? okt A Designation NM24-MFT Address MP1
""" -Lhannel = -
& MPI: Roomi, Position Rooml
ol g MP2: Room?,

*, Simulation | |E|

C Actual S ettings =] Test |
Control functiony DC 2-100W
Sengitivity Mormal Adaption |

Service | Configuration

Mominalrange 93.72° Synchronisation

Running time 203
Angle of rotation Max 1002 [947] . . "
: Al
Mir: 0% ] Mid.: 501 [47°] ||
Direction of rotation cw é‘r:
Synchronization at v=0% 1003

Torque 100%
Bus fail position Analog setpaint
Power ON Mathing
M anual button [once] Synchronization
M anual button [wace] Adaption LI

—_—

<| | _;I State: IEI 4
User interface PC-Tool

P2

—————— explanatory text (tooltip) appears for each icon in the toolbar when you position the mouse
|Parameterize Limited Lot pointer on it.

ﬁ! 21| e | 15| & Menu bar [A] and toolbar [B] provide functions that affect the program as a whole. An

The MP-Channels and actuators belonging to the project are displayed in the

outline bar [C] in the form of a tree (as in the Explorer). The object to be worked on is marked
here. Depending on the selected object, pop-up menus offer

corresponding functions at a click of the right mouse button.

----- § ' Change MP-Address
---- - No De-.ﬁ.ddressing device

Print label
Prink patarneter sek

Pop-up menu after clicking the right mouse button

The detail area [D] contains all the detailed information on the highlighted actuator. The values
that are displayed and changed in this area are grouped as needed and distributed over several
index tabs.

The status bar [E] at the lower margin shows the current status of the connected device (e.qg.:
the actuator is carrying out a synchronization or adaptation.)

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Missing or invalid entries are indicated by a flashing exclamation mark. If you move the mouse
pointer to the exclamation mark, an explanatory text (tooltip) appears.

Froject: I i | I
| This Field is required! |
ﬁ : Inactive commands are displayed in gray letters (or as gray icons) according to the Windows
" standard

Texts in boxes with a black font on a gray background cannot be changed. You can mark the
contents with the mouse, however, and copy them into the clipboard with CTRL+C, for example.

IMesssignaI 115 vaniabel
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2 (Getting started with PC-Tool

2.1 Connecting the computer with the actuators

There are two ways to connect the computer (PC-Tool) to the actuators, via the ZIP-RS232 or
by the ZIP-USB-MP US. If the ZIP-RS232 is going to be used, follow the wiring diagram that
works best for your situation.

pra
ZIP-RS232 BEI_.,_l MO® |

| Acgator |
N
I OFF K
. 1 o 5 e

5232

ZIP-RS232 via direct connection to MFT actuator.

1 ~ AC24V o
— 4+ DC24V Belimo —
PC-Tool
I

— RS232

| —
21P-RS232 BELIMO |
-
{ Actg:tﬂr I + u g
A o~ P o -
; @ @ 5 QE_/
[© )| OFF
1+ 42 5
MWL d L
1 2 3 5
C D)
1l ~ Us
- + A"P ....... MFT

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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ZIP-RS232 via ZK3-GEN to Belimo actuator.

iﬁ‘); :. 1 | Belimo || 8 (
AC 120V PC-Tool b4 !
| I : -\ 2 24V
(| i :{.;ﬂ ZK3-GEN Pl
/ AN
) - @ °° L
ZIP-RS232 BELIMO .
Q (@ @ =) = 1
OFF 1 2 5
o ..MFT
ZIP-RS232 via ZK5-GEN to Belimo actuator.
D o
Belimo e
PC-Tool 4
(o]
! k|
I
[ 2IP-RS232 BEL"ﬁ? Important: Connect cable to the ZIP at first!
Actuator -_—
(| o
OFF

12 S 4 24V
GND

blue = GND
turquoise = 24V
violet = PP

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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ZIP-RS232 via direct connection to LON actuator.

O
Belimo
D-Sub
(o]

RS232

L

] ——aa
ZIP-RS232 BELIMO
Actg:tor I i u | §
@ @ § D-Sub
LONWORKS® w1l 5

A
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If the ZIP-USB-MP is going to be used, follow the directions to load the ZIP-USB-MP software
and driver. Please note the ZIP-USB-MP is paired with the computer, if you move the ZIP-USB-
MP the software and driver must be installed on the new computer.

ZIP-USB-MP via ZK1-GEN to a Belimo actuator.

USB
TS : BELIMO RJ11 (6/4)
Belimo n g
PC-Tool B e T
(o] © Initalized bty
— — & £ - 24V
)y ZIP-USB-MP  C¢ AL GEN GND
AN
@ °° L
..MFT :
2
1
ZIP-USB-MP via ZK1-GEN to a Belimo actuator.
1l ~ AC24V
- + DC24V
"USB Sﬁ?@M)

ZK2-GEN

o ; BELIMO
Belimo R )
PC-Tool g B g MP R
[_ﬂ O Initlalized "Q \\\
g GND

Z ZIP-USB-MP  Cé¢

e USB ?? ...... ?
white = GND
blue = not connected
1 2 5
d— i
1 1 1
J_ ~
- +

green = MP

usIMP

..MFT ...LON
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ZIP-USB-MP via ZK1-GEN to a Belimo actuator.

BELIMO

usB

= =
Belimo
PC-Tool
[o]

a
s

N

| MO EMA

use

./,

MP-Monitoring
Pos. .MO*

/
Py

BELIMO

' ) Enable
O Data
O initalized

ZIP-USB-MP

g
:

Ce

v

d

UK24LON BELIMO
@) o) o 4 o o
mm g ©@ © © ®©
LonTalk MP-Com. Power
a8 b oV 24V ¥ UMP OV 24V n.c.
@gog [@wg
|
3pol } _‘
d | AC24V L ~
DC24V — +
ZKS-MP / L
9
9

«.MFT
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2.1.1 Driver Installation

A driver must be installed on the PC in order to use the ZIP-USB-MP. This driver can be
downloaded from the Belimo website (Download section). Once the driver has been installed,
the ZIP-USBMP is logged in on the PC as a virtual COM port.

Supported operating systems

Windows Vista
WindowsXP
Windows 2000
Windows ME
Windows 98
Windows 98 SE

Preparation

Download the zipped “Driver_ZIP-USP-MP.zip” file from the Belimo website (Download section) to a
folder on the hard disk of your computer. Then extract the ZIP file. The ZIP file contains the following
files:

98_ME_zipUSBMP_Driver
XP-2000- ZIPUSbMP- Driver
ZIPUSBMP_drivinst_d.pdf
ZIPUSBMP_ drivinst_e.pdf
ZIPUSBMP_dok_d.pdf
ZIPUSBMP_doc_e.pdf

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Installing

A) Connect the ZIP-USB-MP to the USB port on your computer. The computer reports that it has
detected new hardware and opens the following screen automatically: Hardware Update Wizard.

B) Click the radio button as shown in the next screenshot: Install from a list or specific location
(Advanced).

Found Hew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps: yowinsial zoftwae for

Bedmo AFLUER-MF Ireerface

=1 1l pow hardware cama with an inztallation CD
<y on floppy disk, inser | now.

what do you want the wieard b da?

77 Inatal the aofbeare automatizaly IRzcommended)
-_i;:ln.tlnl Froen & let or zpeche locaton dvanced)

1

Click Naut b cantirue.

Pyt = ]| Cateel |

C) Then click “Next”.

D) Check the box as shown in the next screenshot:
Include this location in the search, then select the folder to which you extracted the driver (see step
1; in this example ZIP-USB-MP).

() Search for the best dnvet ik theze localions.

Lse the chech bones below to it of cipand the defaull szanch, which eludes bcal
psthe and remiovable mediz. The best diver Found wil be insaled.

[T Smarch rerovacle media [Hoppy, CO-ROM..|
[« ] Irehude tis lncation in the search

Browse For Folder |3 | Bioesae

Select e Folder Ehek contains drivers For voor hardware,

E does rat guaranies thal

[ peston

# | My Doouments

4 % My Computer

1# 8 My Nebeork Flacss » _

] P _Tool ¥z L i | Cancel |

=] ZIP-Usg-F
) 56 _ME_TilISEMP Drives
_J ¥P_Z000_IplshMP_Crier
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E) Select the XP_2000_ZipUsbMP_Driver folder and then click “0K”.

= 1 TIPLEE-MP
=4 26 ME_TpUSEME Driver

To wiew ary subfolders, cick a plus sgnabove.

| DK{EJl Carcel

F) Click “Next”.

[] Search mmovable media [foppy, COADM. |
[ Inciude this ncation in the ssaich:

ic:':.[!;:-:umanls and Sattings‘-kearnsl.‘iﬂaﬂqt-:p‘;fllP:i;lnu | Browss

(" )Dan't searchy | wil chooss the ditver b inelal,

Chonze this option to zelect the devics diver fom & let Windomas doss not guararts= thal
1k dieer you chooze wil be the best match bor pour harderane.

<Back || Met:, | | Concd
Iz

G) The driver is now installed.

% BELIMO ZIP-LISB-kP Serial Converter Direer

H) Click “Finish”.

I Click Firizh b cloes the wizard.
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[)  After the driver has been installed, the USP port must be paired to a COM port.
Click the radio button in the Wizard as shown in the next screenshot:
Install from a list or specific location (Advanced).

What do you war; the wizand 1o do?

) Inztal the sofivars automatcaly [Fecommended)
(&) Inztal Fom 2 izt or gpesific koo atioes A ovancad]

Clicde M ek ko conbnue

[ mes» | [ Concal

J) Click “Next”.

[#] Inehade tiz lacation in the seaich
leOocuments and Settigs Lk esling\Dieskop'ca P-U [ | Ercuize
3 Dion't seaich. | wil chooze ke divel o instal.

Chiooze g aphion bo salect bw davice dnver fiom a kst Windows does not guarantes that
the crivel wou choose wil be the best match For your hardwaie.

¢ Back, ]l NEHU%J[ Cahical |

K) The USB port is now paired to a COM port.

5} BELIMA ZIP-USE 4P Seiid lnberface
—

FTLzng.dll
To CANWIND OGS \epetam 32

L) Click “Finish”.
I Clek Finsh bo chise e vozed

T

i

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

NOTE: If a warning appears during the installation procedure, please ignore it and click “continue
installation”. The driver is the loaded correctly. Your system is not damaged in any way.
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2.1.2 Checking

Check the USB/COM connection on your computer.

You must define a COM port number under “Options” in order to work with Belimo PC-Tool
MFT-P v3. To find out which COM port number is the correct one, you need to check which
COM port the USB port was automatically connected to by the system.

A) Select “Settings/Control Panel/System” in the Windows “Start” menu. On the “Hardware”
tab, click “Device Manager”.

System Properties @ﬁ
System Restore __Automatic Updates ___ Remote
General Cornputer Name Hardware Advanced

Device Manager

on your comnputer. Use the Device Manager to change the

‘iﬂ’g The Device Manager lists all the hardware devices installed
properties of any device

I Device Manager ] |

B) You can see here that the USB port on the ZIP-USB-MP has been connected to COM 8, for
example (a different COM number may apply on your PC).

2 Device Manager
File Acton Mew Help

Fe BE8 2 A <Ra

(45 Human Interface Devices
i=) IDE ATAJATAPI controllers
o4 Infrared devices
2 16M ThinkPad Fast Infrared Port
2 Keyboards
% LonWorks Nebweork Inkerface
) Mice and other painting devices
L. Modems
W Monitors
S8 Metwork adapters
B8 SCom SCRPAGITS Wireless LAN PC Card
B3 Int=lR) PROJ100 VE Network Connection
+ [ PCMCIA adapters
' Ports (COM & LPT)
' [BELIMO ZIP-LSB-MP Serial Interface (COMB)!
F” Communications Port (COM1)
J Drinkar Dark (1DT1Y

-+

| B R bt b (]

]
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Selecting the same COM port in PC-Tool Version 3.4

After selecting the COM port, for example “COM=8" (a different COM number may apply on your
PC), you can set to work with the Tool.

o

el | B [ e | )

D &=
= PC-Tool Options

Geners Conrection

Relaze Codes et . = ta3
WP channel configaration * Seiel cormection | COM-8 &
Air module ¢ Other ]

WA MWY-DEM Modul

Yy Compact Module

WAV VRP-M Moduls Bus stan
Scan Interval [=] | 10
Scan Made |MF/PP |

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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2.2 Starting the program

\r~

BELIMO PC-Toal
right).

2.3 Adapting PC-Tool options

PC-Tool User Manual

When you start the program for the first time, a dialog is displayed for adapting the user-
specific settings.

P PC-Tool Options
P

General
Release Codes

Project baze path:

MP channel configuration |EE|im|:|\F'CT ool

Air module
A NMY-D2M Madul B el
WAk Compact Module
WAy WYRP-M Module Language:
|English
Log file:
" File per week {* File per month

j The new language zetting becomes active
alter a program restart,

PC-Tool options

Cancel

Click the program icon on your desktop. A start screen appears. Click the Start button (bottom

Select the desired language in the combobox here. If you change the language, exit the program

and restart it.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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2.4 Creating a new project

To work with the program, you have to create a "project". The dialog for entering the project data
is displayed. Click the radio button "New project".

New/Open projckt

" Esisting project | & Hew project
Project | Comn
BPMQ Project; I
] ACME
Compaty: I
Short-tark: I
Comment:
| i3
I gerlDr: I
et | Project path; iE:'\Daten'\Belimn'\F‘ETnnl |

k. I Cancel J//
3

Creating a new project

The project name, company and user ID must be filled in; all other information is optional.

2.5 Setting up the program

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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The project and the MP-Channel can be seen in the outline bar [C]. The bus is scanned every 10
seconds by default.

[z PCTonl W30
[ Project ACME

B r;‘;f MP-Channel COM=4, [MP/PP, Every 10z]
------- & MP1: Fooml, W 24-MFT 2, Inlet damper

- & MPZ Foom?, N 24-MFT 2, Heater valve

Outline bar [C]

If no actuators are shown after 10 seconds, you should check whether the level converter ZIP-
USB-MP is connected to the right COM interface. Adjust the settings for the serial interface if
necessary [= 3.3.1].

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.
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2.6 Displaying actuator parameters

Select the desired actuator in the outline bar [C] by clicking it with the mouse.
The current settings for the actuator are displayed in the detail area [D].

Type NMB24-MFT Sh 00449-20025-062-069
Designation Inlet damper Address MP1
Fosition Room 1

Service Configuration| *. Simulation

Actual Settings Pt Test

Control function™” DC 2-100
Sensitivity Mormal Adaption

Hominal range 93.72° Synchronisation

Hunning ime 80z
Angle of rotabion Max: 100%  [347]
bir: 0% [0°]
Direction of rotalion cw & -
Synchronization at *v'=0% Bam 100

Mid: 505 [47] 1

Torque 100%
Bus fail position Analog zetpoint
Power OH Mothing
Manual button [once] Synchronization
M anual button [wace] Adaption ﬂ

Example of detail area [D] (damper actuator)

2.7 Further actions

Read the descriptions for the following topics in Section 3 Basic functions

= Bus scan

= Setting the bus address

= Parameterization of actuators

Read the details for the application areas of the actuators in the descriptions of the following
modules

= Damper actuators (Air module)

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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3 Basic functions

3.1 Program start

After the program is started, a start screen is displayed. Click Start.
Determine the project with which you would like to work. You can either
= open one of the last projects listed,

= open an existing project from a file, or

= create a new project.

The defined MP-Channel is displayed and opened. A bus scan is started for each MP-Channel.

If only one actuator is connected, it is automatically selected and displayed.

Option  If you cancel the project selection, the program will be started without a project. In this case,
only the functions Help, File» New project and File » Open existing project will be available.

You can also start the program by means of opening a project file: In the Explorer, double-click
a file with the extension .bptpj or on a corresponding file link.

If you create a link to a project file on the desktop, make sure that you do not inadvertently move
or copy the file instead. You can tell when a link has been created correctly by the small arrow in
the bottom left-hand corner of the file icon. (If the project file itself, rather than a link to it, is on
the desktop then all other files will be saved there as well.)

In a network environment, the program should be installed on your workstation and started
locally. Special authorizations are required to start the program on network drives.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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3.2 Projects
3.2.1 Project data

PC-Tool User Manual

All user-specific data of the program are administered in the framework of projects. Each project
has a project directory in the file system. The project files are stored in sub-directories of the
project directory.

The storage place of the project files is described in the Appendix.

3.2.2 Creating a new project

Option

ol

| PCToolW34

Select File », New Project in the main menu. Enter the new project data in the dialog. The project
name, company and user ID must be filled in; all other information is optional. Click OK.

Since only one project can be active at a time, the currently displayed project will be closed and
the new project opened.

You can also create a new project by clicking the New Project icon on the toolbar [B] or clicking
the program icon in the outline bar [C] with the right mouse button and then selecting New
Project.

3.2.3 Opening a project

Option

]

-~ PCTool V34

Select File » Open Existing Project in the main menu. A list of all project files in the storage
location is displayed.

Mark a project from the list in the dialog or open any given project file (* . bptp7j) with Find....
Click OK.

Since only one project can be active at a time, the currently displayed project will be closed and
the selected project opened instead.

You can also create a project by clicking on the New Project icon on the toolbar [B] or clicking
the program icon in the outline bar [C] with the right mouse button and then selecting Open
Project.

3.2.4 Changing project data

Option

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

Click the project in the outline bar [C] to display the project data. The Edit button (far right)
displays a dialog in which you can change the data.

Click the project in the outline bar [C] with the right mouse button and select Properties.

Project name and path cannot be changed within the program. However, you can rename the
project file (extension . bptp7j) using the Windows Explorer or move the entire project folder
to another location. Afterwards, open the project again.

The project folder and project file can have different names — for example for backing up data.
The name of the project file determines the project name.
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3.2.5 Exporting a project
Copy the entire project folder in the Explorer, for example onto a CD or thumbdrive.

3.2.6 Copying a project

Copy the entire project folder to another location in the Explorer. Give the project folder a new
name. Give the project file (<project>. bptpj) the same name within the new project folder.

3.2.7 Deleting a project

Delete the entire project folder in the Explorer. The project to be deleted must not be currently
open in the program.

3.3 MP-Channel

3.3.1 Serial interface

The ZIP converter is connected to a serial interface (COM) for connecting the MP/MFT actuator
- or the MP-Bus to the PC-Tool. To select the number of the serial interface used on your
o MPStrang: computer, click the MP-Channel icon in the outline bar [C] and select MP-Channel settings.

For typical wiring diagrams, see = 4.4 Typical wiring diagrams

Now set the serial connection:

= |f you activate the "Serial connection" box (as shown in the screenshot), you can select a
serial connection. This list shows all ports on your computer (between COM=1 ... COM=255).

= QOption: If you activate the "Other" box, you can enter a connection ID in the text box. Valid
values are:

"COMX' or "COM:X" or "COM=X" (x is is the port number between 1 and 255).

"Baudrate=x"' (x is the baud rate 75...115200).

"Bytesize=x' (x is the number of data bits 5...8).

"Stopbits=x" (x is the number of stopbits 1, 1.5 or 2).

"Parity=X" (x is the the parity no, odd, even, mark or space).

It is only mandatory for the COM port to be specified. Separate the values with a semicolon
()-

Example:

"COM1;Baudrate=9600;Stopbits=1".

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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3.3.2 Bus scan

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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=
— Connection
% Serial connection IEEIM=4 j
£~ Other I
—Bus scan
Scan Interval [z] I 10
Scan Mode [MP/PP |
k. || Cancel I

MP-Channel settings

In the bus scan section of the "MP-Channel settings" dialog, you can enter the time interval for
the periodic bus scan in seconds. Permitted values are whole numbers between 1 and 9999.

The program can address actuators in two basic ways:

In multi-point mode (MP), up to 8 actuators of the types MP / MFT can be individually digitally
addressed.

In point-to-point mode (PP) only a single actuator can be activated. In this case, the "classic"
operating modes are available with response voltage at connection D5.

Select the type of bus scan in the bus scan section of the
‘MP-Channel settings" dialog:

PP Only
MP / PP

Connection of a single actuator in PP mode

First scan address 1 to 8 in MP mode.
If there is no response in MP mode, switch to PP mode.

Periodic bus scan

The periodic bus scan is active by default. To switch this off, click the MP-Channel with the right
mouse button and select Interrupt scanning. Afterwards, you can switch the periodic scan back
on again the same way with the menu item Scan Every xx Seconds.

Manual bus scan

Manually activate an immediate bus scan with the function button F5 ("Update") as needed. This
is possible at any time, even when the periodic bus scan is active.
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Option ~ You can also select MP-Channel » Trigger Scan in the main menu or activate the Trigger scan
function by clicking the MP-Channel with the right mouse button.

If more than one actuator responds at the same MP address during a bus scan or if more than
one actuator is connected in PP mode, a bus jam will occur. This situation is indicated by the
program with a corresponding message.

[ PCTool3.4 Bus Collisi
Project: ACME us Collision
- MP-Stang COM=1.(F | 2 or more Actuatars are at the same Address.

o ol P Buz Collizion

Saving a bus scan overview in a file

The result of a bus scan can be saved in a file for recording. Select "Channel" in the outline bar
to show an enumeration of all found MP nodes with the corresponding data (address, position,
type, description and serial number).

ERPC-Tool -— BELIMO Automation AG -10] x|

File MP-Monitor  Project Channel  Tools  Help

D|c|m@| 2|t|L| B kElE |||
— | PCTaolGUI V3.4

[fj Praject: Standard
ms Fi,.f Channel: COM=2, [MP/PI Address | F'u:nsitiu:unl T_I,Ipel Designatiunl Series Mo,
& MP1: testrig, LR24: & MP1 testig  LR.. ACME 00633-20177-142-136

& MP3: testrig, LM24 s mhr 00543-10256-142-143

Save ko file. .,

il | B

Saving the bus scan overview

Click the right mouse button to open the context menu and choose "Save to file" for saving the
information in a text file.

3.4 Setting the bus address

Each actuator with an MP-Bus interface (valid for all devices with an MP-Bus interface, e.g. 1/0
modules, etc.) can be assigned an address which it will use to communicate on the MP-Bus.

The setting of the bus address can be disabled on certain actuators, e.g. for the actuator types
..LON and ...ALON (for LONWORKS®).

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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NOTE: USE THIS SECTION ONLY IF THE ACTUATORS (S) MP ENABLED.

3.4.1 Series addre

g4
Option

Series addressing of devices

ssing of actuators
Click the Address device icon in the toolbar [B].

Click the MP-Channel with the right mouse button and select Addressing Device. Or select MP-

Channel » Addressing Device in the main menu.

Senes-Mumber of the device Type of the device Address
& |D0449-2DD25-DE2-DES MBZ24-MFT MP1 =
& [0032310036-062-076 NMBZ24-MFT [mrz =]
| [MFz =]
| e =]
| [MPs =]
| [Mre =]
| [MF7 =]
| [MPa ~]
Inzert zeries number of devices manually or read the zeriez number of the devices by actuating the manual button, L/R
switch or 52 button.
| Set Address I Cancel |
Series addressing

If one of the addresses is already assigned to another actuator, a message will be displayed:

Belimo PC-Tool: Series addressing of dexvi x|

@ Address MP1 is not free, de-address other devicels) First?

Mo | Cancel |

Message when an address is already assigned (series addressing)

Click Yes to initially release the address. The actuator that used to occupy the address is set to PP.

If you select No, the actuator will be set to the already assigned address and a bus jam can occur.

Click Cancel to stop the series addressing at this point. You can now rearrange the addresses or

end the entire process.
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3.4.2 Addressing with known serial numbers

Each MP/MFT actuator is delivered with a label containing its individual serial number. These
serial numbers can be used to assign a PP or an MP1 ... MP8 address to the actuator. An
additional, removable label with an identical serial number is supplied with the actuator. If the
actuator is installed at a particular position in the system, this additional label can be affixed at
the same position in the system diagram. This records where the actuator with the
corresponding serial number is located in the building. These serial numbers can be used to
assign the MP1 ... MP8 addresses to the actuators.

You can also fill in the input boxes manually before clicking Set Address, for example when the
buttons of the actuators are not accessible or you regularly take the serial numbers from your
documents.

3.4.3 Resetting actuator addresses

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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If you want to reset actuators with MP addressing to PP, click to the right of the MP-Channel
and select "De-address Device" in the pop-up menu.

De-Addressing x|

—Addreszes ta rezet to PP-Mode

W MP1
[~ MP2
[~ MP3
[~ MP4
[~ MP5
[~ MPE
[~ MP?
[~ MP3

De-Address Cancel

Selection of the addresses to be reset

Mark the addresses whose actuators are to be de-addressed.

When the bus scan is set to MP/PP, the de-addressed actuators are no longer visible in the
outline bar [C] as long as there are still actuators with addresses.

If you set several actuators to PP, a bus jam will occur with the bus setting "PP only".
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3.4.4 Addressing a single actuator

HEA
FHP2

Option

Select the actuator in the outline bar [C] and click the "Change MP Address" icon in the toolbar

[B].

Old address:  MP1

Mew address:

| Set Address I Cancel |

Setting a new address

Click the actuator with the right mouse button and select "Change MP Address" ("MP-Adresse
andern").

Select the new address in the combobox. If the address is already assigned to another actuator,
a message will be displayed:

Belimo PC-Tool: Addressing of device =]

@ Address MPZ is nok free, de-address other devices) First?

Yes Mo |

Message when an address is already assigned

Click Yes to initially release the address. The actuator that used to occupy the address is set to PP.
If you select No, the actuator will be set to the already assigned address and a bus jam can occur.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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3.5 Selecting a module

All actuators that are active and connected to an MP-Channel are displayed in the outline bar
[C]. Select the desired actuator from this display.

= r;y‘ tP-Channel: COM=4, [MP/PP, Evemn 10z]
------- ol [4F1: Fooml, Mb24-04FT 2, Inlet damper
bl P WPZ RoomZ, NM24-MFT 2, Heater valve

The type of actuator is indicated by the icon:

Icon Actuator type
& Damper actuator
X Valve actuator
Window ventilation actuator
@ Actuator for fire dampers
EA VAV (Variable Air Volume) controller actuator
THC THG24-MP
ST UST-3 1/0 module
Unknown actuator

When an actuator is selected for the first time, the parameters are read out and displayed in the
detail area [D].

In addition, the address for communication on the MP-Channel (MP or PP mode) and the name
of the actuator type are displayed in the outline bar [C].

The complete information for identifying the selected actuator is found in the header of the detail

area [D].
Type NMB24-MFT sk 00449-20025-062-069
Designation Inlet damper Address MP1

Position Room 1

Display of the actuator identification

Note the difference between the current communication mode on the MP-Channel and the
displayed address. An actuator with the address MP2 can be activated in PP mode during a bus
scan, for example.
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3.6 Actuator parameters

3.6.1 Displaying actuator parameters

The parameters of an actuator are displayed on the Service tab in the
detail area [D].

Type NMB24-MFT = 00449-20025-062-069 ,;i
Designation Inlet damper Addrezs MP1 ¥
Position Room1

Service Configuration | *. Simulation

Actual Settings =] Test

Control functionY DC 2-100
Senszihivity Mormal Adaption

Mominalrange 93.72° Synchronisation

Runningbime &0z

Angle of rotation Max: 100%  [947]
b i 1130 11

Mid: 502 [47°] 1

Example of the "Service" tab (damper actuator)

The Test, Adaptation and Synchronization functions are described for each respective module.

3.6.2 Printing out actuator parameters

The displayed actuator parameters can be printed out. Click the printer icon in the toolbar [B] or
select Print Actuator Parameters in the pop-up menu after clicking the actuator in the outline bar
[C] with the right mouse button.

3.6.3 Deleting maintenance/error messages

When an actuator has created and saved maintenance or fault messages, these are displayed on
the Service tab.

Mezzages

Meszages Mechanical travel increased
Feset Messages

Message display on the Service tab

Use "Reset messages', to delete the messages stored in the actuator.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Following messages may appear:

BELIMO

Message

Description

Mechanical travel increased

Expected end stop value for top or bottom has
been overrun.

Mechanical overload

Actuator did not reach set point because an
obstacle has reduced the operating range

Excessive utilisation

Actuator moves to often compared with the total
operating time

(typical relation of active time to operating time is
greater than 25%)

Actuators for fire & smoke dampers have provide a larger scale of messages. The specific
messages are described in the Fire & Smoke module.
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3.7 Configuring an actuator

To change the parameters of an actuator, go to the Configuration tab.

Type NMB24-MFT Si 00449-20025-062-069
Designation Inlet damper Address MP1
Fosition Room1

Service  Configuration | ', Simulation

D esignation Ilnlet damper

Pasition IFh:nam'I

Start Stop
Control signal Y |DC 2-10v |
Read
Wi Mid Max Write
Angle of rotation I 0 Z[0.67%] I A0 EZ[0.700%) I 100 % [33.100%)
| o- | 47 ° | 04 * Store tofile_..
Running time I 80 = [74..296%) Load from file._.

Example of the "Configuration” tab (damper actuator)

The lower area with the basic settings can be displayed with the "More..." button and hidden
again with the "Less" button.

When you change a value in an input box, the box turns yellow:
Min

] 10 %[0.61%]

The status image on the right additionally shows whether all the displayed values match those

stored in the actuator:;

Display matches actuator Values have been changed

Status image

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Save the changed values in the actuator with the "Set" button underneath the status image.
You can read out the parameters currently saved in the actuator again with the "Read" button.
Entries for values that you have not previously saved in the actuator will be lost as a result.

3.7.1 Saving a parameter file

You can store the displayed parameters in a file (with the extension .bptpar) with "Store to
file..." on the "Configuration” tab. The suggested name for the file consists of the project, the
actuator type, the position, the serial number, the current date and the time of day.

Since the content of the file corresponds to the values displayed on the screen, you can change
individual values and save Options in files without loading them on the actuator.

The file can only be saved when all values on the screen are valid.

3.7.2 Loading a parameter file

The values of a saved parameter file can be read back into the input screen for the configuration
with "Load from file...".

3.7.3 Copying parameters

Read out the parameters of an actuator that you want to copy and save them in a file. Change
the actuator, load the saved parameters from the file and program the actuator with the copied
values.

3.7.4 Load factory settings

When a project is created, two folders are created in the parameter directory. These folders
contain the factory settings for all supported actuator types.

|_}pa|ameterfiles j = £ E-

| factory settings air
| factory settings water

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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| ) factory settings water

] AY24L0N. bptpar
] 424, ON-R.bptpar

|| GR244-MF-5.bptpar
| GR244-MP-5.bptpar
=~

=] &Y Size: 1.17 KB

Type: Belimo PC-Toal W3 .4 Resaurce File
~|AY Date Modified: 9/29/2008 13:10 AM

| AV AT IR 105 bptpar
] 4V24-4MFT bptpar

] 4%24-4FT-R.bptpar

] AVY 24-MFT bptpar

] AVY 24-MFT-C105. bptpar
] AVY 24-MFT-R.bptpar

] AVY 24MFT-R-C105.bptpar
] GM24A-MF. bptpar

] GR24ALON-5.bptpar

] GR24ALON-7.bptpar

4

=[IRUZ3AF Bptpar
] NRI244-MF.bptpar

] NV 24LON, bptpar

] NV 24-MFT 2.bptpar

] NV 24-MFT.bptpar

] Y 24-MFT-C 103.bptpar
] NV 24-MFT-T. bptpar

] NVF 240N, bptpar

] NVF 24L0N-E. bptpar

] NVF 24-MFT 2, bptpar

PC-Tool User Manual

~| & @ E-

] NVF24-MFT 2-E..bptpar
] NVF24-MFT.bptpar

] NVF24-MFT-E. bptpar
] NVF 24-MFT-E-T.bptpar
] NVF 24-MFT-T. bptpar
] NVG24LOM. bptpar

] NVG24-MFT 2. bptpar
] NVG24-MFT bptpar

] NVG24-MFT-T.bptpar
] VY 24-MFT.bptpar

] V¥ 24-MFT-C 105, bptp
] VY 24-MFT-R bptpar
] V¥ 24-MFT-T. bptpar
] SR24ALON. bptpar

] SR 24A-MF-5.bptpar

File Mame: |

Filez of Type:

|Belim|:| Parameter File [*.bptpar)

Parameter files with factory settings

»
ﬂ Open |
j Cancel |

Open the file which matches the actuator type. The settings are loaded into the input screen for
the configuration. Afterwards, store the parameters in the actuator with the "Set" button.
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NOTE: USE THIS SECTION ONLY IF THE ACTUATORS (S) MP ENABLED.

3.8 Parameterizing limited lots

You can parameterize several identical actuators with the function "Parameterize Limited Lots".
The number depends on the power of the voltage supply.

To parameterize limited lots, save the parameter set to be programmed in a file.

With one parameter set, you can only program actuators from the same actuator family (e.g.
MFT), i.e. the parameter set used must match the actuator family.

Connect the devices according to the following wiring diagram (for further wiring diagrams, see
clause 4.4 Typical wiring diagrams):

USB
= BELIMO
Belimo ] 04
PC-Tool i 3 Speisung
2 Oleiend § Power Supply
g ACIDC 24V
A ZP-USBMP  ce
— UsB GND 24V
ZK2-GEN white/weiss = GND )
blue/blau = 24V
green/griin = MP
/GND __@_._.@,..f..
MP
]
.A-MP ..A-MP .. A-MP ..A-MP ..A-MP .A-MP
...D2-MP ...D2-MP ...D2-MP || ...D2-MP ...D2-MP ...D2-MP
..MFT(2) .MFT(2) SMFT@) || .MFT@) || ..MFT(2) .MFT(2)
|ﬁ5| Select the desired MP-Channel and click the symbol "Parameterize Limited Lots".

Option  Click with the right mouse button on the MP-Channel and select Parameterize Limited Lots. Or
select the MP-Channel » Parameterize Limited Lots in the main menu.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Parameterize Limited Lots

Pararneter file: I 00443-20025-062-069_ 20050821 _1340.bptpar j
Series Mumnber | State

00443-20025-062-059

00323-10036-062-076

Inzert zenes number of devices manually or by actuate manual Buttan, L/R switch or 52 button.

¥ PFrint Label Parameternize I Cloze

Dialog for parameterizing limited lots

Select the file with the saved parameters in the dialog.

Position the cursor in the first input box for the serial number. Then press the acknowledge
button on the first actuator which should be parameterized. If the buttons are not accessible,
directly enter the serial numbers as described below.

The serial number of the actuator is read out after the acknowledgement and written into the
input box. The cursor jumps to the next line.

Repeat the process for all actuators that are to be parameterized and mark the checkbox if you
want to print labels after parameterization
(see Section 3.9 "Printing labels").

Click Parameterize.
The PC-Tool now asks for the file with the values to be written into the actuators.

The periodic bus scan is stopped for the duration of the parameterization. The actuators are
successively set to the address MP1, programmed and finally set to PP addressing.

When the bus scan is set to MP/PP, the actuators in the outline bar [C] will not be visible. If the
bus setting PP only is used, a bus jam will result.

If an error occurs during programming, a corresponding text is displayed in the "State" column.
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If the address MP1 is already assigned to an actuator, a message will be displayed:

Belimo PC-Tool: Parameterize limited loks x|

@ Bddress MP1 is not free, de-address ather devicels) First?

Zancel |

Message when the address MP1 is already assigned (limited lot)

Click OK to initially release the address MP1. The actuator that used to be assigned to this
address will be set to PP.

Click Cancel to stop the parameterization at this point.

[dentification with known serial numbers

You can also fill in the input boxes manually before you click "Parameterize", for example when
the buttons of the actuator are not accessible or you regularly take the serial numbers from your
documents.

Programming further series

The actuators that have been successfully programmed are deleted from the list. You can
register further serial numbers in the list and then click "Start parameterization" again.
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3.9 Printing labels

To identify actuators, you can write self-adhesive labels with the PC-Tool program. A special
printer may be necessary, depending on the type of label.

3.9.1 Setting up a configuration file

Labels are defined per project. To print labels, set place holders (number in brackets) in the
configuration file for the information to be printed.

The structure and storage location of the configuration files are described in the Appendix.

3.9.2 Printing labels
|E| Select an actuator and click the "Print Label" icon (with an orange background).

Option  Click an actuator in the outline bar [C] with the right mouse button and select "Label Printing".

E Label Printing [$__<|
Printer selection |"x"xL| RANOS Mirwana
Label configuration file |,’-‘-.~.rer'_.r 5162 bptlb j

Label print oder: 3) left to right b) top
to bottom.

o

L

Mumber of labels per actuator 13:

Next printable label on sheet | 1=

OO

Tagging string (41) |N|_|m|:n3r+‘1t

Start number 1E|: [To number the actustors in serial order, place the &
charactor into the tagging string).

Lable string (42) |FI|:u:lr I
Lable string (43) |
Lable string (44) |

Reset Form | Print Preview | Brint | Cancel

Label printing dialog
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Select a printer and a configuration file.

Enter the number of identical labels that are to be printed for "Number of labels per actuator".
When parameterizing limited lots, the total number of printed labels is equal to this value times
the number of actuators.

Enter the desired texts {41} — {44} that are to be printed, if necessary. A maximum of 50
characters are available per text box. In text with consecutive numbering, a number is entered
instead of the place holder "#'. This number is increased by one for each new actuator.

If labels have already been used from a label sheet, you can specify at what label position the
printing should start (for example 4 when 3 labels have been used from the first row).

Your entries and the selected printer are preserved from one label printing process to the next
(automatic saving). You can empty the input boxes with Reset Form.

The texts {41} — {44} must be present in the label configuration file in the form of place holders.
Otherwise, they will not be printed out.

3.9.3 Printing labels offline

Option

Labels can still be printed even if no actuator is connected. In this case, only the information
from the project data, the texts entered in the dialog and the current date can be output. The
start number is always used instead of the place

holder #.

Click the "Print label" icon (with gray background).
Click the project in the outline bar [C] with the right mouse button and select "Label Printing". Or
select Project » Print Label in the main menu.

For Number of labels per actuator, enter the number of identical labels to be printed. The
number with the placeholder "#" is NOT counted up. The further procedure is the same for
printing actuator labels.

NOTE: USE THIS SECTION ONLY IF THE ACTUATORS (S) MP ENABLED.

3.10 Transformation tables
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Transformation tables are for converting the sensor value into another physical quantity, for
example from resistance (in ohms) to temperature (in °C) for NTC resistors. Several frequently
used transformation tables are supplied with the program.

Selecting a transformation table

Select a transformation table with the combobox. The corresponding converted value is
displayed underneath the sensor value.

The measured sensor variable in the table must match the selected sensor type: volts for active
sensors, ohms for sensor resistors, on/off for switches.
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Adapting a transformation table
M Click the transformation table icon.

Option  Click the project in the outline bar [C] with the right mouse button and select Transformation
table. Or select Project » Transformation table in the main menu.

=Edit Transformation Table =10] x|
[ | 2 | El Mi_1000.bpttt

From To Description:
[Ohm  ~JJT =] NFO0OORmto°C
Ohm - | T =
3 743 50 . 190
791 -40 i
842 -30
893 -20 1o
945 10 1 l‘f'
1000 1] 50
1056 10 .
1112 20 0
1141 25
1171 30 T
1230 40 -50 £ 7 T
1291 50 500 1000 1500 2000
1353 B0 Ohrm
1417 70
1483 g0l o
e -- Cloze |

Dialog for editing transformation tables

Select an available transformation table using the combobox.

The sensor values and the converted values are displayed in the table on the left. On the right,
you see a corresponding diagram with the sensor values on the horizontal axis and the
converted values on the vertical axis. The table values are /inearly interpolated; in other words,
the points are connected by straight lines to calculate intermediate values.

During conversion, the first and last connection lines are extended beyond the range of entered
points (extrapolated) so that even sensor values outside of this range are valid.

You can adapt each value in the table or add new value pairs in the last line, which is marked
with an asterisk (*). Newly added value pairs are automatically sorted into the right place.

The following holds true for switches: Off =0, On = 1.

|E| Save the changes to the transformation table by clicking on the floppy disk icon.
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When you change a transformation table in one project, the changes do not affect
corresponding tables in other projects. However, you can return to the original project folder
from all projects through the entry <Other...> in the combobox and open the changed table.

Setting up a new transformation table

When the dialog for editing a transformation table is open, you can create a new table with the
‘New" icon. Select the physical quantities for the sensor values and the converted values in the
comboboxes above the table. You can also write any other quantities into the text boxes of the
comboboxes.

For the sensor values, only volts, ohms and on/off are meaningful input quantities, because only
these sensor types are supported.

Enter a description in the text box and add new value pairs in the last line of each table, which is
marked with an asterisk (*). A transformation table must have at least two lines.

For switches, you can define an on/off inversion table with the assignments 0 > 1 and 1 > 0.

Save the new transformation table by clicking on the floppy disk icon. The name that you enter
in the "Save file as" dialog will be subsequently offered as a selection in the combobox.

If the name of the new table does not appear in the combobox on the "Simulation” tab, open the
project again.

The new transformation table is not directly available as a selection in the combobox in other
projects. However, you can return to the original project folder from all projects through the
entry <Other...> in the combobox and open the new table.

Deleting a transformation table

When the dialog for editing a transformation table is open, you can use the Delete icon to delete
a table that has been selected in the combobox.

If the name of the deleted table still appears on the "Simulation" tab in the combobox, open the
project again.

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.



M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

V /[ 4
BELIMO

3.11 Displaying recorded trend data

|E| Click the symbol Trend display.

PC-Tool User Manual

Option  Click the project in the outline bar [C] with the right mouse button and select "Trend Recall". Or
select Project » Trend Recall in the main menu.

= Trend Recall

= A= MEE] Standard_LM244-MP_test rig_00543-10256-142-143 20N
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ki Position [%]
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Reset: Double click

Cloze
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Trend recall

Select a trend file with the combobox.

Keep the CTRL key pressed and pull the diagram to the left or right with the mouse in order to

display values for other times.

E Use the save button to fix the window size of the trend display.

Printing a trend

Click the Print icon or press the key combination CTRL-P.

You can use the copy button to insert the diagram into other documents via the clipboard.

Option  In addition to the Print button, you can open a menu with the "down" key. In addition to printing,

this allows you to display a preview or select several files for printing with "Print multiple".
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3.12 PC-Tool options

Select Tools»PC-Tool options... in the main menu.

Option  Click the project in the outline bar [C] with the right mouse button and select PC-Tool options...

x

General
Release Codes
MP channel configuration IC:\daten\B elimotPCT ool _I
Air module

Water Globe module " Use defoul

Waid MY-D2M module

WAy Compact module Language;

Project baze path:

WA WYEP-M module

[ i The new language setting becomes active
Fire: % smoke module IE”QhSh LI

after a program restart.
Log file:
" File per wesk ' File per manth
¥ Enable MP-Manitar
Simulation/T rend
I Ask user if endfiles should be saved [if not check save them always],

¥ Enable senzor reading functionality

(] 4 I Cancel |

x
General . .

Felease Codes Froject base !Jath.

MF channel configuration Ic:'\daten\Bellmo'\F’ETnnl I

Air module I~ Use default

Water Globe module
W MV-D2M module

War Compact module Language:
W YRP-M module : The new language zetting becomes active
Fire & smoke module IEngIlsh ;I itk g

after a prograrn restart,
Lag file;
€ File par week ' File per month
I¥ Enable MP-Moritar
Simulation/T rend
™ &gk user if trendfiles should be saved [if not check save them always).

¥ Enable sensar reading functionality

(0] 8 I Cancel

Dialog for basic settings (general)

"Project base path" sets the default directory in the file system, in which the new project folder
will be saved. You can override this information when creating new projects, however.

When you mark the "Use default’, checkbox, new projects will be saved in your user profile
under "My Documents'. With the operating system Microsoft Windows XP (English), this folder
is located under
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3.13 Log file
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C:\Documents and Settings\<Name>\My Documents.
You can open the folder "My Documents" with the "My Computer" icon.

The language that you select in the combobox will be used the next time that you start the
program.

Under "Log file", you can define whether a separate log file should be created each month or
each week.

Mark the "Activate MP-Monitor" checkbox to monitor the communication with the actuators with
the diagnostic tool.

In addition to "General", the names of the supported modules (actuator families) are displayed
on the left side. Further information on the module-specific settings is found in the
corresponding sections of this manual.

All activities with the PC-Tool software that influence the data stored in the actuator are
recorded in a separate log file for every project. The time of each action is logged.

Configuring the log file

You can create a separate log file for each week or month of a project (default: File per month).
To change this setting, select Tools»PC-Tool options in the main menu. You can select either
‘File per week' or ‘File per month' under ‘General'.

Reading the log file

Click the "Read log file" icon in the toolbar.

Click the project icon in the outline bar [C] with the right mouse button and select Read log file.
Or select Project »Read log file in the main menu.

Using the combo box ‘Log file', you determine the file to read. The contents of the log file are
displayed in a table in the top section (each action starts a new row).

By clicking a column title, you can sort the table according to the selected column. By clicking
again on the same column title, the sorting direction is reversed: increasing (A-Z) or decreasing
(Z-A).

Details
Click a table row to display details of this action in the bottom section.

You can print the text in the detail area ("Print..." button) or copy it to the clipboard ("Copy"
button) and then paste it into another document.
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B[(=1/E9

Logfile |M-2006-02 bptiog -
Log events:
D ate/Time Event Pozition ztring Type Sefies no. PP -
02.02 2006 09.42:31 Fead all parameter  P-10001 LF24-MFT2 00404-10097-080-09 PP
0202 2006 09.42:31 wWiite all parameter  P-10001 LF24-MFT2 00404-10097-080-09 PP
02.02200611.27:05  Read all pararieter  P-10001 LF24-MFT2 00404-10097-080-03 PP
0202200611.31:20 Read all parameter Hif-D2-MP 00G03-30024-146-13  MP4
0202200614 4216 Read all pararneter M0 2-MP 00603-30024-146-13  MP4 |
0202200614403  Read all parameter My pozition Shd 244,-b P 00534-00026-14212 PP
0202 2006 16.05:21 Fead all parameter by position Sh248-kF 00534-00026-14212 PP
0202 2006 16.05:31 Fead all parameter by pozition Sh2d8-kF 10534-00026-14212 PP
02022006 16.03.04  Read all parameter by pozition ShiZds-kF 00534-00026-14212 PP
02022006 16.09.10  Read all parameter by pozition ShdZds kP 10534-00026-142-12 FP
02 02 2007 1R 3R-1N Reaad all rararmeatar AF24A Mk nna121nma-ned-ng WMet T
1 3
K.ey | " alue .
D ate/Time 02022006 14 4216
Event Read all parameter
Pozition string
Type MNbdw-Di2-bP
Series no. 00603-30024-146-139
MP-Adresse kP4
Praject name testpral_trmp
SM 00603-30024-146-139
Type MNiW-D2-tP
D ezignation
Puogition
Address kP4
Control type WAL-CAL
Calibration value 3Je28
Wolumetric: flow zetting  Whom: 3303 madh, Wmid: 1652 m3rh
Yrin: O madh, Y max 3303 m3ddh
& feature Standard
Control function ' DC 210
Senzitivity ninrmal b’
< »
Copy Frir... Cloze |
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4 Attachment

4.1 Storage locations of files

411 Project data

The default project is stored as a "Default project" sub-directory in the installation directory of
the program.

The projects are user-specific and are stored as a sub-directory in the user profile. For an
English-language version of Windows, this is

C:\Documents and Settings\<Name>\My Documents\Belimo\PCTool

This directory contains sub-directories with the project names.

4.1.2 Configuration files

The user-specific settings are stored in the user profile under "Application data". For an English-
language version of Windows, this is

C:\Documents and Settings\<Name>\Application Data\Belimo\PCTool

This directory can be "hidden" under Windows. If it is not present, the settings will be queried
upon starting.
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4.2 Configuration files for printing labels

4.2.1 Storage location

The filenames have the extension *.bptlb. They are saved in the "label definition" directory for
each project. For an English-language version of Windows, this is

C:\Documents and Settings\<Name>\My Documents\Belimo\PCTool\ <Project>\label definition

422 Format

The configuration files for label printing are stored in XML format. You can edit these files with
an editor program, for example "Notepad".

Configuration files for common Avery and Zweckform labels are supplied with the program.

Example of a configuration file

<?xml version="1.0" encoding="utf-8"?>

<LabelDefinition xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<PageSize Height="278" Width="214" />
<PageBorder Top="18" Left="5" />
<LabelSize Height="33" Width="100" />
<LabelBorder Top="5" Left="5" />
<Lines>

<Line Text="" />

<Line Text="{0} / {1}" />

<Line Text="{20}" /> <Line Text="{21}" />
<Line Text="{23}" />
<Line Text="{41} / {42}" />

</Lines>

</LabelDefinitions>

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

1-44

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.



M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

PC-Tool User Manual

BELIMO

4.2.3 Boxes

You can adapt the values for the page layout (values in millimeters) for new label formats.

PageSize Page size (height and width)

PageBorder Border width (top and left) = distance from the top left corner of the first
label to the page border

LabelSize Size of an individual label

LabelBorder Label border width (top and left) = distance of the lettering from the label
border

In every line element <Line>, you can insert place holders where certain project and actuator
characteristics will be added during printing.
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{0} Company name (from project data)
{1} Project name

{10} Actuator type

{11} OEM designation

{12} Position

{13} Serial number

{14} MP address

{20} Control type Y

{21} Feedback signal U5

{22} Range of rotation min — mid — max
{23} Running time

{24} Direction of rotation (cw /ccw)
{25} Bus fail position

{26} Sensitivity

27} Synchronization at

{28} Torque

{29} Nominal range

{30} Conductance

{31} Vnom

{32} Vmax

{34} Vmin

{36} Control fct.

{37} Mode

{40} Printing date

{41} Text with consecutive numbering
{42} Freely definable text 1

{43} Freely definable text 2

{44} Freely definable text 3

{50} Switching point S1 in degrees (°)
{51} Switching point S2 in degrees (°)
{52} Setting damper free running test

You can define up to 50 lines. The program does not check whether the lines fit on a label.

When you define a new configuration file in a project, this configuration will not be directly
available in other projects. However, you can return to the original project folder from all
projects by using the entry <Other...> in the combobox, and then use the file.
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4.2.4 Example of a label

The following example results in a label having the dimensions width x height = 50 mm x 20
mm. The example is intended for an endless label printer that prints labels of the size 50 mm x
20 mm.

The company name, the project name, the actuator type, the type of control signal and the
running time are printed on the label.

This data yields the following configuration file and the subsequently displayed label:

<?xml version="1.0" encoding="utf-8"?>

<LabelDefinition xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<PageSize Height="20" Width="50" />
<PageBorder Top="0" Left="0" />
<LabelSize Height="20" Width="50" />
<LabelBorder Top="5" Left="5" />
<Lines>

<Line Text="{0}" />

<Line Text="{1}" />

<Line Text="Type: {10}"/>

<Line Text="{20} Running time: {23}"/>

</Lines>

</LabelDefinitions>

Label: {0}

Belimo Automation AG
Sample 4————'———__———_————_————_
dl

Type: LM24A-MP {10}
Y: Open/Close Running time: 40s

{20} {23}
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4.3 Troubleshooting and error messages

431 General
Problem  After the program starts, an MP-Channel is not opened but displayed with the MP-Channel icon.

Solution  The MP-Channel cannot be opened, for example because the selected serial interface is
assigned to another application. Check whether a modem or a communication program is using
this interface.

4.3.2 Error messages

Error message Description

Start adaptation failed. Communication failure on the MP-Channel or faulty actuator.

Actuator locked for PC-Tool. The drive has been configured so that it can be neither read out nor
programmed with the PC-Tool.

Summary: Actuator not reachable Communication failure on the MP-Channel or faulty actuator.

Summary: Actuator run into timeout. The drive did not respond within the specified time.

Answer has too much data. Conflict between the actuator and program. The program library
(belipp.dll) may not be up-to-date.

Answer doesn't have enough data. Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

Command has not enough parameters. Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

Command parameters out of range. Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

Belimo library error code = .... Internal fault.

Description is missing A transformation table must have a description.

Bus Jam Two or more devices respond to the same address. Re-address the
actuators.

This field is required! This field must have an entry. It is not allowed to remain empty.

There is already an instance running! The program cannot be started on a computer where it is already
running.

Error while creating the project! Check whether it is possible to write to the storage location of the
project.

Error while copying default project. When a new project is created, configuration files and sub-directories

are normally copied from the default project in the installation directory
of PC-Tool. The default project has probably been accidentally deleted,
moved or renamed.
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Error message

Description

Default project directory '..." does not exist!
Please reinstall the application.

When a new project is created, configuration files and sub-directories
are normally copied from the default project in the installation directory
of PC-Tool. The default project has probably been accidentally deleted,
moved or renamed.

Command ... unknown by the device

Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

The value must be between ... and ....

The entry is not in the permitted range of values.

Invalid data answer from the device.

Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

The difference is smaller than ....

A rule for the minimum difference between two values has been
violated.

The length of the string must not exceed ...
characters.

Shorten your entry.

MP-command ... unknown by
PP_Function

Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

A transformation table must have at least 2
points.

A transformation table must have at least 2 lines to be able to calculate
intermediate values.

Not all parameters written to device

(Note the detailed instructions with the message regarding the reason
for the error.)

Label print failed.

(Note the detailed instructions with the message regarding the reason
for the error.)

Wrong device family ... instead of ...

When setting the parameters of small batches, an actuator from
another actuator family was connected and does not match the
parameter file.

Wrong transformation table for this sensor
type. It cannot transform from unit .. ..

The transformation table does not have the measuring quantity of the
sensor in the first column. Resistance sensors must convert ‘'ohm' into
the target parameter, for example.

Wrong device connected!

This fault occurs when actuators are changed during parameterization.
Read the parameters out again.

Wrong MP channel: '...".

The MP-Channel has changed.
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Error message

Description

Error starting testscript

The test script is invalid.

Label printing error

(Note the detailed instructions with the message regarding the reason
for the error.)

Error loading transformation table

(Note the detailed instructions with the message regarding the reason
for the error.)

Error while loading project file: ...

(Note the detailed instructions with the message regarding the reason
for the error.)

Error reading parameter file

(Note the detailed instructions with the message regarding the reason
for the error.)

Error opening Channel ....

(Note the detailed instructions with the message regarding the reason
for the error.)

Error opening file explorer

File Explorer could not be started when displaying MP-Monitor files.

Error opening MP-Monitor

(Note the detailed instructions with the message regarding the reason
for the error.)

Error while saving test report!

(Note the detailed instructions with the message regarding the reason
for the error.)

Error while processing line ... of the trend file

The trend file could not be interpreted. It was probably written
manually.

Error: Invalid code for the module release.

Relates to the entry of the activation code. Please check your entry. All
boxes must be filled-out according to the requirements.

Error: There is another device on MP1

Address conflict.

Error: Unable to change address to MP1

Address conflict.

Error: no answer from actuator

Communication failure on the MP-Channel or faulty actuator.

Address ... already set to this device!

Re-addressing re-assigns an already existing address.

Module release code expired!

Please contact your representative for a replacement of the code.

Character '..." is not allowed (not 1ISO-8859-1)!

Only characters from the Western European character set are permitted
for Description and Position of an actuator (see table in Section 4.3.3).

No answer (possible bus jam).

Communication problem on the MP-Channel or faulty actuator.

No answer from device.

Communication failure on the MP-Channel or faulty actuator.

No label configuration file chosen.

Please choose a valid label configuration file and print a test label or
uncheck print label after write.

No or empty setup string.

"Other" was selected when setting the communication parameters, but
no connection was specified.

Could not deaddress other device

Address problem. (Note the detailed instructions with the message
regarding the reason for the error.)

Couldn't write to the device!

Communication failure on the MP-Channel or faulty actuator.
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Error message

Description

Could not find the VRP-M Tool executable.
Would you search for it now?

Concerns VRP-M controller. The corresponding program could not be
found at the location specified in the PC-Tool options.

Configure the path in the options (menu Tools/PC-Tool options in VRP-
M).

Could not find PC-Tool V2.1. Would you search
for it now?

Affects VAV actuators. The old version of the program could not be
found at the location specified in the PC-Tool options.

Error while loading project.

(Note the detailed instructions with the message regarding the reason
for the error.)

MP-Command ... failed.

Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date. MP command could be password-protected.

MP-Channel was closed

The MP-Channel was closed during an asynchronously running
function.

Not all data written to the device.

Communication problem during writing of the parameter data, possibly
due to bus jam. Check the connection and addressing of the actuators.
An MP command is password-protected or the actuator is not familiar

with the command.

Could not read all data from the device.

Communication problem while the parameter data was read, possibly
due to bus jam. Check the connection and addressing of the actuators.

Not all fields have valid values! Can't write data

One or more input values in the "Configuration” tab is not valid. Look
for a flashing exclamation mark. If you move the mouse pointer to the
exclamation mark, an explanatory text (tooltip) with the valid range of
values will usually appear.

OEM or BELIMO password necessary. Please
contact OEM-Manufacturer

Parameters on the actuator can be protected with a password against
changes. A password is necessary to overwrite them.

Parameter file contains no series number

When setting the parameters of small batches, the actuator family is
checked by means of the serial number. The parameter file is old or has
been changed manually.

Error opening configuration file

(Note the detailed instructions with the message regarding the reason
for the error.)

Error storing configuration file

(Note the detailed instructions with the message regarding the reason
for the error.)

Plausibility check: Failed. Please check the
configuration dialog for further information.

Testing is not started if there are errors in the configuration.

Problems opening the MP-Channel "...".

Error at the interface. Check the communication parameters and the
cabling.

Sending ... to ... returned error ...

Conflict between actuator and program. The program library (belipp.dll)
may not be up-to-date.

Wrong format of serial number

You have made a typing error while manually entering the serial
number. Check the notation of the serial number.
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Error message

Description

Series number has a wrong format!

You have made a typing error while manually entering the serial
number. Check the notation of the serial number.

Reset alarm messages failed

Communication failure on the MP-Channel or faulty actuator.

Synchronization failed

Communication failure on the MP-Channel or faulty actuator.

The test script cannot be started because some
conditions are not complied.

A certain minimum air flow or system pressure is necessary for the
test. Please check fan and VAV box.

Start test run failed

Communication failure on the MP-Channel or faulty actuator.

New address could not be verified

The serial number is read before and after an actuator is re-addressed.
These two numbers do not match. Another actuator probably answers
to the programmed address.

Unknown MP-Channel '...".

The MP-Channel could not be identified.

Invalid or corrupted parameter file '...'

The contents of the file could not be correctly interpreted. The format
may no longer be valid. If possible, read out the parameters again and
save them in a new file.

Invalid Series Number

The entered serial number was not found in any connected actuator.

Invalid value entered

Refer to the notes about the valid range of values.

Invalid value!

Refer to the notes about the valid range of values.

Unspecific Belimo-Lib error

Internal fault.

Must be greater than zero.

Refer to the notes about the valid range of values.

Must be an integer.

Refer to the notes about the valid range of values.

Summary: Test cannot be executed due to
active forced control

Remove the Y connection with the control signal for the duration of the
test.

Two or more devices respond to the same
address.

Bus jam Re-address the actuators.
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4.3.3 150 8859-1/ANSI character set

Only characters from the ISO 8859-1/ANSI character set are permitted in the "Description” and "Position" box

Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char
32 64 | @ 9% | 128 | € 160 | 7 192 | A 224 | a
33 |! 65 |A 97 |a 129 |- 161 | 193 | A 225 | a
34 | 66 |B 98 |b 130 |," 162 | ¢ 194 | A 226 | a
35 | # 67 |C 9 |c 131 | f 163 | £ 195 | A 227 | a
36 |$ 68 |D 100 | d 132 [,2 |164 |= 196 | A 228 | &
37 | % 69 |E 101 |e 133 | ... 165 | ¥ 197 | A 229 | a
38 | & 70 |F 102 | f 134 |t 166 | | 198 | /E 230 | e
39 | 71 |G 103 | g 135 |t 167 | § 199 | C 231 | ¢
40 | ( 72 | H 104 | h 136 |~ 168 |~ 200 | E 232 | e
44 ) 73 || 105 | i 137 | %o 169 | © 201 |E 233 | &
42 | * 74 | 106 | j 138 | S 170 |2 202 |E 234 | &
43 |+ 75 | K 107 | k 139 |« 171 | « 203 | E 235 | &
44 |, 76 | L 108 || 140 | CE 172 | - 204 |1 236 | i
45 | - 77 |M 109 | m 141 |- 173 | -9 205 || 237 | i
46 | . 78 | N 110 | n 142 | Z 174 | ® 206 |1 238 |1
47 |/ 79 |0 111 | o 143 |+ 175 |~ 207 |1 239 |7
48 |0 80 |P 112 | p 144 | - 176 | ° 208 | B 240 | 6
49 |1 81 |Q 113 | q 145 |9 177 | £ 209 [N 241 | A
50 |2 82 |R 114 |r 146 | 'Y 178 | 2 210 | O 242 | o
51 |3 83 |S 115 |s 147 | "9 179 |3 211 | O 243 | 6
52 |4 84 | T 116 |t 148 |"© 180 |~ 212 | O 244 | 6
53 |5 85 | U 117 | u 149 | - 181 | u 213 | O 245 | 6
54 |6 86 |V 118 | v 150 |- 182 | 1 214 | O 246 | 6
55 |7 87 | W 119 | w 151 | — 183 | - 215 | x 247 | +
56 |8 88 | X 120 | x 152 |~ 184 |, 216 | @ 248 | @
57 |9 89 |Y 121 |y 153 | ™ 185 | ° 217 | U 249 | U
58 | : M |z 122 |z 154 | & 186 | ° 218 | U 250 | U
59 | 91 | 123 | { 155 | > 187 | » 219 [ U 251 |G
60 |< 92 |\ 124 | | 156 | ce 188 | V4 220 | U 252 | 0
61 | = 93 |] 125 |} 157 |- 189 | %2 221 | Y 253 |y
62 |> 94 | A 126 | ~ 158 |z 190 | % 222 | b 254 | p
63 | ? 9% | _ 127 159 |Y 191 | ¢ 223 | B 255 |y

The character positions marked with « are vacant.
) Single speech mark, low

) Double speech marks, low

) Single left speech mark

) Single right speech mark

o

Double left speech marks
Double right speech marks
Non-breaking space
Breaking hyphen

N
(=)

ENE )
e
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4.4 Typical wiring diagrams
4.41 Overview table

Cable MP level converters and devices Drawing Page

ZK1-GEN
; : - d ZIP-USB-MP | Typical wiring diagram1 | 1-55

ZK2-GEN
. — Typical wiring diagram 2 1-55

N > ZIP-USB-MP

AR Typical wiring diagram 3 | 1-56

ZK6-GEN
- “">«/ ZIP-USB-MP | Typical wiring diagram 4 | 1-56

ZKS-MP
s % — ZIP-USB-MP | Typical wiring di 1-57

[K"WT 57 ypical wiring diagram 5

ZK1-VAV

— Typical wiring diagram 6 1-57
n 415;) ZIP-USB-MP
{A Typical wiring diagram 7 1-58
d:. -
Direct connection o, ZIP-RS232 | Typical wiring diagram 8 1-58
A
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4.4.2 Typical wiring diagrams

Typical wiring diagram 1

; BELIG RJ11 (6/4)
Belimo " 0
PC-Tool o g
Q Initialized g
- / 24V
] \ ZIP-USB-MP (e ZK1-GEN GND
..A-MF
...A-MP
...D2-MP
...ALON
...D2LON
Typical wiring diagram 2
1l ~ AC24V
- + DC24V
. BELIMO
Belimo E Qg
PC-Tool - g o g
O Initialized g
2 =
/ \ ZIP-USB-MP  c¢

| — usB

white/weiss = GND
blue/blau = not connected/nicht angeschlossen

green/griin = MP ,! l

(i I >
...MFT(2) ...LON 1~ usmp
~A-MF  _aAloNn T~ ¢
«A-MP  p2| ON
...D2-MP
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Typical wiring diagram 3

MP-Master
DDC Controller
RJ11 (6/4) UK...Gateway
L BELIMO
Belimo . @ ZK2-GEN
] O Enable
PC_TOO' E i g :::allud § GND 24 V MP
— ? § E
[ \ ZIP-USB-MP CE .
[ ! USB white/weiss = GND ““@““@“f“-
blue/blau = not connected/nicht angeschlossen
green/griin = MP MP
L J
+ @
....A-MP
...D2-MP
..MFT(2)

Typical wiring diagram 4

; BEUI\?I% RJ11 (6/4)
¢ {
Inmialized Q
g g ZK6-GEN
ZIP-USB-MP ¢
— USB
RJ11 (6/4
[C]o]O]E[O]0]0] [O]O[0]0]O[0]O[O]
BELIMO
Optimizer ‘
COU24-A-MP

lolojolojojololo]o] [o]olojojololo]o]o] [o]o]o]o]o]o]
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Typical wiring diagram 5

UK24LON/EIB BELIMO
[¢) o ) 2 o |o
MP-Monitoring — '\[’IQ_FI';H ©] © © ®
Pos. ,MO" LonTalk WP-Com. Power
a_ b 0V 24V Y U/MP 0V 24V n.c.
USB g ooog @ed
: 0 ; BELIMO L]
Belimo B n
PC-Tool g ot g
L e P § 3 pol ‘\
— N T ey L
DC24V — +
ZKS-MP L
------------- —
....A-MP
...D2-MP
.MFT(2)
Typical wiring diagram 6
RJ11 (6/4
) BELIMO
Belimo " 0
o QO Enable 8
PC-Tool g palra g
(o] O Initialized g
\ 8 2
/ \ ZIP-USB-MP (43 NMV-D2M BELIMO
| 1 USB
ZK1-VAV
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Typical wiring diagram 7

. BELIGS RJ11 (6/4)
Belimo n ®
PC-Tool g O B
E QO Initialized k\' ?
\ = CR24.. 0
(@]
1 ZPusBMP  ce - :
= USB o 0
o) O
o QO
Q
ZK1-VAV ﬂ

Typical wiring diagram 8

ZN230-24 . O N
AC 230/ 24 V Belimo | 18 55
AC 230V PC-Tool - 4=
| —
ZIP-RS232 BELINMO |
Actg;tor I i %) % -S
OFF
T T 1°'2 5
1 2 3 5
C i)
L ~ uy .. MFT(2)
-+ MP ... A-MF
..... A-MP
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1 Introduction

The "Air module" user manual describes the detail area [D] of the Air module. The

documentation is divided according to the three index tabs "Service", "Configuration" and
"Simulation”.

Air and Water Actuators are basically the same. The water actuator has a linkage that connects
the actuator to the valve. The nomenclature of air and water is as follows:

Air Water
GMB GRB
AMB(Q) ARB
NMB(Q) NRB
LMB(Q) LRB

The actuators operate in the same manner. Examples in this document show the damper
versions and all data applies to valve actuators as well.

NOTE: NV/NVF actuators section starts on 3-A
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2 Service

NOTE: This will display after successfully communicating to the actuator.

2.1 Displaying settings

The Service tab gives an overview of the current settings of the actuator.

L, Simulation ‘ vi

Actual seitings Test

Service l Configuration

Control functionY DC 2-10V

Sensitivity normal Adaption

Synchronization

Mominal range 53° adapted

Running ime £.0=
Angle of rotabion Max: 100% [937]
Min: 0% [07]

Direction of rotation cw @.JY_

Mid.: 50%  [477]

100%

Synchronization at

Torque

Bus fail position
Power ON

Manual button Jonce]

Actuator information

Firmware
Config table ID

Datalog
Operating time
Active time
Stop & Go ratio
Messages

Mezzages

Y=0%

100%

Last value
Synchraonization
Adaption

(2031 (0x04)
OxF111

112h
Oh
0%

Reset Messages

Service tab for full-rotation damper actuators

For linear actuators the stroke is displayed instead of the angle of rotation, and the torque
instead of the positioning force.

Mominal range 100 mm adapted
Running ime 150s

Stroke Mao: 100%  [100mm] I
Min: 0% [Omm] Mid.: 50%  [50mm]
Direction of stroke up ﬁ{;m:{ﬂ
Synchronizabion at =0

Force 100%

Service tab for linear actuators (excerpt)
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Control signal Y

Type of control

Sensitivity Response sensitivity and reversal hysteresis of the control function
Feedback U5 Type of feedback signal

Range Position range within the mechanical limits

Running time related to operating range or a fixed angle/stroke of 95°/100mm (with

annotation)

Angle of rotation

Programmed rotation range: Min / Mid / Max
(for full-rotation actuators)

Stroke

Programmed stroke range: Min / Mid / Max
(for linear actuators)

Direction of rotation

Clockwise/counterclockwise (for full-rotation actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque (for full-rotation actuators)

Actuating force

In percent of maximum positioning force (for linear actuators)

failure

Behavior in the event of bus

Behavior when communication fails

Power ON

Behavior when the system is switched on

Manual button [once]

Function when pressed once

Manual button [twice]

Function when pressed twice
(not present in "New Generation" actuators)

Function table

Assignment of override setting and override function
(only for certain actuators)

Firmware Software version on the actuator

Config table ID Identification of the configuration table

Operating time Number of hours during which the actuator was connected to the
power supply

Active time Number of hours during which the actuator was mechanically in

motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop & Go ratio
indicates an unstable control.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

2-3



PC-Tool User Manual BELIMO

for Damper and Valve Actuators

2.2 Adaptation

Option

In the adaptation, the actuator determines the range 0% ... 100% by approaching the
mechanical limits.

Click the "Adaptation” button on the Service tab.
You can also trigger the adaptation directly on the actuator. The necessary buttons for this can
be programmed. For example, "Manual button [twice]" can be assigned the adaptation function.

The progress of the adaptation is displayed in the status line. The actuator first moves against
the programmed direction to the zero stop and then to the end stop at the full angle of rotation.

Next, the absolute values for a programmed limited angle of rotation range (minimum, mid-
position, and maximum) as well as the feedback signal U5 are recalculated and displayed.

2.3 Synchronization

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Option

In the case of synchronization, a mechanical limit is moved to in order to determine the absolute
range.

For each actuator, it is possible to program whether synchronization will take place at the zero
stop (0%) or at the full angle of rotation/stroke (100%).

Click the "Synchronization" button on the Service tab.

You can also trigger the synchronization directly on the actuator. The necessary buttons for this
can be programmed. For example, "Manual button [once]" can be assigned the synchronization
function.

The progress of the synchronization is displayed in the status line. With the setting
Synchronization at: Y=0%, the actuator moves against the programmed direction to the zero
stop, and with the setting Synchronization at: Y=100% to the end stop at the full angle of
rotation/stroke.
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Function test
The function test checks for opening and closing.

First of all, the drive moves to the mechanical stop according to the synchronization position. If
the angle of rotation (or stroke) is set to "adapted”, movement takes place to the other stop; with
‘programmed", on the other hand, to the programmed range limit.

Click the "Test" button on the Service tab. The standard display is covered by the test window.

r—Test progress: r— Cument position: —
L . Start Tiest
- Plauzablility test 1% 41
- Meszages deleted
- Actuator runs OFEN Tt state: Abort Test
- Achyator runs CLOSE BsL ale
Test running
[Cloze Test
—Test report:

= 8|

Test actiwvities:

Display of test progress and test report

Click the "Start Test" button.
The progress and the current position are continuously displayed.

The test report contains

information on the project,

the identification of the actuator,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current actuator settings.
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If the test reports an invalid actuator configuration, go to the "Configuration" tab after ending the
test. The values that are not allowed are marked with a flashing exclamation point.

You can save the test report as a file by clicking the floppy disk icon, and you can print it with
the printer icon.

End the function test with the "Close Test" button. The program asks whether you want to save
an unsaved test report now.

Save testreport? x|

@ Would wou like to save the testreport?

Yes Mo |

If you cancel the test early, the actuator will be reset to its original state. No test report will be
created.
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3 Configuration

On the "Configuration” tab, you can read out parameter values from the actuator, change them
and save them back to the actuator. The valid ranges for the parameter values are displayed in
parentheses next to the input boxes.

Service Configuration i, Simulation |w

Designation |NM24-MFT2

Position |
Start Stop
Control signal Y |DC 21V ﬂ
Read
Min Mid Max Write
Angle of rotation 0 % (0.11%) 55 % (0..100°%) 100 % (89..100%)
0- 19 ° 34 - Store to file__
Running time 60 s (27.107s) Load from file.
Reduce A
Angle of rotation |ac|a|:|tecl ﬂ | M
& lv= f* cow
Direction of rotation 100% o~
oW

Bus fail posifion [Last value v

Sensitivity m

Synchronizabon at m
Torque lﬁ %

Power ON [Synchronization v |

Manual button fonce]: m

Manual button fiwicel: Im

‘Configuration” tab for full-rotation damper actuators
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For linear actuators, the stroke is displayed instead of the angle of rotation and the stroke
direction instead of the direction of rotation.

Min Mid Max
Stroke % (0.90%) 50 % (0.100%) | 100 % (10.100%)
0 mm 50 mm 100 mm
Runningtime | 150 s (67..275s)
Reduce F 3
Stroke |adapte-:| j 00 mm
- - = - ﬁh up
Direction of stroke 1003 17 ~ down

"Configuration” tab for linear actuators (excerpt)

Actuator number

Description 16 characters of any text

Position 16 characters of any text

Control signal Y

3-point AC voltage, positions: Open / neutral / closed
Open / closed DC or AC voltage, 2-point
DCO-10V (DC voltage)
Fixed operating range DC 0-10 V
DC 2-10 V modulating (DC voltage)
Fixed operating range DC 2-10 V
DC variable Start (Y=0%) 0.5...30V

Stop (Y=100%) 2.5 ... 32V
Range between start and stop at least 2 V

PWM 0.02-5 s Duration of the control pulse (pulse width modulation),
fixed operating range

PWM 0.1-25.5 s Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s Duration of the control pulse, fixed operating range

PWM variable Start (Y=0%) minimum 0.02 seconds

Stop (Y=100%) maximum 50 seconds

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

2-8

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.



M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

BELIMO

PC-Tool User Manual
for Damper and Valve Actuators

VAV4 +/-6V When this function is selected, the actuator is parameterized as a VAV
actuator and can therefore be controlled by the VAV controllers VR.. .
Note:
When VAV (6 + 4 V) is selected, the values for minimum, maximum,
intermediate value, running time and angle of rotation/stroke are reset to
the default values.

4-20 mA (Direct current)
Fixed operating range DC 4-20 mA
Note:
This selection is only available for certain drives (e.g. "SunYeh")

mA variable (Direct current)
The values for start and stop are specified in the actuator and cannot be
changed with the PC-Tool.
Note:
This selection is only available for certain drives (e.g. "Butterfly
Actuators")

Feedback U5 (only active when the actuator address is set to PP)

Damper position,

DC voltage measurement signal, fixed range

2-10V

Damper position, DC voltage measurement signal, fixed range
0.5-10V

Damper position, DC voltage measurement signal

variable Start 0.5...8.0V/Stop 2.5...10.0V

Range between start and stop at least 2 V

Damper position,
4-20 mA

Direct current measurement signal, fixed range

Certain actuators can define further feedbacks, which you cannot
change, however.

U5 scaling (only with "New Generation" actuator, MFT or MP types)

Start

Position in percent, corresponds to the start value of the feedback signal

Stop

Position in percent which corresponds to the stop value of the feedback
signal

Angle of rotation (for full-rotation actuators)

Stroke (for linear actuators)

Min Programmed lower limit of the range
Mid Mid-position of range
Max Programmed lower limit of the range
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An existing value for Mid is automatically adapted when Min and Max are entered: If you enter
Min, Mid is always larger than or equal to this input value. If you enter Max on the other hand,
Mid is always less than or equal to this value.

Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V. min: 30%, max : 70%
Feedback U5 : 2.7V start: 20%, stop: 90%
Position
A
Open 100%  —4—+--F--r-d--d-—t--p-—p=-q-=q---
1 1 1 1 1 1 1 1 1 1
1 1 ] 1 1 1 1 1
- a==T T=="r==r=A1 =
1 1 1 1 1 1 1
Y S SO TP PR Uy 1 /) U RPN PR S
1 1 1
1 1 1
— L -
1 1
1 1
__—I——-: -
50% B . d -
:
1
1
1
1

1
1
L I R P,
] 1 1 1 1
1 1 1 1 1 1 1 1
B ettt i e A Al
Closed 0% | | | | | | | | | Y/U5
Fr -1 11 1T 1T ~ V]
0 5 1
Running time
In seconds Time needed to pass through the range limited by Min and Max (the valid

range of values for the running time depends on the actuator type and the
passed-through range).

Note: For actuators with the "constant speed" operating mode, the speed does not depend on
the range passed through. The running time refers to a fixed angle of 95° for rotary actuators or
a fixed stroke of 100 mm for linear actuators.
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Angle of rotation (for full-rotation actuators) / Stroke (for linear actuators)

Adapted

from the mechanical limits of certain angle of rotation range/stroke

Programmed

Angle of rotation range (full-rotation) or stroke (linear), the valid values
depend on the maximum nominal setting range of the actuator

Direction of rotation (for full-rotation actuators)

cw

Damper opening in the clockwise direction

ccw

Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the lettering on
the actuator)
down Downward-opening damper

Behavior in the event of bus failure

Last setpoint

Position according to control signal Y

Open Move to full angle of rotation/stroke (100 %)

Close Move to zero stop

Close quickly Close with maximum speed

Sensitivity

Sensitivity Actuators without Actuators with Actuators of the new
spring-return: spring return: generation and linear:
NM24-MFT TF24-MFT ..MF
AM24-MFT LF24-MFT ..MP
GM24-MFT NF24-MFT ..LON

AF24-MFT
Normal

— Response sensitivity:

1° angle of rotation | 1° angle of rotation | 1.0% @ operating

range
— Reversal hysteresis 2.5° angle of rotation | 2.5° angle of 2.5% @ operating
rotation range

Damped

— Response sensitivity:

2° angle of rotation | 2° angle of rotation | 2% @ operating range

— Reversal hysteresis

5° angle of rotation | 5° angle of rotation | 5% @ operating range

Variable

(only available with release code)

— Response sensitivity -- --

adjustable 0% ... 20%

— Reversal hysteresis -- --

adjustable 0% ... 20%
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Synchronization at

Y =0% Moves to the mechanical limit at zero stop (depending on the direction of
rotation / stroke direction)

Y =100% Moves to the mechanical limit at full angle of rotation (depending on

direction of rotation / stroke direction)

Note: When the nominal setting range is set to “programmed", then the synchronization MUST
be carried out at Y=0%.

Torque (for full-rotation actuators) / Positioning force (for linear actuators)

25% ... 100% Can be set in increments of 25%. 100% corresponds to the maximum
torque / the maximum positioning force for the actuator type (see
nameplate)

Power ON

Synchronization Moves to a mechanical limit (according to the setting "Synchronization at")

Adaptation Moves to both mechanical limits and recalculates angle-dependent
parameters

Nothing (This option is not available for actuators of the "TOP" performance class.
When switched on, they must always be adapted or synchronized)

You can programmatically limit the rotation and stroke range at one end by only changing the
minimum or the maximum. If the value of Power ON is set to "Nothing", then the following holds
true:

The mechanical limit that can still be attained within a rotation range limited at one
end will be used for synchronization.

If you set the minimum to a value greater than 0%, the zero stop will no longer be in the range.
In this case, synchronization will take place at the end stop of the full damper opening (Y =
100%). If, on the other hand, you set the maximum to a value smaller than 100%,
synchronization will take place at the zero stop (Y = 0%).

This is also valid for the case that the nominal setting range is set to "programmed" and the
minimum is equal to 0%: The setting "Power ON: Nothing" is allowed.

Synchronization when the angle of rotation/stroke is limited at both ends

If the minimum is greater than 0% AND the maximum is smaller than 100%, then you can
select where the synchronization will take place. In this case, it is necessary to perform
synchronization or adaptation when you switch the device on (the setting "Power ON: Nothing"
is considered an error).

If the nominal setting range is set to "programmed" and the minimum is greater than 0%, then
the same rule applies: At least one synchronization must be programmed.

M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.



M40035 - 05/10 - Subject to change. © Belimo Aircontrols (USA), Inc.

BELIMO

PC-Tool User Manual
for Damper and Valve Actuators

Manual button [once]/[twice]

Synchronization

Moves to a mechanical limit (according to the setting "Synchronization
at") when the manual button is pressed once or twice respectively

Adaptation Moves to both mechanical limits and recalculates angle-dependent
parameters when the manual button is pressed once or twice respectively
Note: For "New Generation" actuators (types MFT, MP), the function Manual button

[twice] is not available.
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4 Controller simulation

Go to the "Simulation" tab.

Service | Configuration & Simulation | | W
Actuator
¢ Simulation off Set point Actual posibion
40.0 237 222"
{") SetpointY’ I % I = I A
{* Setpoint Tod 5.20 ¥ 3y
" Motor stop Trendview (% % v
Interval 243 | Trend [ ] | Comment... | I0449—20025—052—059_20050321_1 44848_trend_bptind
—Trend
ACME.NM24-MFT2. Room1
= 100

90

80

70

60

50

40

30

20

10 e

1] T T T T I| T T T T T T T T T T T
14:48:504:48:514:48.534:48:534:48:54 4:48:554:48:56 4. 48:57 4:48:58 4:48:594:49:004: 49:014:49:02 4:493:03
Time
SetPoint [%] Actual angle [%] M ax Position [%] Min Poszition [%]

Simulation tab for damper actuators

The controller simulation is not possible while the actuator is performing an adaptation or
synchronization.
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4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y according to selected
control type (DC, PWM, open/close, 3-point).

Setpoint Tool (not available with control type open/close or 3-point): The setpoint is entered in
% of the programmed range. 0% is the minimum, 100% the maximum. The input values are
converted and displayed in the units of the corresponding control signal (volts, milliamps or
seconds).

The control is switched off when you click "Motor stop". This function is not available with the
control types open/close and 3-point.

Measurement values

During the simulation, the current angle of rotation or stroke is displayed in % of the absolute
(mechanically limited) range and — converted according to the scale setting — as a feedback
value in volts or milliamps.

4.2 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function, however, must
be activated in advance in the PC-Tool options under "General". Select Tools » Options in the
main menu.

Release Codes Project base path:

MP channel configuration |C:‘-.Dokumerlte und Einstellungen*" ACME"Eigene Dateien*Belimo\PCToal
Air module

Water Globe module LI e

VAW NMV-DZM module

VAY Compact module Language:

VAV VRP-M module |Eng|ish LJ The new language setting becomes active

after & program restart.
Log file:
" Fileperweek  File per month

[~ Enable MP-Monitor

Simulation/Trend
[~ Ask user if trendfiles should be saved (if not check save them always).
[ Enable sensor reading functionality

Settings for reading out sensors
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On the Service tab, a section with the sensor values is displayed to the right of the actuator
control.

—Sensor
" Mone WYalue
i Active [0___ 32V I 0.0 vy
" Passive [850.._1.6k0hm]
I 0.0 v .
" Passive [200...60kDhm] Tranzformation
= Switch I{Nu table> j

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either displayed in
volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the sensor into the
corresponding measuring quantity (temperature etc.). (See the "Transformation table" section in
the General User Manual)

4.3 Trend recording

Trend Record

Stop Record

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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During simulation, the time progress of the setpoints and actual values can be displayed in a
plot. The values are saved in a trend file and can be displayed again at a later time. Furthermore,
you can add any comment texts you would like.

In the PC-Tool options "General", you determine whether the trend file is automatically saved
when the recording is finished (checkbox not selected) or whether the program should ask you.
The suggested file name can be modified before saving the file.

Click the "Trend Record" button during simulation. The display changes to a "flat" button. The
recording stops when you click again.

The Trend View radio buttons allow you to set whether the display is given in percent of the full
range (%) or in volts (V).

The position is queried every second by default. You can change the query interval in an input
box. The permitted values are 0 to 9999 seconds, whereby the value 0 means "no waiting time"
(query as quickly as possible).
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Interval

1.0z Trend | Comment... | I1_l]l]443—20025—052—053_20050821_1 50254 _trend.bpttnd

— Trend

ACME, NM24-MFT2_ Rooml

= 100

90

80
70

60

50

40

30
20

/
/
[

/

104

1

1}

LI Ll 1 T T T T T T T T T
15:02:55 15:03:00 15:03:056 15:03:10 15:03:15 15:03:20 15:03:25 15:03:30 15:03:35 15:03:40 15:03:45 15:03:50

Time

SetPoint [%] Actual angle [%] Max Position [%] Min Fosition [¥]

Trend plot

The Comment button allows you to enter a text at a defined time and the text is then saved in
the trend file.

If you want to record a trend for more than one hour (long-term trend), enter a value of at least
2 seconds for the interval. If the interval is shorter, too many data points will result and the time
for correcting the curve between the queries can become too short.
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5 PC-Tool options

Select Tools » Options in the main menu.

Option  Click the right mouse button on the program icon in the outline bar and select "Options".

P PC-Tool Options

General M air vigw

Felease Codes Diefault tab:

P channel configuration |S - __J

WA Compact Manufacturer EIIce it
[ Show function table

Air module
Water Globe module
WAY MV-D 2 module
Wav Compact maodule
WA WRP-M module
Fire & Smoke module

Carcel
_—

Dialog for basic settings (Air module)

Select "Air module" on the left.

Using the combobox "Default tab", you can select the index tab you want to open by default
when starting the program PC-Tool.

If you would like to show the function table in the Configuration register, activate the “Show
function table“ checkbox.
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1 Introduction

The "Water module" user manual describes the detail area [D] of the Water module for globe
valve actuators. The documentation is divided according to the three tabs "Service",
"Configuration” and "Simulation".
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the actuator.

L, Simulation | @/

Service \ Configuration
Actual setiings

Control funclionY DC 0.5-10Y
Sensitvity varizble

Nominal range 20 mm adapted
Running ime &0z

Stroke Max: 100%  [20mm] Mid.: 50%  [10mm]

Min: 0% [Drrum]
=[S on
Directionoisioke dir=ct  |mloe  Closing point up -
531 532

Farce 100%
Bus fail position Last valus

Actuator information

Firmware 0x0036 (0x01)
Config table ID 0x0084

Datalog
Operating time &1Eh
Active ime Oh
Stop & Gorabo 0%
Messages

Messzages
Resst Messages

Service tab for NV/NVF valve actuators
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Meaning of the settings

Control signal Y Type of control

Sensitivity Response sensitivity and reversal hysteresis of the
control function

Feedback U5 Type of feedback signal

Range Position range within the mechanical
limits

Running time Time needed to pass through the position range

Stroke Programmed stroke range: Max / Mid / Min

Direction of rotation Clockwise/counterclockwise (for full-rotation actuators)

Direction of stroke Plot of stroke direction to the positioning signal: Direct / inverted
(in acc. with switch S3.1)

Switching point Top / bottom (in acc. with switch S3.2)

Actuating force In percent of the maximum positioning force

Behavior in the event of bus | Behavior when communication fails

failure

Firmware Software version on the actuator

Config table ID Identification of the configuration table

Operating time Number of hours during which the actuator was
connected to the power supply

Active time Number of hours during which the actuator was mechanically in
motion and connected to the power supply

Stop & Go ratio Ratio of active time/operating time in percent. A high Stop & Go

ratio indicates an unstable control.

Running time, range, direction of rotation and stroke are not displayed on certain actuators.

2.2 Adaptation

In the adaptation, the actuator determines the range 0% ... 100% by approaching the
mechanical limits.

Click the "Adaptation" button on the Service tab.

Variant ~ You can also trigger the adaptation directly on the actuator. To do this, you have to remove the
cover from the actuator. To trigger the adaptation, press the S2 button on the electronic PCB.
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H1 =

ML
‘}rm

[1][2] [a][4][5]

L 7 v vz Up

Control element diagram with open linear actuator

The progress of the adaptation is displayed in the status line. The actuator first moves against
the programmed direction to the zero stop and then to the end stop at full stroke.

Next, the absolute values for a programmatically limited angle of rotation range (minimum, mid-
position, and maximum) as well as the feedback signal U5 are recalculated and displayed.
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3 Configuration

On the "Configuration” tab, you can read out parameter values from the actuator, change them
and save them back to the actuator. The valid ranges for the parameter values are displayed in
parentheses next to the input boxes.

Service Configuration | L. Simulation | g\

Designation |NV24-MFT US

Posifion |
Start Stop
Control signal Y |DC 0510V ﬂ

Read

Min Mid Max Write

Stroke 0 % (D.85%) B0 % (0..100%) 100 % (15..100%)
0 mm 10 mm 20 mm Store tofile...

Running ime B0 s (32 600s)

Load from file___

Reduce r'y

Stroke |adapted j | 20 mm

H

or ol
OFF |
o P

Direction of stroke SL;LDFF direct Closing point

Bus fail position |Last value
Sensifivity |variable -

Farce | 100 -| %

‘Configuration” tab for globe valve actuators

S3.

Actuator number?

Designation 16 characters of any text

Position 16 characters of any text

" Only characters from the Western European character set are permitted for Description and Position
(see General part, table in Section 4.3.3).
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Control signal Y

3-point AC voltage, positions: Open / neutral / closed
Open / closed DC or AC voltage, 2-point
DCO0.5-10V (DC voltage)

fixed operating range DC 0.5-10 V

DC 2—10 V modulating | (DC voltage)
fixed operating range DC 2—-10 V

DC variable Start (Y=0%) 0.5 ... 30 Volt
Stop (Y=100%) 2.5 ... 32 Volt
Range between start and stop at least 2 V

PWM 0.02-5 s Duration of the control impulse (pulse width modulation),
fixed operating range

PWM 0.1-25.5 s Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s Duration of the control pulse, fixed operating range

PWM variable Start (Y=0%) minimum 0.02 seconds

Stop (Y=100%) maximum 50 seconds

Feedback U5 (only active when the actuator address is set to PP)

Valve setting 2 -10V DC voltage measurement signal, fixed range

Valve setting 0.5 -10V DC voltage measurement signal, fixed range

Variable valve setting DC voltage measuring signal
Start 0.5...8.0 Volt / Stop 2.5 ... 10.0 V
Range between start and stop at least 2 V

Scaling U5 (with "New Generation" actuator only)

Start Position in percent, corresponds to the start value of the
feedback signal

Stop Position in percent which corresponds to the stop value of the
feedback signal

Stroke
Min Programmed lower limit of the range (cannot be changed)
Mid Mid-position of range
Max Programmed upper limit of the range

An existing value for Mid is automatically adapted when Max is entered: Mid is always less than
or equal to this input value.
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Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V. min: 30%, max : 70%
Feedback U5 : 2...7 V start: 20%, stop: 90%

Position

Open 100%

50%
1
1
1
1
r
Close 0% L _ Y/US
1 1 T T T T [Vl
0 5 1
Running time
In seconds Time needed to pass through the range limited by
Min and Max (the valid range of values for the running time
depends on the actuator type and the passed-through range)
Stroke
Adapted from the mechanical limits of certain stroke
Programmed The valid values depend on the maximum nominal
positioning range of the actuator

Stroke direction (in acc. with switch S3.1)

Direct 0% positioning signal is equivalent to 0% position feedback.

inverted 0% positioning signal is equivalent to 100% position feedback.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

3-9



PC-Tool User Manual :
for NV/NVF Series Actuators BEL' MO

Closing point (in acc. with switch S3.2)

top The linear spindle is moved into the actuator with the valve
closed and the stem is moved out of the fitting.

bottom The linear spindle is moved out of the actuator with the valve
closed and the stem is moved into the fitting.

Behavior in the event of bus failure (currently cannot be changed)

Last setpoint Position according to control signal Y
Sensitivity
Normal
— Response sensitivity: 1%
@ Operating range
— Reversal hysteresis 2.9%
@ Operating range
Damped
— Response sensitivity: 2%
@ Operating range
— Reversal hysteresis 5%

@ Operating range

Actuating force

25% ... 100% Can be set in increments of 25%. 100% corresponds to the
maximum positioning force for the actuator type (see nameplate)
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4 Controller simulation

Go to the "Simulation" tab.

| -
Service | Configuration ¥ Simulation | ﬂ;}‘, P
Actuator Sensor
" Simulation off Setpoint  Actual position * None Value
- | 40% | 400% | 95 mm I Active (0...32V) [ =
[ 430V 520V " Passive (850...1.6kOhm) [ —
. Setpoimt Tost " Passive (200...60k0hm) Transformation
" Motor stop Trendview > " Switch | J
Interval | 1.0s | Stop Record [ | Comment.. | [V24-MFT2__00626-20013-128-053_20061109_153352_trend bptind

Trend

acme, NV24-MFT2.

< 100
90
20
70
60
50
Y NS N (S S S S (N S Sl T3S SN SN
30
20
10:

15:33:55 15:34:00 15:34:05 15:34:10 15:34:15 15:34:20 15:34:25 15:34:30 15:34:35 15:34:40 15:34:45
Time

—— Setpoint [%] Valve position [%] Max setfing [%] Min setting [*%]

"Simulation" tab for globe valve actuators

The controller simulation is not possible while the actuator is performing an adaptation or
synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y according to selected
control type (DC, PWM, open/close, 3-point).

= Setpoint Tool (not available with control type open/close or 3-point): The setpoint is entered
in % of the programmed range. 0% is the minimum, 100% the maximum. The input values
are converted and displayed in the units of the corresponding control signal (volts or
seconds).
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The control is switched off when you click Motor stop. This function is not available with the
control types open/close and 3-point.

Measurement values

During the simulation, the stroke is displayed in % of the absolute (mechanically limited) range
in millimeters and — converted according to the scale setting — as a feedback voltage in volts.

4.2 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function, however, must
be activated in advance in the PC-Tool options under "General". Select Tools» PC-Tool options...
in the main menu.

K% PC_Tool Options

| General : _
Release Codes Project base path:

MP channel corfiguration IC:‘t.anurnente und Einstellungen\ACME"\Eigene Dateien"BelimoFCTool I
Air module

Water Globe module L

WAV NMY-D2M module

WAV Compact module Language:

VAV VRP-M module IEninsh ;! The new language setting becomes active

after a program restart.
Log file:
" Fileperweek Filz par month

™ Enable MP-Manitor

Simulation/Trend
[ Ask user if trendfiles should be saved (if not check save them always).
¥ Enable sensor reading functionality

Cancel

Settings for reading out sensors

On the Service tab, a section with the sensor values is displayed to the right of the actuator

control.
— Sensor
" None Value
+ Active (0_..32V) |TEHF
" Passive (850...1.6k0Ohm) 03y
" Passive (200...60kOhm) Transformation
" Switch Ic:l"vlu:u table: LI

Sensor display in MP mode
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Select the type of the connected sensor with the radio buttons. The value is either displayed in
volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the sensor into the
corresponding measuring quantity (temperature etc...). (See the "Transformation table" section
in the General User Manual)

4.3 Trend recording

During simulation, the time progress of the setpoints and actual values can be displayed in a

plot. The values are saved in a trend file and can be displayed again at a later time. Furthermore,
you can add any comment texts you would like.

In the PC-Tool options "General", you determine whether the trend file is automatically saved

when the recording is finished (checkbox not selected) or whether the program should ask you.
The suggested file name can be modified before saving the file.

Trend Record ®

Click the "Trend Record" button during simulation. The display changes to a "flat" button. The
recording stops when you click again.

Sl B | The Trend View radio buttons allow you to set whether the display is given in percent of the full
rotation range (%) or in volts (V).
The position is queried every second by default. You can change the query interval in an input
box. The permitted values are 0 to 9999 seconds, whereby the value 0 means "no waiting time"
(query as quickly as possible).
Intewdl 1.0 ¢ ‘ Trend [ | | Kommentar. .. | |imited_lut_cunf_l]l]439-1 0093-
— Trend
ACME. AM24-MFT 2, Limited_lot_conf
% 100
90
80 -
70
60 ],
50 !
40
30 ,:'l
20 -t
10 i 1 T .' T T T T
15:42:50 15:43:00 15:43:10 15:43:20 15:43:30 15:43:40
Zeit
Sollwert [X] Aktueller'winkel [%]
M ax Pozition [*] Min Pozition [%]
Trend plot
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The Comment button allows you to enter a text at a defined time and the text is then saved in the
trend file.

If you want to record a trend for more than one hour (long-term trend), enter a value of at least
2 seconds for the interval. If the interval is shorter, too many data points will result and the time
for correcting the curve between the queries can become too short.
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Select Tools»PC-Tool options... in the main menu.

Variant ~ Click the project in the outline bar [C] with the right mouse button and select PC-Tool options.

== PC-Tool Options

General it g

Relzaze Codes Drefault tab:

MP channel confiquration :

it rmodule | Service LJ

WWater Globe moduls ;
YA NMY-DEM module After write

Wi b rmodul
WA VE??&%:&E ® | Start adaption after write

Dialog for basic settings (Water module)

Select "Water/globe module" on the left.

Cancel

Using the combobox "Default tab", you can select the index tab you want to open by default

when starting the program PC-Tool.

If an adaptation is to be performed after every programming operation, select "Start adaption

after write".

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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1 Introduction

The ePIV Module User Manual describes the detail area [D] of the module for the
ePIV controller (Electronic Pressure Independent Valve, pressure-independent
flow controller). The documentation is divided up in accordance with the tabs for
"Service", "Configuration" and "Simulation".

Note
For function and wiring, see Product Information.
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2 Service

2.1 Show Settings

The Service tab offers an overview of the current settings of the EPIV controller.

L, Simulation

Service ‘ Configuration

Actual zettings
Control type: Flow Control Test

Control function” DC 2-10% inwert 2% =Ymax
Characterisbcs Characteristics on [equal percentage] Adaption

Feedback U5 “Volumetric low 2-10%
Mir: 0% Maw: B0% Synchronization

[

Hominalrange 35° adapted
Valve Size DN ES/2%"
WMo 480 I/min W ax: 384 1/min
Synchronization at v'=0%

Bus Fail position Last value
Power ON Mo action
Gearrelease button Synchronization

Actuator information
Firmware 01.24 -6
ConkhigtablelD 0x1049

Datalog
Operatingtime 4h
Actlive time 0h
Stop k Goratio 0%
Messages
Messzages

Reset Meszages

Service tab for EPIV controller

In the general section of this user manual, a description is given as to how you
can print out the control parameters [chapter 3.6.2.] or delete the maintenance
and error messages [chapter 3.6.3].

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Control function

Flow control or open loop operation

Control function Y

Type of control. If the control function is interpreted as
inverted, then this will be displayed.

Characteristic curve

The EPIV controller works with either an equal-percentage
or a linear characteristic curve.

Characteristic curve off means "linear", characteristic curve
on means "equal percentage".

The two characteristic curves (feedback U5 and control
function Y) are always either simultaneously activated or
simultaneously deactivated.

Feedback U5

Type of feedback signal (conventional operation)

Nominal range

Nominal position range within the mechanical
limits

Valve size

Size of the valve; is set by Belimo. If the specified volumet-
ric flow scale with respect to the valve size has been
changed from the factory setting, then the label marked
"Scaling adjusted" will appear.

Volumetric flow settings

Operating volumetric flow settings: V'nom / V'max
(only V'nom in open loop operation)

Synchronisation at

Stop position 0% or 100%

Bus fail position

Position in the event of MP communications failure

Power ON

Behaviour/Function when switching on the device
or after a voltage interruption, respectively

Gear release button

Function when the gear release button is pressed

Firmware

Software version of the EPIV controller

Config table ID

Identification of the configuration table of the EPIV

Operating time

Number of hours during which the actuator was connected
to the supply

Active time

Number of hours during which the actuator was mechani-
cally moving and connected to the supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio (red) indicates that the control is unstable.

The following additional settings appear when EPIV is combined with Super Cap:

Power Fail-/Power off
Pos.

Actuator position after failure of the supply voltage

Power fail Delay

Time after the failure of the supply voltage and before the
actuator begins to move to the emergency setting position.

Power fail Count

Number of voltage interruptions

45
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2.2 Adaption

BELIMO

Converting units for volumetric flow

Select Tools » PC-Tool Options in the main menu.

Click on "EPIV Module" at the left.

You can determine the physical units for the volumetric flow with the Combobox
volume display

= |/min (litres per minute)

m?3/h (cubic metres per hour)

I/s (litres per second)

I/h (litres per hour)

= gpm (gallons per minute)

This setting applies for all displays, printouts, labels and writing into the log file
[see general section of this user manual].

With adaption, the actuator determines the available range 0% ... 100% by ap-
proaching the mechanical limits.

To start, click the "Adaption” button in the Service tab.

The progress of the adaption is displayed in the status bar. The actuator first
moves against the programmed direction to the zero end stop and then to the
end stop with complete valve opening.

The actuators can be configured in such a way that an adaption will be triggered
automatically when the supply voltage is switched on.

2.3 Synchronisation

Variant

During synchronisation, one mechanical limit is approached in order to compare
the position calculation.

Each actuator can be programmed to determine whether synchronisation is to be
carried out at the zero end stop (0%) or with full valve opening (100%).

To start, click the "Synchronisation" button in the Service tab.

You can also trigger the synchronisation directly at the actuator by pressing the
gear release button.

The progress of the synchronisation is displayed in the status bar. If synchronisa-
tion at: is set to Y=0%, the actuator will move against the programmed direction
to the zero end stop; if on the other hand synchronisation at: is set to Y=100%,
then it will move to the end stop with full valve opening.

The actuators can be configured in such a way that a synchronisation will be trig-
gered automatically when the plant is switched on.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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2.4 Function Test

The opening and closing of the valve is checked during the
function test.

The actuator first moves in accordance with the synchronisation position to the
mechanical end stop. If the range is set to "adapted”, then the other end stop will
be approached; if it is set to "programmed", on the other hand, then it will move to
the programmed range limit.

Click on the "Test" button in the Service tab. The normal display will then be cov-
ered over by the test window.

Test progress: Current position:

- Plauszibility test Fiex T4
- Messages deleted

- Actuator closes T i Abort Test
- Actuator opens et state:

B

Test repart:
&

”~

Belimo Testreport

Project: Demo

Company: Belimo

Date: 26.01_2010

Time: l0:zz2

Type: SRE4L-CF

OEM:

Position:

Serialmanber: 00351-30118-157-1E27
T=ser ID: oy

List of error messages before Testrun:

Test activities:

. Plansibkility test

. Messages deleted

. Actuator closes

. Actuator opens R

[T

Display of test progress and test report

Click on the "Start Test" button.
The progress and the current position will be displayed continuously.

The test report contains

= information concerning the project,

the identification of the EPIV controller,

a list of the error messages in effect before the start of the test,
= the test steps and the test result,

= the current controller settings.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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If the test reports an invalid controller configuration, switch over to the "Configura-
tion" tab after the test has been completed. There you will find the non-permitted
values marked with a flashing exclamation mark.

You can save the test report as a file by clicking on the floppy disk symbol or print
it out by pressing on the printer symbol.

End the function test by pressing on the "Close Test" button. The program will
ask whether you would now like to save a test report that has not yet been saved.

Save testreport?

\._::,) WWould wou like ko save the testreport?

If you abort the test prematurely, then no test report will be compiled.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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3 Configuration

In the "Configuration” tab, you can read out the parameter values from the EPIV
controller, modify them and save them as a text file.
Service Configuration |, Simulation\ ‘

Deszignation |B elirna

Poszition |
Valve Size |DN 65 / 21" Y'nom 127 gpm  ¥'max 127 gpm 100 %
38.1.126.7 gpm
U5 Flow Range: 100 % Read
Write
Control signalY |DC 210 ﬂ _“'___,/|_
1 T
[ irwert 10% = mnax characteristic on [equal percentage] [+ Store to file___
Feedback US | volumetic flow 210V v ,_f
Load from file_..
Feduce A
Bus fail position |Last walue ﬂ
Synchronization at |Y=EI°/= ﬂ
Power ON |N0 action j

Gear release button |Synchrorization

"Configuration” tab for EPIV controller

The extended configuration in the lower area will become visible when you click
on "Expand".

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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3.1 Settings
Controller ID'
Designation 16 characters of any text
Position 16 characters of any text
Valve size

Selection list with valve | Sets the valve size and thus also the nominal volumetric
sizes flow specified by the manufacturer (default nominal volu-
metric flow, if a release code is available, can be modified.
See below: "Display scaling").

Volumetric flow, nominal

V'nom Nominal volumetric flow (is set by the manufacturer)

Volumetric flow range

V'max Upper limit of the operating volumetric flow setting (in
selected unit or in %)

The possible range is displayed under the box, it lies be-
tween 30% - 100% of V’nom.

U5 volumetric flow Upper limit for the U5 volumetric flow range.
range This value is typically the same as V'max[%].

The value only has an influence on the U5 feedback volt-
age value.

You can change the physical units for the volumetric flow in "Tools » PC-Tool Op-
tions" in the main menu [see chapter 2.2.].

An existing value for U5 volumetric flow range will automatically adjust itself to

the V'max when the latter is entered. On the other hand, the V'max will not
change if you change the U5 volumetric flow range yourself.

Control signal Y

DCO0.5... 10V Fixed operating range 0.5 ... 10V
DC2...10V Fixed operating range 2 ... 10V
DC variable Start (Y=0%) 0 ... 8V

Stop (Y=100%) 2.0 ... 32V
Range between start and stop at least 2V

Control function Y inverted

on Inverts the control function Y
(lowest voltage = V'max)

! Only characters from the Western European character set are permitted to be used for
designation and position (see general section, table chap. 4.3.3).

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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off

Control function Y normal
(highest voltage = V'max)

Feedback U5 (active only if actuator address is set to PP)

Volumetric flow

Volumetric flow feedback

0.5...10V 0...100%, V'nom=0.5... 10V

Volumetric flow Volumetric flow feedback

2...10V 0...100%, Vinom=2 ... 10V

Volumetric flow Volumetric flow feedback 0 ... 100%, V'nom
variable Start 0.0 ... 8.0 volt / stop 2.0 ... 10.0V

Range between start and stop at least 2V

Characteristic curve

Equal percentage

Characteristic curves for control function Y and feedback
U5 switched on (input signal to volume equal percentage)

Bus fail position

Last setpoint

Volumetric flow in accordance with the last setpoint of the
MP master received

Open Open valve (100%, valve completely open)
Close Close valve
Max / V'max V’max volumetric flow

Synchronisation at

Y =0% Approaching the mechanical limit with
zero end stop (valve closed)
Y =100% Approaching the mechanical limit with full valve opening

With Power ON

Adaption

Approaching both mechanical limits and recalculation of
angle-dependent parameters

Synchronisation

Approaching one mechanical limit (in accordance with the
setting "Synchronisation at")

No action

Gear release button

Synchronisation

(preset for EPIV actuators)

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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4 Controller Simulation

Switch over to the "Simulation" tab.

Ser\rlce‘ Configuration B Simulation ‘
Actuator .
" Simulationof " Close |S et pql::nt |Actl;a5: Flow |Va|vses
" Setpointy " V'nom % % %
« SetpointTood ¢ V'max | 480 1/min | 407 1/min | 55 - 4
" Motor stop 2.0 vy 88 v
" Dpen Active ovemride step: Yom
Test » | Testfle |Test_EPIV_Max 3m._bptts j
Interval 1.0 ¢ Stop Record ] Comment. .. |emo_SH24A-CF_l]l]951 -30118-158-127_20100128_164607_trend.bpttnd
Trend
Demao. SR24A-CF,
) . - 120 %
1/rmin E50 4
500 . 100
450 L
400 . e
350 - i
300 . s o
280 =4--n |
200 - 40
150 R
100 20
50
0 T T T T T T 0
16:46:10 16:46:15 16:46:20 16:46:25 16:46:30 16:46:35
Time
Set Paint [14rmin] Actual Yolurmetric Flaw [ min] Mawx Position [I/mit] alve position [%]

"Simulation" tab for VAV controllers

Control simulation will be influenced if the actuator is currently carrying out an
adaption or a synchronisation. The "Motor Stop" function overrides any ongoing
adaption or synchronisation.

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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4.1 Actuator Control (Actuator)

4.2 Test

4.2.1 Test scripts

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

Use the radio buttons to select the setpoint specification.
= Setpoint Y: Control function at connection Y.

= Setpoint tool: Input of the setpoint in % of the volumetric flow (100% corre-
sponds to V'max), as volumetric flow value (e.g. I/min) or as control function
(volts).

Clicking on "Motor Stop" stops the actuator.

The following override steps can be specified per radio button.
= Open: Valve completely opened

= Close: Valve completely closed

= V'nom: Nominal volumetric flow

= V'max:  Volumetric flow V’max (100%)

Measured values

The following are displayed:

= The current volumetric flow 0 ... 100% of the V'nom

= The actual flow of the volumetric flow in I/min or the selected unit
= The feedback voltage in volt (U5 signal)

= The valve opening in %

= The current angle of rotation in angular degrees

= An active override step is displayed as text, independently of whether it was
specified by the PC-Tool or externally (control function Y)

The test function is available for the structured testing of the EPIV actuator.

A number of commands which follow one another in sequence [see 4.2.1] are de-
fined in a test script file. A trend record is triggered at the start of the function.

Select test file

Select the desired scrip with the Combobox test file. Only test scripts for EPIV
modules are displayed in the Combobox.

Start test script

Click on the test * button. The tests will begin at once.
Create test script

In accordance with the templates, users can also create test scripts of their own.
File name must contain the character block "EPIV".

The following test scripts are available as templates.
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Name of the test file

Functions

Test_EPIV_Max 3m.bptts

V'max — 3 minutes

Test_EPIV_Max-Auto-Min 9m.bptts

V'max — 3 minutes
Auto — 3 minutes

V'min — 3 minutes

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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4.3 Recording Trends

Trend Record

Stop Record

1#min 550
500
450
400 3
350 3
300 4

250

200 3
150 3
100 3
501 5

The progression over time of the setpoint and actual values can be displayed in a
diagram during the simulation. The values are saved to a trend file and can be
displayed again at a later date. In addition, commentary texts of one's choosing
can be added.

In the PC-Tool Options General, you define whether the trend file is saved auto-
matically when the recording is completed (checkbox not selected) or whether the
program should inquire about your preferences.

During the simulation, click on the "Trend Record" button. The display changes to
a "flat" button. Clicking once more will interrupt the recording.

According to the presettings, measured values are queried at one-second inter-
vals. You can change the querying interval in the interval input box. The permit-
ted values range from 0 to 9999 seconds, for which the value "0" means "no wait-
ing time" (querying as rapidly as possible).

If you wish to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. Shorter intervals cause too many data
points to be created and the time for plotting the curve between the queries could
become too short.

Demo, SR24A-CF,

- 120 %

- 100

......... S - 80

- &0

20

Set Point [I/min] Actual Volumetric Flow [I/min] bd & Position [I/min)

16:34:00 16:34:05 16:34:10 16:34:15 16:34:20 16:34:25
Time

Walve position [%]

Trend diagram

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

You can use the comment button to enter a text at a defined point in time, which
is then saved in the trend file.
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5 PC-Tool Options for EPIV Module

Select Tools » PC-Tool Options in the main menu.

Variant  Right-hand mouse click on the program symbol in the overview bar and select
PC-Tool Options.

K PC-Tool Options

General b ity g
Releaze Codes Default tab: Flow Uit
MP channel configuration - -

Wi Compact Manufacturer Service ﬂ I/min hd
Air module

Wiater Globe module

W MR -D2M module

Wiy Compact module

Wi WRP-M module
Fire & Smoke module

Cancel

Dialogue for basic settings (EPIV Module)
Click on "EPIV Module" at the left.

Main window

In accordance with the most frequent usage, use the "Default Register" Com-
bobox to determine which tab is to be opened in the default settings when the
program is started up.

You can select the physical units for the volumetric flow with the Combobox vol-
ume display

= |/min (litres per minute)

= m?h (cubic metres per hour)

= |/s (litres per second)

I/h (litres per hour)

= gpm (gallons per minute)

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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1 Introduction
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This user manual describes the detail area for valves using SY actuators. The
documentation is divided according to the three tabs "Service", "Configuration” and
"Simulation".

In April 2008, Belimo launched the new SY-MFT to replace its existing proportional
actuator the SYx-P. The new electronics, designed by Belimo's engineering group,
was an extension of the new generation non-spring actuator platform successfully
launched years prior.

The SY-MFT contains most benefits found in Belimo's tradition MFT offering except
for the ability to change the running time.

Typical wiring diagram

RJ12

BELINIO

O Enabie
O Data
Q Inniakzed

| 2IP-usB WP

Belimo
PC-Tool

MO MA

MP278US

uss

~
m

e
B
IoI10) ,@:
| =
PC Tool D ! :|
“ Service Jack | @ :
® o)
() |®:
@ [
@
e Ada Fr Y
ption | [ | Address
I L._l L._I '
o
ol B
SYx-120MFT @
SYx-230MFT
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the actuator.

[ PCToolGUI V3.4
....... B Projeet, 578042
=] j Channel COM=7_ [MP/PP_E

Service tab for SY/MFT valve actuators

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA
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Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control function

Feedback U5

Type of feedback signal

Range

Position range within the mechanical
limits

Running time

Time needed to pass through the position range

Stroke

Programmed stroke range: Max / Mid / Min

Direction of rotation

Clockwise/counterclockwise (for full-rotation actuators)

Direction of stroke

Plot of stroke direction to the positioning signal: Direct / inverted
(in acc. with switch S3.1)

Switching point

Top / bottom (in acc. with switch S3.2)

Actuating force

In percent of the maximum positioning force

Behavior in the event of bus
failure

Behavior when communication fails

Firmware

Software version on the actuator

Config table ID

Identification of the configuration table

Operating time

Number of hours during which the actuator was
connected to the power supply

Active time

Number of hours during which the actuator was mechanically in
motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop & Go
ratio indicates an unstable control.

Running time, range, direction of rotation and stroke are not displayed on certain actuators.

2.2 Adaptation

In the adaptation, the actuator determines the range 0% ... 100% by approaching the

mechanical limits.

Click the "Adaptation" button on the Service tab.

Variant ~ You can also trigger the adaptation directly on the actuator. To do this, you have to remove the
cover from the SY actuator. To trigger the adaptation, press the adaption button located on the

electronic PCB.
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The progress of the adaptation is displayed in the status line. The actuator first moves against
the programmed direction to the zero stop and then to the end stop at full stroke.

Next, the absolute values for a programmatically limited angle of rotation range (minimum,
mid-position, and maximum) as well as the feedback signal U5 are recalculated and displayed.
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3 Configuration

On the "Configuration” tab, you can read

out parameter values from the actuator, R w;ﬁ naspspp O g

change them and save them back to the T Service Configuration | Simutation|

actuator. The valid ranges for the o —

parameter values are displayed in e 1

parentheses next to the input boxes. s DT N =

PSP e FOYTIY [ wap [ smom e

Eioam 1o bl
Lsnaed Traves B,

Dimeionatitaon Sang] £

Wun ok poition [ e =]

Torgue [100 x

ol |

"Configuration" tab for SY-MFT actuators

Control Signal Y: Selectable: Options  2-10vdc, 0.5 — 10vdc, 4-20mA, DC Variable, 3 point*, Open/Close*
PWM 0.02-5s*, PWM 0.10-25.5s*, PWM 0.59-2.93s*, PWM Variable*
Feedback U5: Selectable: Options 2-10vdc, 0.5 — 10vdc, 4-20mA, DC Variable

*Available on 24MFT Actuator Models only.

What is “Loss of Signal” functionality?

This is the point at which the SY actuator interprets no input from the controller and either stops, closes or opens the
valve based on the programmed control functionality.

Loss of signal point is always at 0.5V. It doesn’t matter if the control signal is 2-10V or 0.5-10V.

Loss of signal point is TmA if 4-20mA is selected.

Loss of Signal — Stop  The actuator will stop in its last position.

Loss of Signal — Open The actuator will move to its 100% position.

Loss of Signal — Close The actuator will move to its 0% position.

Loss of Signal — Nothing The actuator will move to the zero position.

Actuator number’

Designation 16 characters of any text

Position 16 characters of any text

! Only characters from the Western European character set are permitted for Description and
Position (refer to page 1-53).
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Control signal Y

3-point AC voltage, positions: Open / neutral / closed
Open / closed DC or AC voltage, 2-point
DCO0.5-10V (DC voltage)

fixed operating range DC 0.5-10 V

DC 2—10 V modulating | (DC voltage)
fixed operating range DC 2—-10 V

DC variable Start (Y=0%) 0.5 ... 30 Volt
Stop (Y=100%) 2.5 ... 32 Volt
Range between start and stop at least 2 V

PWM 0.02-5 s Duration of the control impulse (pulse width modulation),
fixed operating range

PWM 0.1-25.5 s Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s Duration of the control pulse, fixed operating range

PWM variable Start (Y=0%) minimum 0.02 seconds

Stop (Y=100%) maximum 50 seconds

Feedback U5 (only active when the actuator address is set to PP)

Valve setting 2 -10V DC voltage measurement signal, fixed range

Valve setting 0.5 -10V DC voltage measurement signal, fixed range

Variable valve setting DC voltage measuring signal
Start 0.5...8.0 Volt / Stop 2.5 ... 10.0 V
Range between start and stop at least 2 V

Scaling U5 (with "New Generation" actuator only)

Start Position in percent, corresponds to the start value of the
feedback signal

Stop Position in percent which corresponds to the stop value of the
feedback signal

Stroke
Min Programmed lower limit of the range (cannot be changed)
Mid Mid-position of range
Max Programmed upper limit of the range

An existing value for Mid is automatically adapted when Max is entered: Mid is always less than
or equal to this input value.
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Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V. min: 30%, max : 70%
Feedback U5 : 2...7 V start: 20%, stop: 90%

Position

Open 100%

50%
1
1
1
1
r
Close 0% L _ Y/US
1 1 T T T T [Vl
0 5 1
Running time
In seconds Time needed to pass through the range limited by
Min and Max (the valid range of values for the running time
depends on the actuator type and the passed-through range)
Stroke
Adapted from the mechanical limits of certain stroke
Programmed The valid values depend on the maximum nominal
positioning range of the actuator

Stroke direction (in acc. with switch S3.1)

Direct 0% positioning signal is equivalent to 0% position feedback.

inverted 0% positioning signal is equivalent to 100% position feedback.
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Closing point (in acc. with switch S3.2)

top The linear spindle is moved into the actuator with the valve
closed and the stem is moved out of the fitting.

bottom The linear spindle is moved out of the actuator with the valve
closed and the stem is moved into the fitting.

Behavior in the event of bus failure (currently cannot be changed)

Last setpoint Position according to control signal Y
Sensitivity
Normal
— Response sensitivity: 1%
@ Operating range
— Reversal hysteresis 2.9%
@ Operating range
Damped
— Response sensitivity: 2%
@ Operating range
— Reversal hysteresis 5%

@ Operating range

Actuating force

25% ... 100% Can be set in increments of 25%. 100% corresponds to the
maximum positioning force for the actuator type (see nameplate)
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4 Controller simulation

Go to the "Simulation" tab.

24 PC-Tool =S|

File Project Channel Took Help

Dl Flu(ue] &8s 25ls

B Type Sh 000D1-60001-154-000 :.*
Designation Address PP
Position -
Servicel Configuration B Simulation |
Actuator
 Simulation off Setpoint  Actualposition
360 % 356 %
& SetpointY
488 v 435y
" Setpoint Tool
 Motor stop Trendview & % O
Interval | 10.0 s | StopRecod n Comment... | [uments\PM_Bulterfly\SY-8042\trend files\SY-8042__00001-60001-154-000_20100309_105938_tiend.bpttnd
~Trend
SY-B042, .
%100
%0
|
0
60
50 / ............................
o A
Eil
-“‘
Eil
10 -
s
a0 e .
11:00:00 A4 11:00:30 A4 11:01:00 AM 11:01:30AM 11:02:00 AM 11:02:30 AW 11:03:00 AM 11:03:30AM 11:04:00 AM
Time
Set Paint [] Actual angle [%] M Position [%] Min Pastion 2]
1] ] |State: P

"Simulation"tab for SY-MFT actuators

The controller simulation is not possible while the actuator is performing an adaptation or
synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y according to selected
control type (DC, PWM, open/close, 3-point).

= Setpoint Tool (not available with control type open/close or 3-point): The setpoint is entered
in % of the programmed range. 0% is the minimum, 100% the maximum. The input values
are converted and displayed in the units of the corresponding control signal (volts or
seconds).
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The control is switched off when you click Motor stop. This function is not available with the
control types open/close and 3-point.

Measurement values

During the simulation, the stroke is displayed in % of the absolute (mechanically limited) range
in millimeters and — converted according to the scale setting — as a feedback voltage in volts.
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4.2 Trend recording

Trend Record ®

Stop Record [ |

During simulation, the time progress of the setpoints and actual values can be displayed in a
plot. The values are saved in a trend file and can be displayed again at a later time. Furthermore,
you can add any comment texts you would like.

In the PC-Tool options "General’, you determine whether the trend file is automatically saved
when the recording is finished (checkbox not selected) or whether the program should ask you.
The suggested file name can be modified before saving the file.

Click the "Trend Record" button during simulation. The display changes to a "flat" button. The
recording stops when you click again.

The Trend View radio buttons allow you to set whether the display is given in percent of the full
rotation range (%) or in volts (V).

The position is queried every second by default. You can change the query interval in an input
box. The permitted values are 0 to 9999 seconds, whereby the value 0 means "no waiting time"
(query as quickly as possible).

224 PC-Tool _1&8]x]

File

Project Channel Tools  Help

D] Zlu(s| &Elslv|F 2l6|lS
=]

Type S 00001-60001-164-000 :'i
Dresignation Address PP
Position .
Servicel Configuration ¥ Simulation |
Actuator
£ Gimulationoff Setpoint  Actual position
60 % 612 %
 SetpointY
6.80 v 6.90 v
 Setpoint Tool
€ Motor stop Trendview % Y
Interval [ 10.0s | StopRecod n Comment... | [uments\PH_Bulterfiy\SY-8042Wrend files\Sv-8042__00001-60001-154-000_20100309_105338_trend. bpttnd
~Trend
SY-8042..
%100
a0
60
kil
&1 /__\ —
51 7 —_— I
40 4 / -
0 /
a0 7 o
0 £
/
0
11:00:00 &M 11:01:00 AM 11:02:00 AM 11:03:00 &M 11:04:00 &M 11:05.00 M 11:06:00 &M 11:07:00 AM 11:08:00 AM 11:09:00 &M
Time
—— SetPaint [%] Actual angle [%] bas Position (%] Min Position (%]
il [stat=: 7

800-543-9038 USA 866-805-7089 CANADA 203-791-8396 LATIN AMERICA

5-13



PC-Tool User Manual :
for SY-MFT Series Actuators BEL' MO

The Comment button allows you to enter a text at a defined time and the text is then saved in the
trend file.

If you want to record a trend for more than one hour (long-term trend), enter a value of at least
2 seconds for the interval. If the interval is shorter, too many data points will result and the time
for correcting the curve between the queries can become too short.
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5 PC-Tool options

Select ToolsPPC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-Tool

options.
mérC-ToolOpons  H
General Main view
Release Codes Defaull tab:

MPF channel cunfiiuration m

Water Globe module )
VAW NMY-D2M madule V' Show function table

WAy Compact module
WAV YRP-M module
Fue & Smoke module

oK I Cancel

Dialog for basic settings (Water module)

Select "Air module" on the left.

Using the combo box "Default tab”, you can select the index tab you want to open by
default when starting the program PC-Tool.

Note: In PC-Tool Version 3.4, the “Show function table” should be selected. If this
feature is not selected, the function table that is used to select the Loss of Signal
position will not be available.

PC-Tool Version 3.5 is available and defaults with function table.
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BELIMO

USA

ACR Supply Company Inc.
2719 Hillsborough Road
Durham, NC 27705

Phone: 919-286-2228

With branches in NC

Aireco Supply

9120 Washington Boulevard
Savage, MD 20763-0414
Phone: 301-953-8800

With branches in MD, VA

Amcon Controls, Inc.

11906 Warfield Street

San Antonio,TX 78216

Phone: 210-349-6161

With a branch in Houston, TX

Applied Automation

A Wilson Mohr Company

3186 South Washington Street, #230
Salt Lake City, UT 84115

Phone: 801-486-6454

Boston Aircontrols, Inc.
8 Blanchard Road
Burlington, MA 01803
Phone: 781-272-5800

Charles D. Jones Co.

445 Bryant Street, Unit #1

Denver, CO 80204-4800

Phone: 800-777-0910

With branches in CO, MO, KS

Climatic Control Div/ICD
5061 W. State Street
Milwaukee, WI 53208

Phone: 800-242-1656

With branches in WI

Cochrane Supply and Engineering, Inc.

30303 Stephenson Highway

Madison Heights, MI 48071-1633

Phone: 800-432-4894

With branches in Ml and Maumee, OH

Columbus Temperature Control
1053 E. 5th Avenue

Columbus, OH 43201

Phone: 800-837-1837

Controlco

5600 Imhoff Drive, Suite G
Concord, CA 94520

Phone: 925-602-7728

With branches in CA, NV

Edward C. Smyers & Co.
223 Fort Pitt Boulevard
Pittsburgh, PA 15222-1505
Phone: 412-471-3222

Engineered Control Systems
4805 N.W. 79th Avenue

Suite 11

Miami, FL 33166

Phone: 305-418-8901

With branches in FL

First Source Distributors, LLC
710 Peninsula Lane, Suite E
Charlotte, NC 28273

Phone: 800-670-5977

G & O Thermal Supply
5435 N. Northwest Highway
Chicago, IL 60630

Phone: 773-763-1300
With branches in IL

Industrial Controls Distributors LLC
1776 Bloomsbury Avenue

Wanamassa, NJ 07712

Phone: 800-631-2112

With branches in

GA, KY, IN, MA, ME, NC, NY, OH, PA, TN

Interstate HVAC Controls
30 Vineland Street

Brighton, MA 02135

Phone: 617-782-9000

Jackson Controls
1708 E. 10th Street
Indianapolis, IN 46201
Phone: 317-231-2200

M & M Controls

9E West Aylesbury Road

Timonium, MD 21093

Phone: 410-252-1221

With a branch in Alexandria, VA

MICONTROLS, Inc.

6516 5th Place South

Seattle, WA 98124

Phone: 800-877-8026

With branches in WA, OR

Meier Supply

123 Brown Street

Johnson City, NY 13790
Phone: 607-797-7700

With branches in NY, PA

Minvalco, Inc.

3340 Gorham Avenue
Minneapolis, MN 55426-4267
Phone: 952-920-0131

With branches in MN

RSD/Refrigeration Supply Distribution
26021 Atlantic Ocean Drive

Lake Forest, CA 92630

Phone: 949-380-7878

With branches in

CA, NV, OR, AK, AZ, ID, UT, WA, MT

Saint Louis Boiler Supply, Co.
617 Hanley Industrial Court

St. Louis, MO 63144

Phone: 314-962-9242

South Side Control Supply, Co.
488 N. Milwaukee Avenue

Chicago, IL 60610-3923

Phone: 312-226-4900

With branches in IL, IN

Stromquist and Company
4620 Atlanta Road

Smyrna, GA 30080

Phone: 404-794-3440

With a branch in Orlando, FL

Temperature Control Systems
10315 Brockwood Road

Dallas, TX 75238

Phone: 214-343-1444

With branches in OK, TX

Tower Equipment Co., Inc.
1320 West Broad Street
Stratford, CT 06615

Phone: 800-346-4647

Twinco Supply Corporation
55 Craven Street

Huntington Station, NY 11746-2143
Phone: 800-794-3188

With branches in NY

Belimo Platnium Distributors

CANADA

For a complete list of distributors
in Canada, please visit our
website: www.belimo.ca

or call toll free: 866-805-7089
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Belimo worldwide: www.belimo.com

BELIMO Americas
USA Locations, 43 Old Ridgebury Road, Danbury, CT 06810
Tel. 800-543-9038, Fax 800-228-8283, marketing@us.belimo.com

1049 Fortunado Loop, Sparks, NV 89436
Tel. 800-987-9042, Fax 800-987-8875, marketing@us.belimo.com

Canada Locations, 14/16 — 5716 Coopers Avenue, Mississauga, Ontario L4Z 2E8
Tel. 866-805-7089, Fax 905-712-3124, marketing@us.belimo.com

Latin America and The Caribbean Customer Service
Tel. 203-791-8396, Fax 203-791-9139, marketing@us.belimo.com

V /[ 4
BELIMO

S
=
<
[%2]
=]
=
£

=]

=4
=
f=

S

o
=
<<

=]
£
©
==}

@

>

o

<
=

o

=)

2
p

i3

2
S

=

n

f

o
=
=
=3
=

'
=
=

o
S
3]
i



